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Preface

The curriculum and curricular materials have been developed and revised on a regular 
basis with the aim of making education objective-oriented, practical, relevant and job 
oriented. It is necessary to instill the feelings of nationalism, national integrity and 
democratic spirit in students and equip them with morality, discipline, self-reliance, 
creativity and thoughtfulness. It is essential to develop linguistic and mathematical 
skills, knowledge of science, information and communication technology, environment, 
health and population and life skills in students. It is also necessary to bring the feeling 
of preserving and promoting arts and aesthetics, humanistic norms, values and ideals. 
It has become the need of the present time to make them aware of respect for ethnicity, 
gender, disabilities, languages, religions, cultures, regional diversity, human rights and 
social values to make them capable of playing the role of responsible citizens with 
applied technical and vocational knowledge and skills. This learning resource material 
for Animal Science has been developed in line with the Secondary Level Animal 
Science Curriculum with an aim to facilitate the students in their study and learning on 
the subject by incorporating the recommendations and feedback obtained from various 
schools, workshops, seminars and interaction programs attended by teachers, students 
and parents.

In bringing out the learning resource material in this form, the contribution of the 
Director General of CDC Mr. Yubaraj Paudel and members of the subject committee 
Dr. Manraj Kolakshpati, Madhukumari Tiwari, Lavdev Bhatta is highly acknowledged. 
The learning resource material is written by Dr. Ganesh Gautam Dr. Shibalal Bhandari 
and Dr. Asis Mahat the subject matter of the materials, was edited by Mr. Badrinath 
Timsina and Mr. Khilanath Dhamala and language was edited by Mr. Bijaya Kumar 
Ranabhat. CDC extends sincere thanks to all those who have contributed to developing 
this material in this form.

This learning resource material contains a wide coverage of subject matters and 
sample exercises which will help the learners to achieve the competencies and learning 
outcomes set in the curriculum. Each chapter in the material clearly and concisely deals 
with the subject matters required for the accomplishment of the learning outcomes. 
The Curriculum Development Centre always welcomes constructive feedback for the 
betterment of the material.

2082 BS	 Ministry of Education, Science and Technology	
	 Curriculum Development Centre
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Guidelines to Teachers

A.	 Facilitation Methods

The goal of this course is to combine the theoretical and practical aspects of the 
contents needed for the subject. The nature of contents included in this course 
demands the use of practical or learner focused facilitation processes. Therefore, 
the practical side of the facilitation process has been focused much. The instructor 
is expected to design and conduct a variety of practical methods, strategies or 
techniques which encourage students engage in the process of reflection, sharing, 
collaboration, exploration and innovation new ideas or learning.  For this, the 
following teaching methods, strategies or techniques are suggested to adopt as 
per the course content nature and context.  

Brainstorming

Brainstorming is a technique of teaching which is creative thinking process. 
In this technique, students freely speak or share their ideas on a given topic. 
The instructor does not judge students’ ideas as being right or wrong, but rather 
encourages them to think and speak creatively and innovatively. In brainstorming 
time, the instructor expects students to generate their tentative and rough ideas 
on a given topic which are not judgmental. It is, therefore, brainstorming is free-
wheeling, non-judgmental and unstructured in nature. Students or participants 
are encouraged to freely express their ideas throughout the brainstorming time. 
Whiteboard and other visual aids can be used to help organize the ideas as they 
are developed. Following the brainstorming session, concepts are examined 
and ranked in order of importance, opening the door for more development 
and execution. Brainstorming is an effective technique for problem-solving, 
invention, and decision-making because it taps into the group's combined 
knowledge and creative ideas.

Demonstration

Demonstration is a practical method of teaching in which the instructor shows 
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or demonstrates the actions, materials, or processes. While demonstrating 
something the students in the class see, observe, discuss and share ideas on 
a given topic. Most importantly, abstract and complicated concepts can be 
presented into visible form through demonstration. Visualization bridges the gap 
between abstract ideas and concrete manifestations by utilizing the innate human 
ability to think visually. This enables students to make better decisions, develop 
their creative potential, and obtain deeper insights across a variety of subject 
areas.

Peer Discussion

Peer conversation is a cooperative process where students converse with their 
peers to exchange viewpoints, share ideas, and jointly investigate subjects 
that are relevant or of mutual interest. Peer discussion is an effective teaching 
strategy used in the classroom to encourage critical thinking, active learning, 
and knowledge development. Peer discussions encourage students to express 
their ideas clearly, listen to opposing points of view, and participate in debate 
or dialogue, all of which contribute to a deeper comprehension and memory 
of the course material. Peer discussions also help participants develop critical 
communication and teamwork skills by teaching them how to effectively 
articulate their views, persuasively defend their positions, and constructively 
respond to criticism. 

Peer conversation is essential for professional growth and community building 
outside of the classroom because it allows practitioners to share best practices, 
work together, and solve problems as a group. In addition to expanding their 
knowledge horizon and deepening their understanding, peer discussions help 
students build lasting relationships and a feeling of community within their peer 
networks.

Group Work

Group work is a technique of teaching where more than two students or 
participants work together to complete a task, solve a problem or discuss on a 
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given topic collaboratively. Group work is also a cooperative working process 
where students join and share their perspectives, abilities, and knowledge to 
take on challenging job or project. Group work in academic contexts promotes 
active learning, peer teaching, and the development of collaboration and 
communication skills. Group work helps individuals to do more together than 
they might individually do or achieve.

Gallery Walk 

Gallery walk is a critical thinking strategy. It creates interactive learning 
environment in the classroom. It offers participants or students a structured way 
to observe exhibition or presentation and also provides opportunity to share 
ideas. It promotes peer-to-peer or group-to-group engagement by encouraging 
participants to observe, evaluate and comment on each other’s work or ideas. 
Students who engage in this process improve their communication and critical 
thinking abilities in addition to their comprehension of the subject matter, which 
leads to a deeper and more sophisticated investigation of the subjects at hand.

Interaction

The dynamic sharing of ideas, knowledge, and experiences between people 
or things is referred to as interaction, and it frequently takes place in social, 
academic, or professional settings. It includes a broad range of activities such 
as dialogue, collaboration or team work, negotiation, problem solving, etc.  
Mutual understanding, knowledge sharing, and interpersonal relationships 
are all facilitated by effective interaction. Interaction is essential for building 
relationships, encouraging learning, and stimulating creativity in both in-person 
and virtual contexts. Students can broaden their viewpoints, hone their abilities, 
and jointly achieve solutions to difficult problems by actively interacting with 
others.

Project Work

Project work is a special kind of work that consists of a problematic situation 
which requires systematic investigation to explore innovative ideas and solutions. 
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Project work can be used in two senses. First, it is a method of teaching in regular 
class. The next is: it is a research work that requires planned investigation to 
explore something new. This concept can be presented in the following figure.

Project work

Method of teaching Research based work

Project work entails individuals or teams working together to achieve particular 
educational objectives. It consists of a number of organized tasks, activities, and 
deliverables. The end product is important for project work. Generally, project 
work will be carried out in three stages. They are:

•	 Planning

•	 Investigation

•	 Reporting

B.	 Instructional Materials 

Instructional materials are the tools and resources that teachers use to help students. 
These resources/materials engage students, strengthen learning, and improve 
conceptual comprehension while supporting the educational goals of a course or 
program. Different learning styles and preferences can be accommodated by the 
variety of instructional resources available. Here are a few examples of typical 
educational resource types:

•	 Daily used materials

•	 Related Pictures

•	 Reference books

•	 Slides and Presentation: PowerPoint slides, keynote presentations, or 
other visual aids that help convey information in a visually appealing 
and organized manner.

•	 Audiovisual Materials: Videos, animations, podcasts, and other 
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multimedia resources that bring concepts to life and cater to auditory 
and visual learners.

•	 Online Resources: Websites, online articles, e-books, and other web-
based materials that can be accessed for further reading and research.

Maps, Charts, and Graphs: Visual representations that help learners understand 
relationships, patterns, and trends in different subjects.

Real-life Examples and Case Studies: Stories, examples, or case studies that 
illustrate the practical application of theoretical concepts and principles.

C.	 Assessment

Formative Test

Classroom discussions: Engage students in discussions to assess their 
understanding of concepts.

Quizzes and polls: Use short quizzes or polls to check comprehension during or after 
a lesson.

Homework exercises: Assign tasks that provide ongoing feedback on individual 
progress.

Peer review: Have students review and provide feedback on each other's work.

Summative Test

Exams: Conduct comprehensive exams at the end of a unit or semester.

Final projects: Assign projects that demonstrate overall understanding of the 
subject.

Peer Assessment

Group projects: Evaluate individual contributions within a group project.

Peer feedback forms: Provide structured forms for students to assess their peers.

Classroom presentations: Have students assess each other's presentations.
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Objective Test

Multiple-choice tests: Use multiple-choice questions to assess knowledge.

True/False questions: Assess factual understanding with true/false questions.

Matching exercises: Evaluate associations between concepts or terms.

Portfolio Assessment

Compilation of work: Collect and assess a variety of student work samples.

Reflection statements: Ask students to write reflective statements about their 
work.

Showcase events: Organize events where students present their portfolios to 
peers or instructors.

Observational Assessment

Classroom observations: Observe students' behavior and engagement during 
class.

Performance observations: Assess practical skills through direct observation.

Field trips: Evaluate students' ability to apply knowledge in real-world settings.
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1.1 	 Introduction to Livestock Extension
Education is the process of changing of human behaviour on desirable direction. 
Education is the teaching learning process. “Education is simply, process of 
acquiring (gaining) knowledge and skill through instruction and study. Education 
aims to change in three main componen9t of human. They are,

•	 change in knowledge

•	 change in attitude

•	 Change in skill

•	 change in values

•	 change in ability to do

Types of Education 

Education is broadly classified as: 

1.	 Formal education

2.	 In-formal education

3.	 Non-formal education

Formal Education

Formal education is a chronologically graded system of education at school and 
university. It is subject oriented, full time, sequential, hierarchically structured 
and leading to certificate, degree and diploma.

In-formal Education

In formal education is a lifelong process by which person acquires knowledge, 
skill and attitude from day to day experience and surrounding environment. 

Unit  
1

Introduction to Livestock 
Extension
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Non-formal Education

Non formal education is not like formal education like in school, university. It is 
an organized, systematic, educational activity carried on outside the framework 
of the formal system or formal education.

Extension education differs from formal education in a number of ways. Some 
of them are as follows :

S.N Formal Education Extension (non- formal education) 
Education

1 Formal education is for those 
who come to school and college

Non formal education is those who 
don’t come to school and college

2 (Learner) Hierarchically 
structured curriculum

No Hierarchically structured, Need 
based.

3 Learners study the subject Learners study the problems

4

Formal admission, registration 
and examination system

No formal admission, registration 
and examination system

5 Compulsory class attendance Voluntary class attendance
6  Learning by repetition and book 

work
Learning by discussion and practice

7 Teacher authoritarian Learner authoritarian
8 More theory More practical
9 Teacher, lecturer Facilitator

1.1.2	Concept and Definition of Extension Education  

The word extension has been derived from Latin language where ‘Ex’ means out 
and ‘tension’ means stretching. Thus, literally extension means the extending 
something which is an out of school education. It transmits latest technology 
to rural farmers and bring back their reaction to the researchers, it works like a 
bridge between the farmers and researchers.

Researchers FarmersExtension Education
New technology

Reaction Reaction

New technology
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Some definition of extension education are as follows:

“Extension is two way bridges carrying information from research workers to 
the rural people and bringing back knowledge and suggestions based on local 
experiences as a guide for the further research.” - C.W.  Lynn

“Extension is the process of extending knowledge of recent advances of Science 
and technology to the people who need it most.”  - B.Rudramathy

“Extension is as out of school system of education in which the adults and young 
learn by doing the job themselves.”	 - Kesley and Heane 

1.1.3	Scope and Important of Extension Education

The scope of extension education is applied in many sectors which are as fallows;

1.	 Agricultural extension-Agricultural growth

2.	 Livestock extension-Breeding, managing, feeding and caring of animal 
and birds

3.	 Agricultural engineering extension-farm tool and machines

4.	 Homes science extension-Balance diet, child care, home decoration, 
tailoring, kitchen 

5.	 Dairy extension-raising of milk animals and milk products 

6.	 Public health extension-Hygiene family planning, childcare, vaccination 
and prevention of diseases

7.	 Forestry extension- tree plantation, forest conservation and utilization to 
the people.

1.1.4	Philosophy, Objectives and Principles of Extension Education   	

Objective of Extension Education

1.	 To transfer the latest technology to the farmers and bring back the reaction, 
an experience, problems and opportunities to the researches.

2.	 To make farmers skillful and efficient to use new technology in agriculture.

3.	 To improve farmers decision-making ability in farm management.
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4.	 To make people self-help.

5.	 To help rural people to utilize local resources.

6.	 To promote farmers access to various agriculture development program.

Principle of Extension Education

Principle of extension is the fundamental guideline to make extension programmer 
effective and successful. i.e.

1.	 Principle of Interest and Need

Extension education must be based on interest and need of the people so 
extension worker should first identify the particular need of particular 
people and place before carrying out an extension education program.

2.	 Principle of Grass Root Approach

Planning of extension program should not be imposed from the top. It 
should be identified from the family and village level and not by planner.

3.	 Principle of cultural Difference

It should be undertaken from people’s participation but not only by the 
lecture but also by discussion and practices. 

4.	 Principle of whole Family Approach

Extension program must be directed to the benefit and development of 
whole family and not the individual member. 

5.	 Principle of Learning by Doing

Extension should encourage farmers to learn new things by doing. Learning 
by doing makes people confident to use new method and technology at 
their home and farm.

6.	 Principle of Democratic Approach

Program must be democratic decision and must be made from discussion 
and consensus and not from imposing.
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7.	 Principle of Self Help

Extension should be helping people to help themselves. Villagers should 
make aware that the outsiders can only assist them but the they should do 
their best themselves.

8.	 Principle of Flexibility in Teaching Methods

Teaching method and materials must be flexible with respect to age, 
gender, education, economic status, culture etc.

9.	 Principle of Participatory Teaching

Extension program should be under taken people participation. Teaching 
method should not be lecture but discussion and practices.

10.	 Principle of Flexibility Leadership

Local leader can motivate and influence the local people effectively then 
outsiders so local leadership must be developed and trained to make 
extension programme successful.

11.	 Principle of Indiscrimination

For extension program, every individual is equal irrespective of age, cast, 
gender, education, social economic status etc.

12.	 Principle of Evaluation

Evaluation of extension program to identify its success makes easier to 
find errors, strength, weakness and opportunities of the program and the 
corrective action for further program.

13.	 Principle of Satisfaction

The successions of extension wok lie in the satisfaction of the people. If 
the participants are not satisfied, they will not participate in the future.

Philosophy of Extension

The word philosophy has origin from Greek language”philos” meaning education 
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or knowledge and “sophia” means way of acquiring knowledge. Philosophy is a 
body of general principles or laws of a field of knowledge; it provides guidelines 
for performing the activities in life in a particular way. Some philosophies of 
extension education are as follows :

1.	 Extension is an education process that changes knowledge, skill, attitude 
and behaviour of people.

2.	 Extension is help people hemselves.

3.	 Extension is learning by doing and believing by seeing.

4.	 Extension is a two-way channel.

5.	 Extension is a never-ending process.

6.	 Extension is the best on cooperative effort.

1.2 	 Historical Perspectives of Livestock Extension Development in 
Nepal

Timelines Key events 
1850 AD  

(1907 BS) 

Import of improved livestock from the United Kingdom and 
France and started formal Agriculture Development in Nepal by 
Jung Bahadur Rana and Chandra Shamsher Rana. 

 

1851 AD 

Then, the prime minister of Nepal, Jung Bahadur Rana, initiated 
breeding in cattle in the country by importing the semen of one 
jersey bull, two jersey cows, and the seed of white clover grasses 
from Britain. 

Establishment of the first Agriculture office or Agriculture Council 
in Nepal by the Prime minister Junga Bahadur Rana. 

1922 AD Establishment of the first agricultural station as an agricultural 
office in Singha Durbar at the governmental level. Establishment 
and re-strengthening of the Agriculture office and Agriculture 
Council in Nepal by then Prime minister Chandra Shamsher Rana. 

1925 AD Formation of Agriculture Department in Nepal. 
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1937 AD Formation of Agriculture Council, Provision made for director 
of the agriculture department to be appointed as head of an 
agriculture council, Establishment of sheep farm in Chitlang and 
Shivapuri, import of Red Sindhi cow from Pakistan, Initiation to 
send Nepalese student in India for Agriculture training by Chandra 
Shamsher, Establishment of first commercial Agricultural school. 

1938 AD Formation of Agriculture development Board by merging the 
Agriculture Department and Agriculture Council 

1939 AD Establishment of Veterinary dispensary. 
1940 AD Establishment of the first veterinary hospital in Kathmandu, 

Treatment of livestock by Homeopathy method, the introduction 
of awareness about animal health, and initial works for animal 
treatment. 

1944 AD Establishment of Government sheep farm. 
1952 AD 

 

Execution of Tribhuvan Rural Development Program (TRDP) with 
the help of British Government, development of the organizational 
framework in agricultural communication. 

1957 AD Rural Development Workers (RDW) produced from Agriculture 
school under the Agricultural department was given additional 
training, and these RWD training programs were converted into 
JTA training. 

1958 AD Reformation of Agriculture Department, Initiation of the Livestock 
Development sector, Establishment of livestock development farm. 

1967 AD Establishment of Khumaltar livestock farm. 

1967 AD Establishment of livestock development and livestock health 
department. 

1968 AD Conversion of Agriculture school into Agriculture colleges.  
1972 AD Establishment of the Institute of Agriculture and Animal Science 

in Kathmandu. 
1973 AD Livestock Development and Livestock Health Department merged 

into Department of Agriculture 
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1979/80 Re-establishment of Livestock Development and Livestock 
Health Department, Establishment of Regional Livestock Service 
Directorate in each region. 

1982/83 Establishment of Veterinary hospital in every district, 480 livestock 
service centres established. 

1989 AD Changed the name of Livestock Development and Livestock 
Health Department to the Department of Livestock Service. 

1992 AD Department of Livestock Service reunited with the Department of 
Agriculture. 

1995 AD Livestock service department re-separated. Establishment of 
district livestock service office in 75 districts, Establishment of 
359 livestock service centre, and 640 livestock service sub-centre. 

1995 AD Adoption of Agricultural Perspective Plan (APP), 20 years of 
agricultural development program, by the Government of Nepal. 

1997 AD Third Livestock Development Project (TLDP) was a people-
centered project implemented from 1997 to 2004. This ADB 
project promoted the Systems Learning Approach (SLA)” of LS 
in the country. TLDP programs have been implemented in 19 
districts of Western (12 districts), Mid-Western (3 districts), and 
Far-Western (4 districts) regions of Nepal. 

2003 AD Community Livestock Development Project (Nepal) was initiated 
from 2003 to 2011.  

2004 AD National Agricultural Policy 2061 BS was adopted by the 
Government of Nepal, which has institutionalized several 
modernization policy issues and directives pertaining to agriculture 
(LS services) and with emphasis on the gradual transformation of 
subsistence mode of farming into commercial and competitive 
agricultural (and LS) system in the country.  

2007 AD Agricultural business promotion policy adopted by the GoN. 
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2070 BS Initiation of Youth Targeted Livestock Production Programs 

Initiation of Livestock Insurance Policy with targeted programs 
from DLS 

55 Embryos (30 Jersey and 25 HF breed) were transferred in some 
of the selected private farms and NARC cattle farm Khumaltar 

2071 BS A liquid nitrogen plant with a capacity of 30 litres/hour was 
established in NLBC, Pokhara 

2072 BS •	 Adoption of ADS 2015-35 (Agricultural Development 
Strategy), a 20 years’ program by GOvt. of Nepal, which has 
given high-value production (including LS services) in the 
country.  

•	 A separate ministry named as Ministry of Livestock 
Development (MOLD) was established by GON 

•	 4o-points commitments were approved and published from the 
MOLD to achieve the target of becoming self-reliant on eggs 
within one year, on meat within two years, and milk within 
three years. 

•	 Initiation of One Village Development Committee One 
Technician (OVOT) programs almost in all districts of Nepal 

2073 BS •	 The budget of the FY 2073/74 for the livestock sector was 
increased by more than double in research and extension. 
Accordingly, an appreciative volume of the budget was 
allocated to DLS and DLSO to achieve the target as stipulated 
in 40 points commitment of the ministry. 

•	 A full capacity second NLBC at Lahan (as the backup of 
the NLBC, Pokhara) was started with the ample budget, as 
proposed by the Directorate of Livestock Production/DLS in 
Plan of the DLS. 

•	 Animal Welfare Guideline, 2073 (based upon the animal 
transportation standard, 2064) approved by the MoLD 
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•	 The Directorate of Fishery which was under the department of 
agriculture has been brought to DLS 

•	 Altogether 26 Joint secretary posts (12 veterinaries, 11 
livestock, and 3 fishery have been approved by the 

      GON and registered in the Department of Civil Service Record 
of the Ministry of Federal Affairs and General Administration 
(MOFAGA) 

•	 International Buffalo Symposium organized in Sauraha of 
Chitwan

2074 BS As per the 2015 federalism-based constitution of Nepal, the LS 
services were devolved into provincial and local government level, 
wherein, farmers' level extension of LS services to municipalities 
(LS Units) and monitoring and evaluation work to the provincial 
government. 

•	 The MOLD was merged in the MOAD and renamed the united 
ministry is called as Ministry of Agriculture and Livestock 
Development (MOALD) 

•	 The previous four directorates (Directorate of Livestock 
Production, Directorate of Animal Health, Directorate of 
Livestock Market Promotion, and Directorate of Livestock 
Training &Extension) under the DLS has been merged and 
renamed as Livestock Disease Diagnosis & Control Division, 
Livestock Quarantine Division, and Animal Genetic Resources 
& Economic Analysis Division   

•	 Two livestock farms; Poultry Development Farm, Khajura, and 
Goat Development Farm, Chitlang, have been handed over to 
the respective provincial government, Livestock Development 
Farm, Pokhara, and NLBC, Pokhara have merged and renamed 
as National Livestock Breeding Farm. Two other LBOs 
(Gaughat, Banke, and Lahan) have also renamed as NLBO 
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2075 BS A full-fledged Project Coordination Unit (PCU) has been 
established in the DLS and started to work as per its To Rs. 

2076 BS •	 7thInternational Conference on Sustainable Animal Agriculture 
for Developing Countries (SAADC) was organized in Pokhara, 
attended by more than 300 national and international delegates 
participated.  

•	 Covid-19 pandemic-related lockdown started in Nepal from the 
3rd week of March 2020; which has kept stand and still of all 
sectors of the economy, including all sub-sectors of agriculture 
(and livestock and veterinary programs and activities) in the 
country.  

Source: Adapted from various publications of DLS, MOLD, and MOALD and some 
recent events/development facts and figures (especially of after the 1980s) as recalled 
by the authors' team of the report. 

1.3	 Simplify Organizational Structures of Livestock Extension 
Systems in Nepal.

The Federal Ministry of Agriculture and Livestock Development (MOALD), 
which is the main body for agriculture development in Nepal is comprised of 
three central departments, central laboratories, and commodity development 
centers, and national priority projects, such as the Prime Minister Agriculture 
Modernization Project (PMAMP). There are altogether nine central agencies, 
three under MOAD, and six under departments. One of the most remarkable 
changes in agricultural institutional reform is the establishment of the Ministry 
of Land Management, Agriculture and Cooperatives (MOLMAC) in each 
province. This ministry operates the agriculture and livestock development, 
related directorates, province-level laboratories, Agriculture Knowledge Centers 
(AKC), Veterinary Hospital, and Livestock Expert Centers at the district level. 
The Agriculture Knowledge Centre has replaced the earlier structure District 
Agriculture Development Office (DADO) and District Livestock Service 
Offices (DLSO) with a significant reduction in their roles and responsibilities. 
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There are 44 AKCs (Agriculture Knowledge Centre) and 9 ADOs (Agriculture 
Development Offices), AKCs of Karnali Province replaced by ADOs except 
that of Surkhet District under the provincial level Directorate of Agriculture 
Development (DAD), whose authority is to obtain and diffuse innovative and 
necessary technologies and supply associated support services to producers and 
agribusinesses (Krishi Diary, 2077). 

In the case of local government, the structure consists of an Agriculture 
Development Division which has been established to support technology 
generation and transfer activities. To cover all at the then local level Agriculture 
Service Centers (ASCs) under local government were expanded 753 local 
authorities. Currently, the agriculture sector is under the concurrent right of and 
local level. Farmers can get all the input and services from the program and 
projects implemented by all three tiers of government. The figure 1 given below 
shows the schematic diagram of agricultural extension under federalism.

1.4	 Introduce Current Status of Livestock Extension Services in 
Nepal

Nepal's current agriculture extension service delivery system is passing through 
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several challenges like institutional instability, contradictory power, authorities 
and control among multiple institutions, weak human resources specifically 
at the local level, and a shifting policy system. Nepal's agricultural extension 
services are facing several challenges, including:

1.	 Limited Human Resources

There are not enough extension agents to provide quality services at the local 
level. This is due to a lack of career opportunities and financial incentives for 
extension officers, who tend to stay in central or provincial offices. 

2.	 Poor Coordination

There is a lack of coordination between governmental institutions, which impacts 
service delivery. 

3.	 Conflicting roles and responsibilities

The different levels of government have distinct roles and responsibilities, but 
there is confusion among implementers. 

4.	 Short-term Working Guidelines

Agricultural entities operate under short-term working guidelines, which can 
lead to duplication of programs in some areas and a lack of programs in others. 

5.	 Lack of Governance Understanding

Local and provincial governments lack a proper understanding of governance, 
institutionalization, and human resources management. 

Agricultural extension is a service that helps farmers improve their farming 
techniques, increase production, and improve their standard of living. In Nepal, 
the Ministry of Agriculture and Livestock Development (MoALD) is the apex 
body for agriculture development. The government allocates 3% of the national 
budget to agriculture development. 
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Exercise

Choose the correct answer from the given alternatives.
1.  	 Who is called the father of Extension?

a. A.J. Leagan		  b. M.A. Bell

c. J.P. Leagan		  d. L.J. Fergusin

2.	 What does "extension" mean in the context of agriculture?

a. Informal education	 b. Advice and information

c. Circulation of idea	 d. All of above

3.	 What are the Scope of extension education?

a. Rural area		  b. Urban area

c. Developed country	 d. All of above

4.  	 "In what ways do you think extension education leads to social and 
economic improvements in rural areas?"

a. Youth development 	 b. Leadership development 

c. Community development	 d. All of above 

5.	 How to end product of effort of extension teaching? 

a. Gain of knowledge	 b. Satisfaction 

c. Gain of experience	 d. All of above 

6.  	 What do you mean by extension education?

a. Informal education	 b. Advice and information

c. Circulation of idea	 d. All of above 

7.	 What type of Agri. Extension education focuses on hands-on training and 
practical skills?

a. Formal		  b. Non-formal

c. Informal		  d. Special
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8.	 Which type of education takes place in a structured environment, like a 
school or university?

a. Formal		  b.  Non-formal

c. Informal		  d. Special

9.	 In Nepal, the level of government are..............

a. Federal – province- Local	 b. Province-Local

c. Federal 		  d. All of above 

10.	 Veterinary hospital and livestock expert center is controlled under........

a. Department of livestock service

b. Provincial directorate

c. Livestock service unit 

d. All of above 

11.	 Three tier of agriculture extension services at local, provincial, and federal 
levels started from............

a. 2081		  b. 2020

c. 2016		  d. 2019

12.	 "What additional support would you like in future extension education 
programs?"

a. More hands-on practical training

b. Access to expert consultations

c. Better follow-up and monitoring

d. All of above

Write short answer to the following questions. 
1.	 What is extension education?

2.	 What are the components and elements of extension?

3.	 What do you mean by formal education?
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4.	 Make a chart of extension education process.

5.	 Write the principle of extension education.

6.	 Differentiated between formal and non- formal education.

7.	 Define extension education.

Write long answer to the following questions.
1.	 Describe about the principles of extension education.
2.	 Describe about scope and importance of extension.
3.	 Describe about the steps of extension education process.
4.	 Mention the historical background of livestock extension development in 

Nepal.
5.	 Make a chart of organizational structure of livestock extension system of 

Nepal.

6.	 What are the current livestock extension services found in Nepal?
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Meaning of Communication 
Communication is the process of exchanging information, ideas, and meanings 
between two or more people. It is two-way process involves both understanding 
and expression.  The word "communication" comes from the Latin word 
communis, which means "common" or "to share"

The word ‘Communication’ has been derived from the latin word ‘Communicare’ 
or ‘Communis’ which means to join, to unite, to share or to have things in 
common (Communicative English For Engineers and Professionals). 

According to Newstrom & Keith Davis, “Communication is the transfer 
of information form one person to another. It is a way of reaching others by 
transmitting ideas, feelings, thoughts, facts and values.” 

Megginson said, “Communication is the process of transmitting meanings, ideas 
and understanding of a person or a group to another person or group.” 

According to William Rice-Johnson, “Communication takes place when one 
individual, a sender, displays, transmits or otherwise directs a set of symbols to 
another individual, a receiver, with the aim of changing something the receiver 
is doing (or not doing) or changing his or her world view. This set of symbols is 
typically described as a message”

According to W.H.  Newman and C.F. Sumer Jr. “Communication is an exchange 
of facts, ideas, opinions or emotions by two or more persons.”

Unit 
2

Communication and 
Innovation, Extension 

Education System
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2.1	 Types & Modes of Communication
The four  types of communication  you need to know about are verbal 
communication, nonverbal communication, written communication, visual 
communication

1. 	 Verbal Communication 

A.  Oral communication: Communication is done through spoken words, Face-
to-face talk, telephonic talk, video-chat, television, radio or chat over internet, 
such as Skype or WhatsApp.  Personal traits such as clarity of pronunciation, 
pitch, slang, volume, speed, etc. influence oral mode of conversation.	  

Merit of Oral Communication

1.	 High level of transparency and understanding 

2.	 Quick feedback 

3.	 Flexibility 

4.	  Time and other resources saving 

5.	 Helpful for teamwork 

6.	  Best for confidential exchange of information 

7.	 Quick resolution of disputes 

8.	 Receptive and encouraging 

9.	  Facial expressions and body language visible

Limitation of Oral Communication

1.	 Informal and no proof of decision

2.	  Poor personal traits, such as stammering, weaker command on 
language, slang, no coherence visible 

3.	  Less authentic 

4.	 It may consume long time in meetings 

5.	  It requires great attentiveness and receptivity

6.	  No legal standing
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2.	 Written Communication 

1.	 Communication is written in words or symbols and is transmitted via 
e-mail, letter, memo, etc. 

2.	 Many social media platforms based on Internet are available, where 
written communication is posted. 

3.	 Writtten communication is an meant for mass circulation, instead 
for an individual. Written communication is most commonly used in 
business and its contents, vocabulary, style, precision and clarity are 
very important achieving its objective.

Merit of Written Communication 

1.	 Writtten communication is permanent record and can be used as 
reference in future. 

2.	 Sender can write and re-write to make it error free before sending. 

3.	 Presence of the sender and the receiver is not required. 

4.	 Sometimes there are complex matters that cannot be talked over in a 
satisfactory manner. In the written communication, complex matters 
can be explained. 

5.	  Being a written document, there are no chances of misconception. 

6.	 Message can be sent to a large number of targeted people.

Limitation of Written Communication

1.	 Time consuming. 

2.	 Requires good command on the language

3.	 Poorly written communication may create poor impression. 

4.	 Feedback is not instant. 

5.	  No personal touch.

C.	 Visual and Audiovisual communication: “A picture is worth than thousand 
words”. Audio-visual communication is a combination of sight and sound.
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Merit of visual and Audiovisual communication

1.	  Supports oral communication 

2.	  Easy presentation of complex data 

3.	  Helpful for rural clients 

4.	  Saves time 

5.	 Decision making is quicker 

6.	 Helpful in publicity

Limitations of Visual and Audiovisual Communication

1.	 More expensive 

2.	 Time consuming 

3.	 Some times more complex 

4.	 Infrastructural problems

2.	 Non -Verbal Communication

1.	 Communication without using words, such as gesture, body language, 
facial expression. 

2.	 Often non-verbal expression supplements the verbal communication. 

3.	 Leader often uses gestures, to emphasize certain points. 

Type of Non Verbal Communication 

a) Body language (Kinesics) 

b) Facial expressions

c) Posture 

d) Gestures 

e) Touch (Haptics) 

f) Proxemics
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2.1.1	Process/Models of Communication (SMCRE Communication model)   

Communication- Communication is the exchange of ideas, feelings, factors 
or information between two or more individuals or organizations. In brief, 
communication is the transfer of message from the sender to the receiver.

Communication is complete only if the receiver understands the message, in 
same meaning as expected by the sender. Therefore, “Communication is defined 
as a process by which two or more people exchange ideas, facts, feelings or 
message in ways that each gets common understanding of the message.

Berlo’s SMCR model of Communication

Sender or source: A person or organization sending the message is called a 
sender or a source. The sender encodes the message and sends it selecting one 
or more appropriate channels depending on situation a farmers (from DADO)

Message: The message is the subject metter or the content of communication. 
It is the information that sender wants to transfer to the receiver, message is 
first encoded in symbols like words, sounds, number, gesture, picture etc, before 
sending the message through the channel.

Channel: It is medium for message transformation channel which can be 
audiovisual aids:- TV, radio, film etc

Printed media: - Newspaper, magazine books etc

Electronic Media: - telephone, fax, e-mail

Carrie: - person, post, curriers etc

Receive: Receiver is the target person for audience who receives the message 
after receiving the message. The receiver decodes and understands it. Depending 
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on situation of a farmer, DADO etc can be receiver. There may be one person or 
more people.

2.1.2	Five Steps Involved in a Successful Communication Process

1. 	 Sender or Communicator

A person who conveys information to another person is called sender or 
communicator. She develops ideas or information to be transmitted.

2. 	 Message or Ideas

Communication does not take place without message. This is the main element 
of communication process. Message consists of facts, ideas, thoughts, opinions, 
data etc. to be conveyed to the receiver.

3. 	 Encoding

Encoding is the process of converting subject matter or message into words, 
symbol, voice, pictures etc. Sender translates the information into a perceivable 
form by encoding it.

Source:https://marketinglord.blogspot.com/2017/11/process-of-communication.html

4.	 Selecting the Channel of Communication

Proper channel of communication should be selected to transmit the message. 
Message can be transmitted by audio-visual (TV, radio etc), by print media 
(magazine and newspaper) or by face-to-face contact.
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5. 	 Receiver

Receiver is a target party of communication or the person to whom the message 
is meant for. Receiver may be a listener, or reader, or viewer.

6. 	 Decoding

After receiving the message, the receiver decodes (processing the message into 
understanding) it.Decoding is to translate message into a meaningful form.

7. 	 Feedback

Feedback is the final stage of the process of communication. Feedback is the 
response regarding the message sent by sender. It ensures the effectiveness of 
encoding, transmitting and clarity of the message.

Rogers and Shoemaker Model (1971)

Rogers and shoemaker model (1971) thought of the communication process in 
terms of the S-M-C-R-E model accounting to them (a) source (s) send a message 
(M) via certain channel (C) to the receiving (R), which causes some effects (E) 
i.e. changing the existing behaviour pattern of the receiver. The components of 
which are as follows;

•	 Source 

•	 Message 

•	 Channel

•	 Receiver

•	 Effects

Most of the mass communication researchse have implicitly followed this model.
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2.2	 Organizational communication (Meaning, flow of communication; 
upward, downward, lateral, horizontal communication)

Meaning of Organizational Communication

Organizational communication includes formal and informal communication 
throughout an organization, including communication among employee-manager 
communication. Organizational communication can be formal or informal, flow 
in various directions and make the use of various media.

Formal Communication  

Being formal, clear and specific is a great way to ensure a proper flow of 
information in the workplace. With formal communication, everyone is 
informed about and aligned with business goals. This type of communication is 
also required to meet legal requirements. For example, work, as well as safety 
rules and guidelines, have to be communicated to the employees in a formal way 
(Emails, printed documents).

Informal Communication

formal communication is the opposite to the formal communication. It includes 
dialogues, chats, phone conversation as well as the “water cooler talks” that 
usually take place near the coffee maker that don,t rely on any formalities. It 
is a faster way of sharing information in the workplace. It also helps share and 
develop new ideas to improve products as well as internal or external processes.

Flow or Directions of Organizational Communication can be of 4 Types:

Upward flow: Upward communication is initiated by staff and directed at 
executives; it frequently takes place the formal of a complaint or a request.

Downward flow: Downward communication flows from the managerial and 
executive levels to the staff through formal channels such as policy manuals, 
rules and regulations and organizational charts.   

Horizontal flow: Horizontal communication occurs when colleagues meet and  
discuss the issues of common interest, resolve problems and share information.
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Lateral flow: This type of communication occurs when two or close persons 
meet together to share the information.

2.3	 Meaning of Diffusion and Stages of Innovation-decision Process  
Diffusion- Diffusion is the transfer and spread of the innovation to most of the 
farmers in the community. Diffusion is the process by which the innovation 
is transferred from the sources to the ultimate users. Adoption is the use of 
innovation in individual level. Therefore, the diffusion process also includes the 
adoption process but diffusion occurs among many people while adoption is an 
individual.

Innovation: Innovation is an idea, technology, practices or object perceived as 
new by the people. People who try the innovation for the first time in commodity 
are called innovators. 

Stages of Innovation-decision Process

•	 Awareness

•	 Interest

•	 Evaluation

•	 Trail

•	 Adoption 

Awareness: The individual just hears about an innovation but lacks detail 
information. She only knows that a new idea exists but he does not know how it 
works and what its potential usefulness is.

Interest: Awareness stage makes the individual curious.  He develops interest on 
new idea and seeks detail information. He collects information from extension 
workers, technicians and others on how it is, how it works and what are its 
potentially.

Evaluation: In this stage individual evaluates his/her findings. She compares 
the relative advantages and disadvantages of the ideas. She asks many questions 
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in mind about how he/she do it? Is it better than what she is doing? etc. After an 
overall evaluation, an individual makes mental decision whether or not to try the 
new idea.

Trial: If the mental evaluation is favourable the individual experiments the new 
idea on a small scale to measure its utility on his situation. He collects inputs and 
affords source land, money and labour to the trial to see the results.

Adoption: If the individual is satisfied with the trial. She/he adopts the idea. 
She/he uses the new idea continuously on a large scale. The individual uses the 
idea continuously until a better idea does not appear.

Classification of Adopters  

All persons of a community do not adopt an innovation immediately. Some 
people adopt earlier and the other later based on the willingness toward adoption, 
people in a community can be classified into 5 categories.

Figure: Adopters categorization on the basis of innovativeness

Classification of Adopters

1.	 Innovators: innovator are the experimenters who try an innovation for the 
first time in a community. They need no motivation and persuasion (try to 
do). They are usually better educated, financially strong high community 
status, willingness to bear risk and good access with information resources.

2.	 Early adaptors: Early adaptors don’t try the new idea for the first time but 
are the followers of innovators. They can be self-motivated or persuaded 
by extension workers or innovators. 
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3.	 Early majority: These adopters adopt new idea earlier than the majority. 
Their adoption decision process is longer than innovator and early 
adopters’.

4.	 Late majority: These categories adopt new idea when the average villagers 
have adopted it. They are security oriented and not willing to take risk.

5.	 Laggard: This group is adopting an innovation in the community. They 
are more conservation, older, less educated and having less social contract 
and resistance to the change.

2.4 	 Extension Education Systems and Cooperatives, Audiovisual 
Aids

Extension teaching methods are the tools and techniques used to create situations 
in which communication can take place.

These are the methods of importing new knowledge and skills to the rural people 
by drawing their attention towards such technologies, there by arousing their 
interest and helping them to have a successful experience of the new practice. 
Various type of extension education teaching methods are:

Extension Teaching Methods  

Teaching method used in extension education are of three typesthey are;

1.	 Individual/Interpersonal method

2.	 Group method

3.	 Mass method

1.	 Individual method: In this method one person is used to teach one 
person at a time. It is the best and most effective method for adoption of 
new technology. It is the direct personal contact of extension workers 
with the farmers. The techniques used in individual method are;

1.	 Farm  and Home visits /field visit

2.	 Office calls

3.	 Telephone call

4.	 Personal letter
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Merit  of Individual/Interpersonal Method

1.	 Good relationship between extension workers and farmers.

2.	 It is easy to motivate farmers to accept new technology.

3.	 It helps to select local leader and demonstrators.

4.	 Farmers can become clear about subject matter which they don't 
understand.

5.	 It is useful for teaching complex practices.

Limitation of Individual/interpersonal Method

1.	 Costly and time consuming process.

2.	 Comparatively low coverage because extension worker can teach only 
one at a time.

2.	 Group methods: Extension worker can teach a group of farmers at a 
time. Group method is also direct contact of extension workers with a 
group of farmers for a definite purpose. Useful tools and teaching of 
group methods are demonstration field trip, meeting, group discussion, 
brainstorming, role play, panel discussion, lecture, seminar, workshop, 
forum etc.

Demonstration

Demonstration is to show people how things are done or what are the result of 
certain experiments therefore demonstration is of two types.

Method Demonstration

Result Demonstration

Methods Demonstration-Method demonstration is a short time practical work 
to show and tell people how to use an entirely new practice or an old practice in 
better way. It teaches farmers how the things are done. For example-

1.	 How to applied fertilizer?

2.	 How to raise free seedlings?

3.	 How to spray the mixture?



31Animal Science (Grade 9)

Merits of Method Demonstration

1.	 Suitable in teaching skills to many people at a time.

2.	 Enables face to face discussing and practicing, stimulate the interest 
and the action of the learning.

3.	 Builds confidence to both the extension worker and farmers.

4.	 Creates good relationship between extension worker and farmers.

Limitations of Method Demonstration

•	 Suitable to teach only the skill and not the concept.

•	 Need of high effort for preparation and presentation

Result Demonstration

1.	 Result demonstration is a way of showing people the values of worth 
of a new practice write in paragraph.

2.	 It helps to compare a new practice with an old. In result demonstration 
extension workers select demonstrator farmer and demonstration new 
seed or breed verities on their farm. Result demonstration normally 
includes methods demonstration also. 

Merit of Result Demonstration

1.	 Helps to introduce and convince farmers a new practice.

2.	 Conveniences farmers from ”seeing is believing”

3.	 Helps to local leadership development.

4.	 Provides information based on facts.

Limitations of Result Demonstration

1.	 Difficult to find demonstrator farmer willing to keep all the records.

2.	 Takes long time and hard work.
3.	 Adverse result can be obtained due to uncontrollable factors such as 

weather and disease.
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Difference Between Method and Result Demonstration

S.N Method demonstration S.N Result demonstration
1 Method demonstration shows 

how use a new practice or old 
practice in better way.

1 Result demonstration shows and 
verifies how the new practice is 
better than the old.

2 It is useful to teach new methods 
and skills.

2 It is useful to compare new 
practices with the old.

3 It takes shorter time a few hours 
to complete demonstration.

3 It take longer time of weeks 
or months to complete 
demonstration.

4 Extension workers play major 
role in the program.

4 Both the extension worker and 
farmers have equal role.

5 Selection of farmers and place is 
easy.

5 Selection of farmers and 
demonstration plot is difficult.

6 Record keeping is not necessary. 6 Record keeping is compulsory.
7 It is cheaper in cost. 7 It is expensive in cost.

Mass Method

Mass method is used at mass media, extension teaching most popular mass media 
are television, radio, and newspaper. It has high coverage that communicates 
information to a large number of people at a time.

Merits of Mass Method

1.	 Message can reach to a large number of people rapidly at a time.

2.	 It save time and expenses.

3.	 Wholesome cost is relatively high but the cost per audience is very low.

Limitation of Mass Method

1.	 Mass method is less effective in brining behavioral changes.

2.	 Massage recommendation may not suitable to all the audience.

3.	 It is not possible to ask the question because of one-way communication.

4.	 It is difficult to evaluate the results.
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Different Between the Individual Method and Mass Method of Extension 
Teaching

S.N Bases Individual method  Mass method
1 Purpose Individual method is used 

to transfer new information 
personally to the farmers.

mass metod is used to 
transfer information to a 
large.

2 Coverage It teaches and 
communicates a single 
person at a time.

It teaches and 
communicates a large 
mass at a time.

3 Means Home, farm visit, office 
call, telephone call and 
personal letter.

Media like TV, Radio, 
newspaper and audio-
visual.

4 Relationship Direct contact, high 
interaction and good 
relationship.

No direct contact, 
interaction and 
relationship.

5 Cost It is relatively expensive Wholesome cost is high 
but the cost audience is 
very low.

6 Communication 
type

Two way face to face 
communication takes 
place.

One way communication 
takes place.

7 charge Extension worker might be 
charged with favoritism.

There is no chances of 
favoritism.

Extension education is more effective if we used mass media or audio-visual 
aids. Audiovisual aids can be classified in to three groups. They are:

•	 Visual aids

•	 Audio aids

•	 Audio-visual aids
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Visual aids: Visual aids are the teaching materials to teach farmers based on the 
principle of 'learning by seeing and seeing is believing.' Visual aids can be:

1) 	 Projected: for example, the overhead projector, mobile projector, slide 
projector, photo etc

2) 	 Non-projected: for example, non-projected: poster, pamphlets, graphs, 
charts, leaflets, flipchart, flashcards, newspapers, magazine etc.

•	 Audial aids: for example, radio, tape recorder, photograph and loud 
speakers 

•	 Audio-visual aids: for example, these are the materials that can be 
seen and heard examples-film, videos, TV etc
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Exercise

Choose the correct answer from the given alternatives.
1.	 What is Communication through spoken words called?

a. Vocal communication	 b. Non verbal communication

c. Non vocal communication	 d. Mass communication

2.	 What is Communication through written words is called?

a. Vocal communication	 b. Non vocal communication

c. Non verbal communication	 d. D. Kinesics

3.	 What is Communication through gestures and facial expressions called?

a. Vocal communication	 b.  Non vocal communication

c.  Non verbal communication	 d.  Distance communication

4.	 Nodding of head by a person is an example of.........

a. Vocal communication	 b. Non vocal communication

c. Nonverbal communication	 d. Signaled communication

5.	 What is Communication between two or more than two persons called?

a. Vertical communication	 b. Horizontal communication

c. Intra-personal communication	 d. Inter- personal communication

6.	 What is communicatoin model shows a one-way flow of information from 
the source to receiver? 

a. Linear models		  b. Circular models

c. Singular model	 d. Horizontal model  

7.	 Farm and home visit are the examples of ................

a. Individual contact method	 b. Group contact method

c. Mass contact method	 d. Distance contact method
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8.	 Which one of the following is an individual contact method?

a. Office call		  b. Method demonstration

c. Newspaper		  d. Farmer

9.	 Which one of the following is a mass contact method?

a. Symposia		  b.  Seminar

c. News paper		  d. Farmers data

10.	 If socio-economic status of the audience is high, what would be the 
preferable extension method (s)?

a. Individual contact method	 b. Group contact method

c. Mass contact method	 d. Individual and group contact method

11.  	 If socio-economic status of the audience is low, what would be the 
preferable extension method (s)? 

a. Individual contact method	 b. Group contact method

c. Mass contact method	 d. Individual and group contact method

12.	 If size of the audience is small and geographically concentrated, what 
would be the preferable extension method (s)?

a. Individual contact method	 b. Group contact method 

c. Mass contact method	 d. Individual and group contact method

13.	 If size of the audience is large and geographically dispersed, what would 
be the preferable extension method(s)?

a. Individual contact method	 b.  Group contact method

c. Mass contact method	 d. All of the above

14.	 The process, when an innovation (s) is adopted by a society is called...........

a. Diffusion		  b. Adoption

c. Communication	 d. Transmission
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15.	 The process when an individual adopts an innovation is called..............

a. Diffusion		  b. Adoption

c. Communication	 d. Transmission

16.	 If extension organization has limited man power to cover large scale 
population, what would be the preferable extension method (s)? 

a. Individual and group contact method

b. Mass contact method

c. Individual contact method 

d. Group contact method

17.	 Which one of the following communication aids is regarded as only visual 
aid (s)?

a. Motion picture (cinema)	 b. Skit

c. Slides		  d. Telephone

18.	 Which one of the following communication aids is regarded as only audio 
aid (s)?

a. Skit		  b. Slide

c. Telephone		  d. Motion picture

19.	 Which one of the following communication aids is regarded as audio-
visual aid (s)?

a. TV		  b. Slide

c. Telephone		  d. Motion picture

20.	 Which of the following is also known as opinion leaders?

a. Laggards		  b. Early adopters

c. Early majority		  d. Innovators

21.	 Which of the following category does not or hardly adopts an innovation?

a. Laggards		  b. Early adopters

c. Early majority		  d. Late majority
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22.	 At what percentage, does diffusion line start?

a. 2.5%		  b. 13.5%

c. 16%		  d. 34%

23.	 At what stage an innovation is adopted at small scale?

a. Adoption		  b. Trail

c. Interest		  d. Evaluation

24.	 The first stage in adoption process is................

a. Interest		  b. Awareness

c. Evaluation		  d. Trail

Write short answer to the following questions. 
1.	 Define innovation.

2.	 Describe different types of flow of communication in an organization.

3.	 Define adoption.

4.	 Write down the factors affecting in adoption process.

5.	 What is adoption process?

6.	 Classify the adopters in details.

7.	 What do you mean by audio-visual aids?

8.	 Differentiate between leaflets and pamphlets.

9.	 Define communication.

10.	 Define organizational communication.

11.	 What is the difference between result demonstration and method 
demonstration?

Write long answer to the following questions.
1.	 Describe the process of diffusion of an innovation. 

2.	 Describe the strategies of decentralization of program.

3.	 Write the role of extension worker in transfer of technology.
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4.	 What are the stages of adoption process?

5.	 Describe the categories of adopters in details.

6.	 Describe different types of extension education systems.

7.	 Define diffusion. Describe various types of communications.

8.	 Describe various types of models of communication.

9.	 What are different types of audio-visual aids?
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Program: A program is a statement of situation, objectives, problems and 
solutions. It forms a basis for program planning.

Planning: Planning is the determination of carrying out (implementation) a 
program, planning determines what, why, how, when, where and to whom the 
program is intended (target).

3.1	 Principles and Important of Program Planning  
Principles

A planner should keep the following principles in mind while framing (making) 
a plan of a program.

1.	 Extension program planning must be based on an analysis of the facts of 
situation planned.

2.	 Planned program must be based on the need and interest of local people.

3.	 A program should determine problems, priorities and set the objectives a 
program and solutions.

4.	 A planned program should determine a detail plan of work.

5.	 Program planning is a continuous process when one program is finished 
another program should be planned.

6.	 Program planning should involve local people and their institutions.

7.	 A planned program should determine the criteria for evaluation.

8.	 A planned program must be achievable, financially feasible and time 
bound.

Unit 
3

Extension Program Planning, 
Monitoring and Evaluation
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Importance

1.	 Programme planning avoids wastage of resources

2.	 It provides guidance

3.	 It provides continuity                                               

4.	 It helps in leadership development

5.	 It provides local support

6.	 It provides basis for evaluation

3.2	 Program Monitoring, Evaluation and Follow ups
Follow up: Follow up is the direct observation, supervision or monitoring of 
activities to ensure the proper execution of the program. The words follow up 
monitoring/ supervision are used interchangeably in program execution stage. 
They all mean to observe the work of people at work place and provide immediate 
direction and guidance if necessary. However the term supervision refers the 
observation of the task of subordinations by the superiors. While follow up and 
monitoring refer the direct visit if a project or farmers field to find out how the 
activities are being done and what suggestion they need. An extension worker 
follows up the activities of farmers and his/her activities are further followed up 
by his/her superior.

Follow up is performed only by those who are directly related to the program. 
The follow up method must be practicable, reliable and cost effective. Some 
common methods used to perform follow up are as follows:

1.	 Direct field observation

2.	 Collection of information

3.	 Study of written records and reports

4.	 Meeting and group discussion with related people.

5.	 Need of evaluation and its objectives
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3.3	 Extension Program Planning Process and Decentralized Program 
Planning Process  
1.	 Situation analysis

2.	 Organization for planning

3.	 Program planning process

4.	 Planned program

5.	 Plan of work

6.	 Execution of plan of work

7.	 Appraisal of accomplishment

1.	 Situation Analysis: Situation analysis includes the collection of social 
economic, technical facts and other relevant data from the local people and 
local leaders. Methods like surveys, questionnaires interviews and PRA/
RRA can be used for situation analysis. Situation analysis helps to identify 
the needs and problems of the people.

2.	 Organization for Planning: Participation of local people makes them 
feel that the program is their own, planned by them and is for their own 
welfare. Therefore, the extension worker or the planner in this step should 
determine to whom to involve and which organization or group are to 
cooperative in the program.

3.	 Program Planning Process

a.	 Determine the clients (farmers, housewives, youth, children agriculture, 
forms etc) to serve.

b.	 Identify the needs and the problems of the clients.
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c.	 Prioritize the needs on the basis of relative importance.

d.	 Determine alternative solutions.

e.	 Determine program objectives.

4.	 The planned program: It is a written statement of situation, programs, 
objectives and solutions. It contains

a.	 Name of the program.

b.	 Name of the planner.

c.	 The procedures to be fallowed.

d.	 Situation statements of needs, problems and solution.

e.	 Statement of agreed objective.

f.	 Provision for co-operation with other agencies.

5.	 Plan of Work: Plan to work is the outline of specific activities for the 
implementation of program. It indicates what, how, where and by who the 
actions are to be taken.

6.	 Execution of Plan of Work: Program execution is the heart of program of 
planning here the people work as planned and acquire knowledge and skill 
to execute the plan.

7.	 Appraisal of Accomplishment: It ensures where the objectives are 
achieved or not. The result of such evaluation is used as the basis for 
planning of future program.

3.3.1	Decentralized Program Planning Process  

Program planning is a producer of working with the people to recognize the 
problems and to determine the possible solutions. This is a conscious effort 
to meet the needs, interest and wants of the people to whom the program is 
intended. Program planning is therefore defined as “a process of assessing the 
existing situation, analyzing it. Identifying the needs and problems setting of 
objectives proposing solutions and developing a details plan of work” in brief 
program is a statement of situations, objectives, programs and solution and the 
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planning is the predetermination of activities to carry out the program.

Program planning is termed as decentralized program. Planning if the power 
and authority of planning is delegated (given) to the working is decentralized 
program planning. Local people fully participate in all the steps of planning 
process. It provides an opportunity to take part in planning to all men, women 
and children in planning process to which the plane is intended.

3.4	 Need of Evaluation and its Objectives
The term evaluation means to appraise (evaluate) to measure, to judge or to 
determine the value or worth of something. Evaluation is the determination of 
value or quality of a program. Evaluation can be of a process, program, method 
or person. Evaluation measures all the tangible and intangible outcomes of a 
program and determines its impact on communities. Evaluation is made before 
during and after the completion of a program. Evaluation of one program 
becomes the basic to plan next program. The need and objectives of evaluation 
of a program are as fallows :

1.	 To identify the work progress and report it to higher authority.

2.	 To determine the extent of accomplishment of the objective.

3.	 To find out the input, output, effect and impact of a program in the 
community.

4.	 To point out strength and weakness of program execution process.

5.	 To find out people’s reaction. about the program

6.	 To facilitate realistic planning of a future program
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Exercise

Choose the correct answer from the given alternatives.
1.	 Which document is typically used to outline the goals, scope, and 

deliverables of a program or project?

a.	 Program Specification Document

b.	 Project Plan

c.	 Code Documentation

d.	 End-User Manual

2.	 Which program planning is carried out?

a. Committee		  b. Extension workers

c. Resource persons	 d. All of the above

3.	 Which is true sequence of ?

a. Monitoring-follow up-evaluation

b. Monitoring-evaluation-follow up

c. Evaluation-monitoring-follow up

d. All of the above

4.	 Which of the following is also known as opinion leaders?

a. Laggards		  b. Early adopters

c. Early majority		  d. Innovators

5.	 Which is the first stage in adoption process?

a. Interest		  b. Awareness

c. Evaluation		  d. Trail

6.	 Which of the following communication aids is regarded as audio-visual 
aid (s)?

a. TV	 b. Slide	 c. Telephone	 d. Motion picture
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7.	 Which following category does not adopt or hardly adopts an innovation?

a. Laggards		  b. Early adopters

c. Early majority		  d. Late majority

8.	 According to philosophy of Agri. Extension, there should be use for 
.............. approach.

a. Autocratic		  b. Centralized

c. Democratic		  d. None of above

9.	 What does impact evaluation assess?

a. Outputs		  b. Effects

c. Budget		  d. Staff

10.	 What is the primary goal of an evaluation plan?

a. To collect data		 b. To assess impact

c. To set benchmarks	 d. To monitor progress

11.	 What type of evaluation focuses on assessing a project’s ongoing processes 
and activities?

a. Impact evaluation	 b. Summative evaluation

c. Process evaluation	 d. Formative evaluation

12.	 Which tools are useful for a situational analysis prior to planning a project/
program?

a. Stakeholder analysis

b. SWOT (strengths, weaknesses, opportunities and threats) analysis. 

c. Problem tree analysis

d. All of the above

Write short answer to the following questions. 
1.	 Define program planning.
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2.	 Define monitoring, evaluation and follow up.

3.	 Write down the steps of program planning.

4.	 What are the five criteria in monitoring and evaluation?

5.	 How do you ensure the quality of field activities?

Write long answer to the following questions.
1.	 Write down the importance of program planning in detail.

2.	 Describe the objectives of monitoring and evaluation of a program.

3.	 How do you measure monitoring and evaluation?

4.	 What are the stages of program evaluation? Write in details.

5.	 Why is evaluation of program planning important?
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4.1	 Concepts, Meaning and Purpose of Social Mobilization  
Meaning of social mobilization is to mobilize people, like in a campaign, to 
achieve certain religions political or economic objectives. In term of community 
development,social mobilization is an economic process. It is a holistic program 
of mobilizing local people to utilize their potentialities to reduce poverty and 
improve their lives.

The strategy and working modality of social mobilization component is based 
0n three principles.

1.	 Organization development

2.	 Capital formation

3.	 Skill enhancement 

4.1.1	Decentralization and Local Governance for Development, Definition, 
Strategy and Current Status of Decentralization in Nepal  

Decentralization involves a central government transferring to local entities 
(SASTHA) some of its political authority, resources and administrative 
responsibilities. It is the transfer of political financial and administrative power 
and authority of decision making from the center to local entities. In recent year 
wide varieties of countries, left or right, authoritarian or democratic, pursue the 
decentralization concept for local governance. The result of decentralization of 
authority is the empowerment of local governance. it is widely believed that 
decentralization increase popular participation in decision making because 
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it brings the government closer to local problems. Making it more accessible 
and more knowledge about local condition and so more responsive to people 
demands. 

4.1.2	Strategic Objectives and Impressive Achievements of Decentralization 

1.	 Faster responses to local needs.

2.	 More accountability, transparency and less corruption.

3.	 Improved delivery of basic services like education and health as well as 
agriculture and livestock educing employee absenteeism(state of absent)

4.	 Better information flow to bureaucrats on disaster, disease outbreaks, floods, 
draughts etc and allowances to central authority for fast remedial actions.

5.	 More sustainable project because of local design, execution (to kill as 
punishment for capital crimes) and monitoring.

6.	 Strong means for resolving conflict through local efforts.

4.1.3 Social Mobilization, Scope and Roles of LA’s, NGOs and CBOs on 
Social Mobilization  

Social mobilization program for poverty alleviation is inclusively a participatory 
approach based on button- up planning process. But it does not minimize the role 
of supporting agencies, the program, needs a full cooperation in infrastructure 
developments, human resource developments and financial support from 
government line agencies(Las), NGOs and various community based 
organization(CBOs), operative in program area, the role of external agencies 
is not simply to set up micro credit activities and undertake rural infrastructure 
projects, but even more importantly to assist in the development of local 
organizations, which will manage and decide the nature of these activities, and  
to enhance local skill  formation for this purpose.

The management structure of social mobilization program is itself composed 
of village organization and external agencies, the program is implemented 
for national planning commission by SAPAP (South Asia poverty alleviation 
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program) under UNDP (Nepal). At district level, there is a District Coordination 
Committee (DCC) consisting of DDC and district level line agencies chaired 
by DDC chairperson. Similarly, at the local level, there is a VCC in each VDC 
chaired but VDC chairperson and participated by local level line agencies. The 
program is implemented in the field under the cooperation of these committee, 
Village Organizations (VOs), and the national plan the coordinator from SAPAP 
(Nepal). NGOs and other donor agencies coordinate their program with social 
mobilization program in infrastructure development, skill enhancement and 
financial support. Social mobilization programs build linkages with various 
development agencies and mobilize resources to undertake different social and 
economic activities. The program facilities and coordinates their efforts as and 
when required.

4.1.4	Concept and Importance of Development  

Sustainable Development  

For any technical structure and environment resource, there are some utilization 
rates that cannot be sustained none of these are constant and stable over time. It 
is not easy to define sustainability. “Progress that meets the needs of the present 
without compromising the ability of future generations to meet their own needs.”

Recent definition has focused more explicitly on three pillars of sustainability-

1.	 Economical

2.	 Environmental 

3.	 Social

 Any development can be sustainable if it has balance development in economic, 
environment and social aspects of community. Developments of only two of 
time pillars without the third can never be sustainable.

The concept of sustainable developments we defined above is global perspectives. 
But the meaning of sustainable developments in underdevelopment countries 
like Nepal is litter different our development is not until responsible for global 
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sustainability, like the ozone depletion and greenhouse effect of development. We 
are only centered to reduce poverty and improve rural life through development 
programs,  

Sociology is the study of human society, learning social structures, interactions, 
and patterns. It helps us understand social phenomena and how individuals and 
groups shape the world around them.

Rural sociology is the study of life in rural environment. It examines the social, 
economic, and cultural aspects of life in rural areas, including agricultural 
practices, community development, and social change.

4.1.5	 Importance of Rural Sociology for Development Process

Rural sociology plays a crucial role in development by providing insights into 
the needs, challenges, and opportunities of rural communities. 

1. 	 The study of rural sociology helps to make a correct diagnosis or 
identify the problems of rural society and find out the solutions of these 
problems. 

2. 	 The solutions are extended by extension workers to the rural people 
who need the technology for solving their problems. 

3. 	 Rural sociologists assess the effectiveness of development programs 
and make adjustments for making long term success. 

4. 	 It helps in sustainable development process of a country. 

4.2	 Social Mobilization in Nepal
Social mobilization in Nepal refers to the process of empowering and engaging 
communities to take ownership of their development. It involves mobilizing 
people, resources, and institutions to work together towards common goals.

4.2.1	History of Social Mobilization in Nepal

1.	 Period Before 1955: It was based only on spiritual motivation. It 
was founded on social participation. The purpose was to develop 
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and improve the community infrastructures. It was not enough but 
sustainable.

2.	  Period Between 1955 to 1974: The social mobilization was state 
driven: state, elective representatives and the people. Eg; compulsory 
saving schemes in late 50s, cooperative movement of 60s, etc. 

3.	 Period Between 1975 to 1993: Small farmer’s development program 
(SFDP) initiated in 1975 which recognized poor farmers. Women 
development program initiated in 1982, Grameen bank approach in 
1991, Hundreds of NGOs and dozens of INGOs established. 

4.	 Post 1993 era: The major areas focused are linkage of social 
mobilization with decentralization, national effort to reach poorest of 
the poor, nation recognition to social mobilization approach as a tool 
for poverty reduction. 

4.3	 Objectives of Social Mobilization in Extension
1.	 Religious: to establish a new religion or spread information about a 

particular religion.

2.	 Political: to establish a specific political ideology or to spread 
information regarding it. 

3.	 Economic/Social: to support efforts for poverty alleviation.

4.	 Cultural: to bring changes in food habits, clothing, social norms, etc. 

5.	 National: to wage a war, to fight for independence, to initiate an 
immunization program, etc. 

4.4	 Concept and Importance of Development
Development is the gradual and sequential phases of any positive change.  

Community development is a process whereby the efforts of government are 
united with people to improve the social, cultural and economic conditions in 
communities.
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Sustainable development is a mode of human development that meets current 
demands without compromising the needs of future generations

Source: https://education.nationalgeographic.org/resource/sustainable-
development-goals/

4.4.1	 Importance of Sustainable Development

1.	 To reduce excess population growth.

2.	 To remove poverty and provide required human development.

3.	 To provide ecological sound farming system.

4.	 To control the use of hazardous chemical, waste product etc. and 
provide safe, clean and green environment.

5.	 To reach 17 sustainable development goals (SDGs).  
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4.4.2	Rural and Urban Development

Basis for 
Comparison

Rural Development Urban development

Life Simple and Relaxed Fast and complicated
Environment Direct contact with 

nature
Greater isolation from 
nature

Greater associated 
with

Agriculture and 
Livestock

Trade, Commerce or 
provision of services. 

Figure: Source: https://keydifferences.com/difference-between-urban-and-rural.
html

4.4.3	Problems of Rural Development in Nepal

Rural development programs in Nepal face numerous challenges, which affect 
economic growth and social progress. 

1.	 Inadequate communication channels especially mass media in rural areas. 

2.	 Limitation of funds and staffs for training the farmers. 

3.	 Requirement of skilled workers that is very expensive. 

4.	 Communities and individuals differ in needs as their circumstance 
changes.
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5.	 Small land holding.

6.	 Cast driven social structure.

7.	 High unemployment.

8.	 The objectives of organization are not clearly framed. 

9.	 Unable to take risk for development.  

4.4.4 Rural and Community Development  

The term development means growth or maturation. It implies gradual and 
sequential phases of change. Rural community development is bringing forth 
the potential abilities and quantities of group of people who live together in a 
common territory and who have an interdependent relationship with each other. 
It is a continuous process of social action by the people of a community.

Rural development program more sustainable if we adopt these simple remedies-

1.	 Need based development programs realized by the community.

2.	 Community participation in each step of program planning and execution 
process.

3.	 Training of adequate local technician required to execute the program at 
present and maintenances it in the future.

4.	 Development of management capacity of village organization and local 
leadership.

5.	 Transparency of program income, cost, and benefit.

6.	 Equal and equitable access of men, women and youth in development 
outcome.

7.	 Complete decentralization of authority to local level in decision-making.

8.	 Continuous, impartial and valuable benefits to community members.

9.	 Sustainability of sectional services delivery and localization of the process.

10.	 Adequate fund for individual and community development program.
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4.5	 Effective community/rural Development Program and Its Role 
in Poverty Alleviation 

Major Problems and Issues of Rural/Community Development in Nepal  

These are many challenges and barrier of rural developments in Nepal. Some 
Nepal rural farmers perform multipurpose activities. They are engaged in 
diversified farming in a small land mixed with horticulture and animal husbandry. 
They work themselves as agronomist, horticulturist, soil scientist, labour and  
household manager all the time, therefore they have a complex life. The natural 
calamities like floods, draughts, attracts of pests and diseases like locust (like 
grasshopper) invasion and fluctuation of their product price make their occupation 
still at a risk. The rural farmers had been given very little attention and help from 
the state and therefore, they hesitate to be involved in developmental programs. 
Resting on these assumptions, we may conclude following programs and issues 
of rural community developments in Nepal.

1.	 Education

2.	 Poor infrastructures

3.	 Limitation of capital fund

4.	 Quality and quantities of developments workers

5.	 Tradition

6.	 Gender imbalance

7.	 Local leadership

4.5.1 Problems of Community Development in Nepal

Community development programs in Nepal face challenges which affect 
community well-being and sustainable development. They are: 

1.	 The community doesn’t get involved in decision making process for 
project initiation and implementation. 

2.	 Many community development programs are without adequate planning. 
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They lack proper cost estimate and structural design. 

3.	 The income level in many communities is very low. 

4.	 Sometimes, leadership crisis exists in communities.

5.	 The lack of expertise in maintenance service makes community program 
diminished in value and dead.
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Exercise

Choose the correct answer from the given alternatives.
1.	 Sociology is the study of.............

a. Society		  b. Human behavior

c. Relationship		  d. All of above

2.	 Rural sociology includes...............

a. Village life 		  b. Rural problems

c. Rural relationship	 d. All 

3.	 Which of the following best definition sociology?

a. The study of individual behavior

b. The study of human society, its structures, and functions

c. The study of economic systems

d. The study of biological evolution

4.	 Who is considered the "Father of Sociology"?

a. Karl Marx		  b. Emile Durkheim

c. Max Weber		  d. Auguste Comte

5.	 What is the primary goal of social mobilization?

a. To create conflict in communities

b. To bring people together for collective action and social change

c. To establish individual wealth

d. To develop advanced technology

6.	 Community development means development in................

a. Food 		  b. Health

c. Education		  d. All of above
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7.	 What is the  responsibility of a group leader?

a. To monitor group	 b. To encourage members

c. To introduce new idea	 d. All of above

8.	 Community- based farmers group are concerned with..............

a. Inputs 		  b. Outputs/products

c. Both		  d. None of them

9.	 The main goal of meeting is..........

a. Problem solving	 b. Decision making

c. Chatting		  d. Both (a) and (b)

10.	 Social mobilization is most commonly used in.....

a. Promoting community welfare and sustainable development

b. Individual wealth-building initiatives

c. Large-scale industrial development

d. Entertainment events

11.	 Which principle is fundamental to community development?

a. Top-down decision-making

b. Community empowerment and participation

c. Dependence on external agencies

d. Exclusive focus on urban areas

12. 	 Which approach is most effective in ensuring the success of community 
development projects?

a. Rigid adherence to pre-designed plans

b. Flexibility and adaptation based on community input

c. Exclusive reliance on government agencies

d. Avoidance of local leadership
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13. 	 Sustainable development includes harmony  in the use and change of...

a. Resources 		  b. Technology

c. Environment		  d. All of above

Write short answer to the following questions. 
1.	 Explain the concept of sociology and rural sociology.

2.	 What are the importance of sociology for society development.

3.	 Explain the scope and importance of sociology in understanding human 
society.

4.	 What are the steps of social mobilization?

5.	 What are the steps of social mobilization?

6.	 How does social mobilization play a big role in community development?

Write long answer to the following questions.
1.	 What are the problems of rural and community development programs in 

Nepal? What could be the probable solutions for them? 

2.	 Define sustainable development. Explain the Sustainable development 
goals (SDGs)?

3.	 Describe the challenges and opportunities in implementing community 
development projects.

4.	 Propose strategies to improve community participation in development 
projects using sociological principles.

5.	 When did social mobilization start in Nepal? Write down the objectives of 
social mobilization in Extension.

6.	 Explain the scope and importance of sociology in understanding human 
society.



61Animal Science (Grade 9)

5.1	 Group
A group is a collection of individuals with shared goals, interests, or identities 
who interact with each other. Groups play a vital role in society and in various 
aspects of life, including work, education, and personal development. 

Characteristics of a Group

i.	 Two or more persons

ii.	 Formal social structure

iii.	Common fate 

iv.	 Common goals

v.	 Face-to-face interaction

vi.	 Interdependence

vii.	Recognition by others 

5.1.1	Concept, Principle and Types of Group

Principle of Group

i.	 Principle of Human Needs: Social groups are formed to work together 
to fulfill the basic human needs. The members should feel this as 
primary responsibility.

ii.	 Principle of cultural setting: Social groups are formed easily when the 
group members have same cultural setting. 

iii.	Principle of planned group formation: Groups can be formed easily if 
there is a proper planning of achieving a common goal.

iv.	 Principle of specific objectives: Most of the groups are formed to 

Unit 
5

Group Formation and 
Dynamics
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achieve specific objectives. 

v.	 Principle of purposeful worker-group relationship: Some groups are 
formed on the guidance of workers who have purpose of something to 
deliver to the group. 

vi.	 Principle of guided group interaction: Group interaction should be 
guided by workers on specific topics to get appropriate solutions. 

vii.	Principle of flexible functional organization: Group should be flexible 
and should be encouraged by the members.

Types of Groups

 According to Degree of Organization

i. 	 Formal:  Organized and 
structured with defined roles 
and procedures. Eg; college, 
government, department, 
army. 

ii.	 Informal: Spontaneous and 
flexible with fewer rules 
and roles. Eg: Gossip group, 
family group

       

According to Nature of Interaction

i.	 Primary:  Close, intimate interactions with strong personal bonds. Eg: 
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Family group, friendship 
group.

ii.	 Secondary: More 
formal and task-oriented 
interactions with less 
personal connection. Eg: 
government departments, 
industrial organizations. 

According to Nature of Membership

1 . 	 Voluntary: Individuals choose to join. Eg: gossip group, friendship group, 
library, youth organization.  

2. 	 Involuntary: Individuals are assigned or required to join. Eg: caste group, 
national group, religion group, sex group, age group. 

According to the Size of Group

1. 	 Small groups:  Members are less.  Feeling of cooperation and sympathy 
can be achieved individually. Example: Family, sport club.

2. 	 Big groups: Members are large. Example: University, army.  

Stages of Group Development: Forming, Storming, Norming, and 
Performing

American organizational psychologist Bruce Tuckman proposed a four-
stage map of group evolution, also known as the  forming-storming-norming-
performing model. Later he enhanced the model by adding the fifth and final 
stage, the adjourning phase.

1.	 Forming : In this stage, the members either known or strangers come 
together for the first time with a degree of guardedness and formality to 
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accomplish goals through discussions and meetings.

2.	 Storming: Once group members feel sufficiently safe and included, they 
tend to enter the storming phase. Participants focus less on keeping their 
guard up as they shed social facades, becoming more authentic and more 
argumentative. During this chaotic stage, reemergence of creative energy 
takes place but it takes skill to move the group from storming to norming. 
In many cases, the group gets stuck in the storming phase.

3.	 Norming: Group members are much more committed to each other and 
the group’s goal. The members feel energized, cooperative and cohesive. 
The group tends to make big decisions, while subgroups or individuals 
handle the smaller decisions. the group is more open and respectful toward 
each other.

4.	 Performing: At the performing stage, participants are not only getting the 
work done, but they also pay greater attention to how they are doing it. By 
now, the group been matured, becoming more competent, autonomous, 
and insightful. Group leaders can finally move into coaching roles and 
help members grow in skill and leadership.

5.	 Adjourning: The groups get adjourned (end) once the goal of the group is 
fulfilled. 

5.1.2	Procedure of Group Formation and its Role in Extension

Procedures of Group Formation

Group formation is formed as per the need and requirement of people.

i.	 Identify the organization involved in particular area in a particular 
work.

ii.	 Find out different organizations and programs working there since 
past.

iii.	Meet with local leaders and discuss on group formation. 

iv.	 Communicate with people by making pamphlet, leaflet, newspaper, 
radio, etc.
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v.	 Interested farmers are collected and discussed on group topic.

vi.	 Group is formed based on age, sex, interest, educational level, and 
economic status. 

vii.	Motivate each group to give a group name. 

viii. Election of the working members.

ix.	 Motivate each group to prepare rules and regulations for smooth 
running of groups.     

Role of Group in Extension

I.	 Security: People can feel secure and stronger in a group.

II.	 Status: Group provides recognition and status to its members.

III.	Self-Esteem: Groups can provide people with feelings of self-esteem.

IV.	Goal Achievement: More than one person can complete a task through 
combined talent, knowledge and skills.

V.	 Good communication between members and the society. 

VI.	Better utilization of available resources.  

5.1.3	Dynamics of Group Leader in Group Management

1.	 To  monitor group progress and achievement of objectives.

2.	 To ensure that the groups’ constitution is obeyed.

3.	 To encourage participation by all members in discussion, decision 
making and work.

4.	 To introduce new ideas into the group, and encourage members to do 
the same.

5.	 To report about the work of individual members and the group as a 
whole.

6.	 To represent the group on special occasion.

5.1.4	Group Meeting for Problem Solving and Decision Making

Group meetings are essential for problem-solving and decision-making, as they 
bring together different perspectives and expertise.
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Group Meeting for Problem Solving

i.	 Define the problem

ii.	 Analyze the problem

iii.	Generate possible solutions

iv.	 Evaluate the solutions

v.	 Implement the solution

Group Meeting for Decision Making

i.	 Decision by authority/ expert and no need to agree with members.

ii.	 Decision by minority (designated authority) and may or may not 
consider the other members’ views.

iii.	Decision by majority (one half plus one) by hands vote, a paper ballot, 
or electronic voting.

iv.	 Decision by consensus (all members) 

v.	 Decision by unanimity (all members) agree without conflict

Social Loafing 

Social loafing refers to the tendency of individuals to put in less effort when 
working in a group context. This phenomenon is also known as the Ringelmann 
effect. The social loafing tendency is less a matter of being lazy and more a 
matter of perceiving that one will receive neither one’s fair share of rewards if 
the group is successful nor blame if the group fails.

5.1.5	Types of Farmers' Groups and its Role in Agriculture Extension

A.	 Community and Resource Oriented Farmer Group: This is village 
level cooperatives dealing with inputs needed by the members, the 
resource owners, to enhance the productivity of their business. 

B.	 Commodity and Market Oriented Farmer Group: This group 
specializes in a single commodity and go for value added products 
which have expanded markets.  
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Role of Farmers’ Group in Agricultural Extension

i.	 It can increase agricultural productivity and farmers’ income through 
increasing the technical knowledge and farming practices by farmers.

ii.	 It enables the extension agent to have face to face contact with a number 
of people at a time.

iii.	People can be motivated to accept change due to group influence.

iv.	 Less expensive than other method.

v.	 In groups, people can be enhanced and members of groups can be 
involved for depth discussion. 

5.1.6	Group as a Conflict Management

Conflict is a disagreement between people with opposing needs, ideas, beliefs, 
values, goals, interest or views.  Conflict management involves skills related to 
conflict resolution and self-awareness. Strategies for conflict management are:

i.	 Styles: Use of conflict handling behaviour styles (competition, 
collaboration, compromise or avoidance) as per situation.

ii.	 Improving Organizational Practices: After identifying reason of the 
conflict, suitable organizational practices (establishing goals, reducing 
vagueness, policy improvement, rules, altering communication) should 
be used.

iii.	Special Roles and Structure: A person with problem solving skills 
and respected by the conflicting parties can be appointed to defuse 
conflicts.

iv.	 Confrontation Techniques: It aims at finding a mutually acceptable 
solution through collaboration and compromise. It involves defining 
the problem, searching for alternatives and their evaluation, and 
deciding by consensus.
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Exercise

Choose the correct answer from the given alternatives.
1.	 What is the primary purpose of forming groups in extension programs?

a. To reduce individual workloads

b. To encourage collective learning and action

c. To compete against other communities

d. To reduce the role of extension workers

2.	 What is a key characteristic of a successful group in extension activities?

a. Lack of communication

b. Clear goals and objectives

c. Unequal participation

d. Individual decision-making

3. 	 How many  members should be in a group for optimal effectiveness?

a. More than 20		  b. 10 to 15

c. 5 to 7		  d. Less than 10

4.	 What is a common cause of conflict in group settings?

a. Clear communication	 b. Unequal workload distribution

c. Strong leadership	 d. Shared decision-making

5.	 Which of the following is NOT a key stage in group formation according 
to Tuckman’s model?

a. Forming		  b. Storming

c. Performing		  d. Restructuring

6.	 How can groups ensure equitable participation of all members?

a. By assigning tasks based on members’ preferences and capacities

b. By allowing only senior members to make decisions
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c. By following a rigid set of rules

d. By avoiding open discussions

6.	 Which of the following best describes the main focus of cumminity 
best farmers group?

a. Improving agricultural inputs 

b. Improving agricultural outputs/products

c. Improving Both inputs and outputs

d. Nither inputs nor outputs

7.	 What is the main goal of meeting ?

a. Problem solving 	 b. Decision making

c. Chatting 		  d. Both (a) and (b) 

8.	 Which type of decision-making technique is used when discussion becomes 
lengthy?

a. Minority rule		  b. Majority rule

c. Consensus rule		 d. Authority rule

9.	 Conflict management through structural changes is done by ……..

a. Members		  b. Manager

c. Executive committee	 d. All of above

10.	 Style of conflict managements is ……

a. Competition		  b. Collaboration

c. Compromise 		  d. All of above 

Write short answer to the following questions. 
1.	 Define group. Explain the process of group formation.

2.	 What role do group leaders play in ensuring the success of extension 
programs?
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3.	 What are the key stages of group development? 

4.	 What is conflict? Why does it occur?

5.	 What are the key stages of group development? 

6.	 Describe the dynamics of group leader in group management.

Write long answer to the following questions.
1.	 How does the composition of a group (e.g., diversity in skills, gender, age) 

impact its performance in extension projects?
2.	 How do group dynamics influence the success of extension programs in 

rural communities?
3.	 How is group essential in problem solving and decision making?
4.	 Describe the steps of problem solving in the meeting in details.
5.	 What is conflict? How does group help in conflict management? Explain 

with examples.
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6.1 	 Introduction to Cooperatives
Cooperative is a form of community organization where its entire members work 
together in order to fulfill their common needs. The members of cooperatives 
have a common goal in order to meet their economic, social and cultural needs 
under the control of joint approach by its own members so that their members 
are directly responsible for benefiting themselves and ultimately to the society 
in general. Robert Owen (1771–1858) is considered as father of the cooperative 
movement.

According to Sherlekar, "A co-operate is a form of organization, where persons, 
irrespective of caste and religion, voluntary associate together, as human beings, 
on the basis of equality for the promotion of their common economic interests"

According to Talmaki "A co-operative is an association of the weak who gather 
for a common economic need and try to lift themselves from a weakness into 
strength, through business organization."

6.1.1	 Importance or role of Cooperative

Cooperatives are organized by the group of people which are democratically 
controlled, managed and owned to serve the members and produce benefits 
for them. Cooperatives are being considered as the most reliable and effective 
organizations in creating and maximizing the wealth and contributing to poverty 
alleviation. The given points clarify its role and importance:

1 . 	 Cooperatives provide financial assistance to the farmers for buying 

Unit 
6

Introduction and Concept 
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improved seeds, chemical fertilizers and agricultural tools and equipment 
at a low-interest rate in order to increase agricultural output.

2. 	 They provide financial assistance to the people of rural areas for poultry 
farming, beekeeping, fisheries, horticulture, animal husbandry and 
promoting cottage and small scale industries.

3. 	 They provide the facilities of warehousing, transportation, processing, 
grading, packing, financing, and marketing the products of their members.

4. 	 They develop a feeling of mutual help, co-operation, democracy, unity, 
brotherhood and equality which ultimately brings peace and prosperity in 
the society.

5. 	 They protect their members from the exploitation of capitalist organization, 
money leaders and middle person which ultimately helps for the betterment 
of the living standards of people.

6.1.2 Seven Guiding Principles of Cooperative

S.N. Principles Values

1. Voluntary and open membership Openness
2. Democratic control by members Democracy, equality
3. Economic participation of members Justice
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4. Autonomy and independent Self-help, self-responsibility
5. Cooperation among cooperatives Honesty
6. Education, training and 

communication
Solidarity

7. Concern about community Social responsibility

1.	 Voluntary and Open Membership

Cooperatives are voluntary organizations, open to all people able to use its 
service and willing to accept the responsibilities of membership, without 
gender, social, racial, political or religious discrimination.

2. 	 Democratic Member Control

Cooperatives are democratic organizations controlled by their members 
who buy the goods or use the services of the cooperatives and actively 
participate in setting policies and making decisions.

3.	 Members' Economic Participation

Members contribute equally to, and democratically control, the capital of 
the cooperative. This benefits members in proportion to the business they 
conduct with the cooperative rather than on the capital invested.

4. 	 Autonomy and Independence

Cooperatives are autonomous, self-help organizations controlled by 
their members. If the cooperative enters into agreements with other 
organizations or raises capital from external sources, it is done so based on 
terms ensureing democratic control by the members and maintaining the 
cooperative's autonomy.

5. 	 Education, Training and Information

Cooperatives provide education and training for members, elected 
representatives, managers and employees so that they can contribute 
effectively to the development of their cooperative. Members also inform 
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the general public about the nature and benefits of cooperatives.

6.	 Cooperation among Cooperatives

Cooperatives serve their members most effectively and strengthen the 
cooperative movement by working together through local, national, 
regional and international structures.

7.	 Concern for Community

While focusing on member needs, cooperatives work for the sustainable 
development of communities through policies and programs accepted by 
the members.

6.1.3	Cooperative Movement in Nepal

The first Co-operative Act was enacted by the government in 1960 A.D., 
which was followed by the Agricultural Co-operative Act (Sajha Sahakari). 
In 1963, the capital of savings and credit cooperative societies was converted 
into a Cooperative Bank in 1963, and in 1968 it was also converted into the 
Agricultural Development Bank of Nepal (ADBN). After 5 years the ADBN 
returned management back to the government and in 1975 the Cooperative Act 
was amended again.

Beginning in the 1980s a new generation of community based savings and credit 
groups began to emerge in Nepal. The Cooperative Act was amended for the 
third time to give the Government more control. By this time the Savings and 
Credit movement had spread throughout the country and the need for an apex 
coordinating body was evident. In August 16, 1988, the Nepal Federation of 
Savings and Credit Cooperative Unions (NEFSCUN) was formed.

After people’s movement the new democratic government enacted the Co-
operative Act and the Co-operative Regulations in 1992 and 1993 which 
permitted the establishment of a three tiered co-operative system, and provides a 
legal base both for the establishment of co-operative societies/unions/federations 
and application of co-operative values, norms and principles into practice.
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Nepal Cooperative movement has seen a lot of socio-economic as well as 
political changes. In 2008, Nepal was declared as the Federal Democratic 
Republic of Nepal. In 2015, constitutional assembly successfully declared the 
new Constitution of Nepal which recognized the co-operative sector as one of 
the three pillars of the National Economy. In 2018 and 2019, new cooperative 
act and regulation were enacted. The new constitution has decentralized and 
delegated the authority to the local and provincial governments to promulgate 
the laws and acts that they need. Now provincial government and local level 
government bodies can promulgate and implement the cooperative law.

According to the Department of Cooperative, the major types of co-operative 
societies operating in Nepal are Saving and Credit, Multipurpose, Dairy, 
Agriculture, Fruits and Vegetables, Bee Keeping, Tea, Coffee, Consumers, 
Science and Technology, and Energy. It is believed that around 6 million people 
are the members of 34,512 cooperatives and more than 60,517 people are 
employed directly in Cooperative business.

6.2	 Impact of Local Cooperatives in Livestock Commodities
The cooperatives are meant for income, social and perception based poverty 
reduction groups. The cooperative had become an integral part of community to 
provide financial access to unbanked people. The commercial banks and other 
financial institutions had not been able to reach in rural area. The cooperatives 
in different form have reached in very rural areas and encouraging the people to 
save and entertain loan.

Few major impacts of local cooperatives in livestock commodities are: 

1. 	 The pricing system or price determination in the context of cooperatives, 
particularly in livestock commodities, typically involves a system where 
prices are set based on a variety of factors.

A cooperative is an enterprise owned by and operated for the benefit of 
its members and users. It plays a major role for price determination for 
livestock products like milk, meat, eggs etc. and also makes a bargaining 
capacity for the price with the traders in local levels.
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2. 	 As technical service provider : Local cooperatives also provide new 
technologies, equipments, machines, technicians etc to their members at 
local levels so that their members can get new ideas, technologies and 
technical services and can enhance their livestock production and can get 
optimum price.

3. 	 Saving and credit programme in cooperative : Cooperatives do 
savings of its members so that its members can get big amount of money 
to buy a new technology in their occupation. It also helps to provide the 
microfinance in the form of credit to its members which also help them 
to adopt a new occupation or technology. By the help of finance, local 
cooperatives are uplifting the economic condition of its members through 
enhancing the quality and quantity of livestock products.

4. 	 Women leadership and empowerment : Women are the major members 
of cooperatives who are involved in livestock farming and commodity 
development. By providing training and funds to its women members, 
cooperatives are helping to increase the quality and quantity of livestock 
commodities.

6. 	 Marketing support : Cooperatives are supporting their members in every 
steps of marketing of livestock commodities, from production point to 
the final consumers. They are helping in livestock insurance, collection, 
storage and transportation of livestock commodities. They are also helping 
and serving to consumers by providing a cheap and quality market of 
livestock commodities in local levels.
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Exercise

Choose the correct answer from the given alternatives.
1.	 Who is known as "Father of Cooperatives"?

a. Carolous Linnaeus	 b. Robert Owen 

c. Louis Pasteur		  d. Socrates 

2.	 Which is the major theory of cooperatives?

a. One for one, all for all	 b. One for all, all for one 

c. both of them		  d. none of them

3.	 Where did the Cooperative movement first start from? 

a. England		  b. France 

c. Spain		  d. Germany

4.	 Which of the following is a type of cooperative organization?
a. Private Corporation	 b. Consumer Cooperative

c. Government Agency	 d. Public University

5.	 Which is the first cooperative bank in Nepal ? 

a. National Co-operative Bank Limited 

b. Bank of Kathmandu 

c. Kumari Bank 

d. Laxmi Bank

Write short answer to the following questions. 
1.	 Define cooperatives. Explain the seven guiding principles of co-operatives.

2.	 Explain the organizational structure of any one cooperative of your society.

3.	 Analyze the challenges faced by cooperatives in Nepal and suggest possible 
solutions. 

4.	 Describe the steps involved in forming and registering a cooperative. 
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5.	 How are local commodities impacted by cooperatives? Explain in detail. 

Write long answer to the following questions.
1.	 Explain the initiation of cooperative movement in Nepal. 

2.	 What is your perspective on the current challenges and opportunities 
faced by cooperatives in Nepal? How do you assess the rising instances of 
corruption within cooperatives in Nepal?
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Computer Science
Abbreviations

•	 ALU – Arithmetic Logic Unit

•	 BIOS – Basic Input/Output System

•	 BR – Bar-Code Reader

•	 CD – Compact Disc

•	 CLI – Command Line Interface

•	 CPU – Central Processing Unit

•	 CU – Control Unit

•	 DMP – Dot Matrix Printer

•	 DPI – Dots Per Inch

•	 DT – Digitizing Tablet

•	 DVD – Digital Versatile Disc

•	 EEPROM – Electrically Erasable Programmable Read-Only Memory

•	 FAT – File Allocation Table

•	 FDD – Floppy Disk Drive

•	 GB – Gigabyte

•	 GPT – GUID Partition Table

•	 GPU – Graphics Processing Unit

•	 GUI – Graphical User Interface

•	 HDD – Hard Disk Drive

•	 Hz – Hertz (Refresh Rate)

•	 I/O – Input/Output

•	 I/P – Input

•	 IJ – Inkjet Printer

•	 JS – Joystick
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•	 KB – Keyboard

•	 L1/L2 Cache – Level 1 / Level 2 Cache

•	 LJ – LaserJet (Laser Printer)

•	 MB – Megabyte

•	 MB – Motherboard

•	 MBR – Master Boot Record

•	 MICR – Magnetic Ink Character Recognition

•	 MMC – MultiMedia Card

•	 MOU – Mouse

•	 NIC – Network Interface Card

•	 NTFS – New Technology File System

•	 O/P – Output

•	 OCR – Optical Character Recognition

•	 OS – Operating System

•	 PCL – Printer Command Language

•	 PROM – Programmable Read-Only Memory

•	 PSU – Power Supply Unit

•	 RAM – Random Access Memory

•	 ROM – Read-Only Memory

•	 SD – Secure Digital

•	 SSD – Solid State Drive

•	 SVGA – Super Video Graphics Array

•	 TB – Terabyte

•	 TB – Trackball

•	 USB – Universal Serial Bus

•	 VCD – Video Compact Disc

•	 VGA – Video Graphics Array

•	 XGA – Extended Graphics Array
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7.1	 The Concepts of Computers and its History
A computer is an electronic device that processes data and performs tasks 
based on instructions. It can solve problems, store information, and complete 
calculations much faster and more accurately than humans. Computers have 
evolved to become smaller, faster, and more powerful, making them essential in 
modern life.

Working on a Computer

The computer is an electronic device that converts raw data into information in 
various processes by using a program. Every computers can do the following:

a.	 Input: Enter data into the computer.

b.	 Process: Process according to the given program to produce information.

c.	 Output: Display meaningful information from the computer.

d.	 Storage: Store data and information for future use.

The following is a block diagram of the IPOS cycle of computer systems.

 Input (data) Process (CPU) Output (Information) 

Storage 

History of Computer 

The history of computers dates back to ancient times when people used tools like 
the abacus to perform basic calculations. In the 19th century, Charles Babbage 
designed the first mechanical computer, the Analytical Engine, though it was 

Unit 
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never built during his lifetime. In the mid-20th century, computers evolved rapidly, 
starting with massive machines like ENIAC, which used vacuum tubes. The 
invention of transistors in the 1950s made computers smaller and faster. Later, 
integrated circuits and microprocessors revolutionized computing, leading to the 
personal computers of the 1980s and today’s powerful, compact devices like 
laptops and smartphones. Over time, computers have transformed from simple 
calculators to essential communication, work, and entertainment tools. A short 
description of the development process of the computer is described below:

a.	 Mechanical Devices

The history of computers began with mechanical devices that aimed to simplify 
calculations and automate tasks. Early tools like the abacus (2400 BCE) were 
used for basic arithmetic, while the 17th-century Pascaline and Stepped Reckoner 
introduced mechanical computation for addition, subtraction, and more complex 
operations. In the nineteenth century, Charles Babbage created the Difference 
Engine and the Analytical Engine, which introduced concepts such as memory 
and conditional logic, providing the framework for contemporary computing. 
The Jacquard Loom demonstrated programmability through punch cards and 
Herman Hollerith's tabulating machine automated data processing for the 
U.S. Census. These innovations bridged the gap between manual calculation 
and electronic computing, shaping the evolution of technology.

b.	 Electromechanical Computer (Devices)

The history of electromechanical computers marks a pivotal transition between 
mechanical and electronic computing. These devices used electrical components 
like relays and switches alongside mechanical parts to perform calculations 
and process data. The Zuse Z3 (1941), developed by Konrad Zuse, was the 
first programmable electromechanical computer, capable of solving complex 
equations. Another notable machine, the Harvard Mark I (1944), built by 
IBM, utilized punch cards and relays to automate calculations for military and 
scientific applications. Electromechanical computers were faster and more 
reliable than purely mechanical devices, and their programmability set the stage 
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for fully electronic computers.

c.	 Electronic Computers (Devices)

The history of electronic computers began in the 1940s, marking a significant 
leap in speed, efficiency, and reliability over mechanical and electromechanical 
devices. These computers used vacuum tubes for electronic switching, enabling 
faster processing. The ENIAC (1945) was the first general-purpose electronic 
computer, capable of performing thousands of calculations per second, though 
it was massive and power-hungry. The arrival of transistors in the 1950s 
supplanted vacuum tubes, resulting in smaller, quicker, and more dependable 
second-generation computers. By the 1970s, the introduction of microprocessors 
had transformed computing, allowing for the creation of personal computers and 
ushering in the contemporary age of electronic devices.
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History of Computers in Nepal

Computers do not have very long history in Nepal. Nepal hired many sorts 
of calculators and computers to conduct census calculations.  In the 2028 BS 
census, an IBM 1401 second-generation mainframe computer was used. In 
2031 BS, a facility for Electronic Data Processing, later renamed the National 
Computer Facility (NCC), was constructed for national data processing 
and computer education. In 2038, the census was conducted using a second-
generation mainframe computer, the BS ICL 2950/10. Nowadays, almost every 
institution, business organization, communication center, ticket counter, and so 
on uses computers.

After 2039 B.S., private enterprises and individuals in Nepal imported 
microcomputers such as Vector, IBM, and Apple now, Nepal has thousands 
of computer training colleges, as well as computer sales and repair facilities. 
Different universities are establishing IT colleges in Nepal. CDC has added 
computer subjects to school curricula. The High-Level Commission for 
Information Technology (HLCIT) is a body established under the chairmanship 
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of Nepal's Rt. Hon. Prime Minister to provide critical strategic direction and 
assist in the formulation of appropriate policy responses for the development of 
the ICT sector. The IT policy is also created in 2057 B.S.

IBM 1401 Computer

7.2	 The Characteristics of the Computer System
There are many electronic devices, but those devices do not have all the 
characteristics that a computer possesses. The following are the characteristics 
of a computer:

a)	 Speed 

Computers can process and perform millions, or even billions, of calculations 
in just a second, which is much faster than any human can achieve. This speed 
allows them to handle complex tasks like running programs, analyzing large 
amounts of data, and performing multiple tasks at the same time without delays. 
The speed of a computer depends on factors like its processor, memory, and the 
technology used, making them essential for tasks that require quick and accurate 
results. The table below shows the speed of the computer in different units of 
time.
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 Unit of Time Part of Second Power of 10

Millisecond (MS) 1/1000 10-3 One Thousandth
Microsecond (µs) 1/1000000 10-6 One Millionth
Nanosecond (ns) 1/1000000000 10-9 One Billionth
Picosecond (ps) 1/1000000000000 10-12 One Trillionth
Femtosecond (fs) 1/1000000000000000 10-15 One Quadrillionth

b) 	 Accuracy

Another important characteristic of computers is their accuracy. Computers 
perform tasks and calculations exactly as they are programmed, without making 
mistakes, as long as the instructions and data provided are correct. Unlike 
humans, they don’t get tired or distracted, so they can work with consistent 
precision. This accuracy makes them reliable for activities like solving complex 
math problems, processing large datasets, or running critical systems like those 
in healthcare or banking. The incorrect output produced due to incorrect input 
is called Garbage in Garbage out (GIGO). An error due to the malfunctioning of 
hardware or programs is referred to as a bug.

c)	 Automatic

Computers are automatic, meaning they can perform tasks on their own once 
they are programmed and started. They don’t need constant human involvement 
to carry out instructions. For example, when you run a program, the computer 
automatically follows the steps in the program without needing help at each stage. 
This feature allows computers to handle repetitive or complex tasks efficiently, 
making them useful for things like controlling machines, running software, or 
automating processes in industries.

d)	 Storage

One of the important characteristics of computers is their ability to store large 
amounts of data. Computers can save information, such as documents, images, 
videos, and software, in their memory for future use. This storage can be temporary 
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(like RAM) or permanent (like hard drives, SSDs, or cloud storage). The stored 
data can be accessed quickly and accurately whenever needed. Computers also 
allow users to organize and retrieve data easily, making them essential for tasks 
like managing records, creating backups, and running applications that require 
large amounts of information.

e)	 Diligence

Computers are diligent, meaning they can work continuously without getting 
tired or losing efficiency. Unlike humans, they don’t need breaks, rest, or sleep, 
and they don’t make mistakes due to fatigue. This makes computers ideal for 
performing repetitive tasks, such as data entry, calculations, or running programs 
for long periods. They can maintain the same level of performance and accuracy 
no matter how long they work, which is why they are used in industries that 
require constant and reliable operations, like banking, manufacturing, and 
research.

f)	 Versatility

Computers are highly versatile, meaning they can perform many different 
tasks depending on the software or program being used. For example, they 
can help with writing documents, editing videos, designing graphics, browsing 
the Internet, or even controlling machines. This versatility comes from their 
ability to switch between tasks quickly and adapt to new instructions without 
needing physical changes. Whether it is for personal use, education, business, 
or scientific research, computers can handle a wide range of activities, making 
them incredibly useful in almost every field.

7.3	 The Capabilities and Limitations of Computers
There are some limitations of the computer systems depending on their ability, 
dependency, actions, and many more. The main limitations of the computer are 
as follows:

•	 Lack of Thinking Ability: Computers cannot think or make decisions 
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on their own; they only follow instructions given by humans.

•	 No Creativity: Computers cannot create new ideas, innovate, or think 
outside the box like humans can.

•	 Dependence on Human Input: They rely on accurate data and 
instructions from humans; incorrect input leads to errors.

•	 No Emotional Understanding: Computers cannot understand emotions, 
empathy, or human feelings.

•	 Limited by Programming: A computer can only perform tasks it has 
been programmed to do and cannot go beyond its code.

•	 Susceptible to Viruses and Malware: Computers can be infected by 
malicious software, which can cause them to malfunction.

•	 High Energy Consumption: Operating computers and related devices 
require electricity, which can be costly.

•	 Need for Maintenance: Computers require regular updates, repairs, and 
maintenance to function efficiently.

•	 Data Security Risks: Without proper security, computers are vulnerable 
to hacking, data breaches, and unauthorized access.

•	 No Adaptability to Changing Environments: Computers cannot adjust 
to new situations without reprogramming or external modifications.

7.4 	 The Types of Computers on the basis of Data: • Analog• Digital 
• Hybrid; on the basis of Size • Micro • Mini • Mainframe and • 
Super 

Different types of computers are used in different areas. Computers used at 
offices, homes, hospitals, and research centers may be different. They may differ 
in size, tasks, purpose, model, and brand. Computers can be classified based on 
size, data handling capability, purpose, model, and brand. 

On the Basis of Data Handling 

On the basis of data handling, computers are classified into three categories:
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a. Analog Computer

b. Digital Computer

c. Hybrid Computer

a.	 Analog Computer

Analog computers are special-purpose computers (i.e., dedicated to a single 
task) that can measure continuous physical values like length, temperature, 
pressure, speed, height, vibration, etc., and convert them to numeric values. All 
operations on the analog computer are performed in parallel. Speedometers and 
thermometers are examples of analog devices. The speedometer shows the speed 
of the vehicle while it is moving. Analog computers are used for scientific and 
engineering purposes. Industries like power plants, petroleum refineries, and 
chemical plants use these computers. A seismograph is an example of an analog 
computer that measures an earthquake. In the ICU (Intensive Care Unit) of a 
hospital, the heartbeat, blood pressure, pulse, etc. of patients are monitored by 
analog computers.

Analog Computer – Seismograph

b.	 Digital Computer

Digital computers are general-purpose computers that work on binary digits. 
They accept discrete data (discontinuous data) like letters, numbers, symbols, 
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and figures, and these data are represented in terMS of binary numbers. Digital 
computers can't measure temperature, pressure, voltage, etc. Digital computers 
accept data and instructions, process them, and give the information. Almost all 
the computers that we use in offices and homes are digital.

c.	 Hybrid Computer

A hybrid computer has the capabilities of both analog and digital computers. 
It is a special-purpose computer. It accepts a continuously varying input which 
is then converted into discrete data for digital processing. They are used in 
airplanes, ships, factories, hospitals, and research centers. CT-Scan machines, 
ECG machines, and Ultrasound machines are the examples of hybrid computers 
used in the health sector. Pathfinder is the hybrid computer that was sent to Mars. 

On the Basis of Size

On the basis of size, computers are classified into four categories. They are:

a.	 Microcomputer

b.	 Minicomputer

c.	 Mainframe computer

d.	 Supercomputer
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a.	 Microcomputer 

A microcomputer is a single-user general-purpose computer that is smaller than 
a minicomputer. It consists of a microprocessor as the main component. It is also 
called a personal computer (PC). Microcomputers are commonly used in homes, 
schools, banks, offices, etc. Microcomputers are available in various sizes like 
desktops, laptops, and palmtops. A desktop computer is larger than a laptop and 
a palmtop and is required to be kept on the desk or table for use. Laptops and 
palmtops (or personal digital assistants, i.e., PDA) are small and compact. They 
are portable and can be taken from one place to another very easily. While using 
them, they can be kept on the lap and the palm. A laptop computer can be kept 
on a lap for working. A laptop computer is also called a notebook computer. A 
palmtop can be kept on the palm while using. These portable computers have 
a backup power supply facility, so they can be used in places where there is no 
electricity. Dell, Apple, IBM, Sony, Toshiba, and Acer are some of the leading 
manufacturers of laptop computers.

b.	 Minicomputer

A minicomputer is larger 
than a microcomputer. It is 
smaller than a mainframe and a 
supercomputer. A minicomputer 
is a mid-range server computer 
that consists of two or more 
processors. A minicomputer 
has more storage capacity and 
higher processing speed than a 
microcomputer. A minicomputer 
is a multi-user computer that 
provides facilities to operate 100 people simultaneously via terminals (A terminal 
is a device through a keyboard, mouse, monitor, and other devices are connected 
to a computer). Nowadays, minicomputers are mostly used as servers in the 
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computer network. They are used for data processing, desktop publishing, etc. 

c.	 Mainframe Computer

A mainframe computer is a multi-user computer having faster processing 
speed and more storage capacity than a minicomputer. They are larger than 
minicomputers. They can support thousands of users through the terminals. 
Big organizations use mainframe computers for bulk data processing, financial 
transaction processing, etc. They are also used as central host computers in 
distributed data processing systems. IBM zSeries, FUJITSU Server GS21, Cray 
XE6, Tianhe-1A, etc. are the examples of mainframe computers.

Mainframe - IBM Z16

d.	 Supercomputer

Supercomputers are extremely powerful computers that can perform a huge 
number of calculations very quickly. They are designed to solve complex 
problems that require enormous amounts of processing power, such as predicting 
weather patterns, designing new drugs, or simulating nuclear reactions. Unlike 
regular computers, supercomputers have many processors working together 
at the same time, making them much faster and more capable. They are used 
by scientists, researchers, and governments for tasks that demand high-speed 
computing, like space exploration or climate modeling. Supercomputers are 
very expensive and need special cooling systems because they generate a lot 
of heat. The world's most powerful supercomputer is El Capitan, developed by 
Hewlett Packard Enterprise (HPE) for the U.S. Department of Energy's Lawrence 
Livermore National Laboratory. In our country, Nepal, computer engineer, Muni 
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Bahadur Sakya constructed a supercomputer in 2063 B.S. by joining sixteen 
microcomputers.

Supercomputer

7.5	 The Generations of computers and their features: • First • Second 
• Third • Fourth and • Fifth generation

The generations of computers refer to the major advancements in technology 
that have shaped the development of computers over time. The first generation 
(1940s-1950s) used large vacuum tubes and was very slow. The second 
generation (1950s-1960s) replaced vacuum tubes with transistors, making 
computers smaller, faster, and more reliable. The third generation (1960s-1970s) 
introduced integrated circuits, allowing computers to become even more compact 
and efficient. The fourth generation (1970s-present) saw the development of 
microprocessors, which made personal computers possible. The fifth generation 
(ongoing) is focused on artificial intelligence and advanced computing 
technologies like quantum computing, aiming to make computers even more 
powerful and intelligent. Following are the main five generations of computers.

Generation Time Main Component

First Generation 1945 to 1955 Vacuum tube
Second Generation 1956 to 1964 Transistors
Third Generation 1965 to 1971 Integrated Circuits
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Fourth Generation 1972 to 1980 Micro Processor
Fifth Generation 1981 to present Bio Chip

First Generation (1945 to 1955)

•	 The computers utilized vacuum tubes for circuitry and magnetic drums 
for memory.

•	 They were massive, expensive, and unreliable, generating significant 
heat.

•	 ENIAC (1945), the first general-purpose computer, could perform 
thousands of calculations per second.

•	 Programming was done using machine language.

Second Generation (1956 to 1964)

•	 Transistors replaced vacuum tubes, making computers smaller, faster, 
and more reliable.

•	 COBOL and FORTRAN, the first high-level programming languages, 
were created.

•	 Computers like the IBM 1401 became popular in businesses for data 
processing.

Third Generation (1965 to 1971)

•	 The introduction of integrated circuits (ICs) revolutionized computer 
design by combining multiple transistors on a single chip.

•	 Computers became smaller, cheaper, and more efficient, leading to 
wider adoption in industries.

•	 Operating systems were introduced, allowing multiple programs to run 
simultaneously.

Fourth Generation (1972 to 1980)

•	 Microprocessors are a single chip that houses the whole CPU. 
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•	 Personal computers, such as the Apple II (1977) and IBM PC (1981), 
made computing more accessible to individuals. 

•	 The rise of software applications, Graphical User Interfaces (GUIs), 
and networking (e.g., the Internet) further expanded usage.

Fifth Generation (1981 and Beyond)

•	 Focused on artificial intelligence (AI), machine learning, and quantum 
computing.

•	 Modern computers are incredibly fast, compact, and energy-efficient, 
capable of processing complex tasks like natural language processing 
and big data analysis.

•	 Examples include AI-driven systems, advanced robotics, and cloud 
computing platforms.

7.6	 The Types of Personal Computer and their Characteristics. • 
Desktop • Laptop • Notebook • Palmtop

Microcomputers are the most commonly used at homes, schools, colleges, 
hospitals, banks, offices, etc. It is a small, less costly digital computer that consists 
of a microprocessor, storage unit, and input and output device. They are much 
smaller in size as compared to supercomputers and mainframes. Microcomputer 
includes desktop computers portable computers like laptops, and handheld 
computer like Personal Digital Assistants (PDA). The first microcomputer was 
IBM-PC designed by IBM (International Business Machine) company. Computers 
come in different sizes and types, depending on their purpose and usage. Below 
are the common types of personal computers and their characteristics:

a.	 Desktop Computer

•	 A desktop computer is a large, powerful computer that is placed on a 
desk or table.

•	 It consists of a separate monitor, keyboard, mouse, and a Central 
Processing Unit (CPU).
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•	 Desktops are not portable because they are designed to stay in one 
place.

•	 They are commonly used in offices, schools, and homes for tasks like 
gaming, work, and studying.

•	 Desktops are more powerful and have better cooling systems compared 
to smaller computers.

b.	 Laptop

•	 A laptop is a portable computer that is smaller and lighter than a 
desktop.

•	 It has a built-in screen, keyboard, touchpad (instead of a mouse), and 
battery for wireless use.

•	 Laptops can be carried easily and used anywhere, making them ideal 
for students and professionals.

•	 They are less powerful than desktops but still capable of performing 
most tasks like browsing, working, and watching videos.

•	 Laptops need to be charged regularly, as their battery life is limited.

c.	 Notebook

•	 A notebook is a smaller and lighter version of a laptop.

•	 It is designed for simple tasks like web browsing, writing documents, 
and watching videos.

•	 Notebooks usually have a long battery life and are easy to carry in a 
bag.

•	 They are less powerful than regular laptops and may not support heavy 
applications like gaming or video editing.

•	 Some notebooks are also called ultrabooks, which are thin, fast, and 
have high-quality screens.
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d.	 Palmtop (Handheld PC)

•	 A palmtop is a very small computer that can fit in the palm of your 
hand.

•	 It is also known as a handheld PC or PDA (Personal Digital Assistant).

•	 Palmtops were used in the past for simple tasks like taking notes, 
managing contacts, and setting reminders.

•	 Today, smartphones and tablets have mostly replaced palmtops because 
they can perform many more functions.

•	 Palmtops have small keyboards or touchscreens for input.
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Exercise

Choose the correct answer from the given alternatives.
1. 	 Which is not the characteristic of a computer?

a. Speed	 b. Accuracy	 c. Storage	 d. Intelligence 

2. 	 What is the incorrect result due to incorrect input?

a. GIGO	 b. FIFO	 c. LIFO	 d. GOGO

3.	 What is the size of 1 byte?

a. 8	 b. 4	 c. 2	 d. 1

4.	 Which of the following is related to the capability to perform tasks 
repeatedly?

a. Versatility	 b. Reliability	 c. Diligence	 d. Intelligence

5.	 Which computer is capable of processing analog and digital computer?

a. hybrid	 b. hyper	 c. analog	 d. digital

Write short answer to the following questions. 
1. 	 List the characteristics of a computer.

2. 	 Why is a computer called diligent machine?

3. 	 Why is a computer called versatile machine?

4. 	 Write the difference between desktop and laptop computers.

5. 	 Write the difference between analog and hybrid computers.

Write long answer to the following questions.
1. 	 Classify computers on the basis of their size and explain them in brief.

2.	 Classify the types of digital computers with short description.

3. 	 Classify the computers on the basis of data handling and explain them in 
brief.
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Project Work
1. 	 Draw “Types of computers on the basis of working principle” on chart 

paper and paste in your class room.
2. 	 Make presentation on the "Features of computer".
3. 	 Prepare a presentation about use and purpose of hybrid and supercomputer 

in different sector and demonstrate.
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8.1	 The Concept of Computer Organization 
Computer organization refers to the operational structure and implementation 
of a computer system's components and their interaction to carry out tasks 
efficiently. It focuses on a computer's hardware components and how they are 
integrated to accomplish computational tasks. It is a critical computer science 
and engineering component that bridges the gap between hardware and software.

8.2	 Familiarization with Hardware Parts of the Computer
A computer is a sophisticated machine designed to process data, execute tasks, 
and produce meaningful outputs. Its operation relies on the interplay of various 
basic components, each fulfilling a specific function in the overall computing 
process. These components include the input unit, Central Processing Unit 
(CPU), memory, output unit, and storage.

8.3	 The Basic Components of a Computer system – Input, Output, 
Processor, and Storage 

The main components of the computer system are defined below:

a.	 Data: Data is a main part of the computer system. It can process to get the 
desired output as information.

b.	 Software: A set of programs is called software which instructs hardware 
to perform a task. For example MS Windows, MS Word, MS Excel, etc.

c.	 User: The person who operates the computer system is called the user. 

d.	 Hardware: The physical parts of the computer that can be touched, seen, 
and felt are called computer hardware. For example: keyboard, mouse, 
printer, monitor, etc.

Unit 
8

General Concept  
of Computer
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The computer hardware is further divided into four units as

a.	 Input unit,

b.	 Process  unit,

c.	 Output unit and

d.	 Storage unit

a.	 Input Unit

This unit enters data into the computer. An input unit consists of input devices 
like a keyboard, mouse, microphone, joystick, etc. These devices are used to 
enter data and instructions or commands into the computer system. The input unit 
acts as a communication channel between the user and the computer. The input 
devices translate the information into a form understandable by the computer.

b.	 Processing Unit

A processing unit consists of processing devices like a CPU (Central Processing 
Unit). CPU is the main processing unit of a computer system. It is also known as 
the brain of the computer system. It receives data from the input unit, processes 
it as instructed by the user and produces information as output.

The speed of the CPU is measured in hertz. Hertz is also called CPU clock rate 
or CPU clock speed. Nowadays, CPU speed is measured in Gigahertz (GHz).

1 GHz	 = 1000 MHz (Mega Hertz).

	 = 1,000,000 KHz (Kilo Hertz).

	 = 1,000,000,000 Hz (Hertz).

So, one Giga Hertz is equal to one billion hertz. The CPU speed of 2.1 GHz is 
equal to 2.1 *1,000,000,000 Hertz.

The CPU consists of main three parts. They are:

i.	 CU (Control Unit),

ii.	 ALU (Arithmetic Logic Unit) and

iii.	MU (Memory Unit- Register Array)
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i.	 Control Unit

The control unit is a part of the CPU that controls and co-ordinates activities of 
other units of the computer system. It acts as the nervous system of the computer. 
It controls the execution of instructions given to the system. It co-ordinates the 
flow of data in or out of ALU, memory, and various input or output devices.

ii.	 Arithmetic Logic Unit

The arithmetic logic unit is a part of the CPU that can perform arithmetic operations 
like addition, subtraction, multiplication, and division. It also performs logical 
comparisons like equal to, greater than, less than, etc. to compare between two 
numbers.

iii.	 MU (Memory Unit- Register Array)

The memory unit is also a part of the CPU but not the part of the main memory 
that stores the currently executing task. It is located inside the microprocessor 
and has very limited storage. It is used to store very active data and instructions 
temporarily during processing.

c.	 Output Unit

An output unit consists of output devices like a monitor, printer, speaker, etc. 
These devices are used to display information after processing raw data from the 
processing unit.

d.	 Storage Unit

A storage unit consists of primary and secondary storage. The primary storage 
or main storage stores raw data and instruction. For example: RAM (Random 
Access Memory) and ROM (Read Only Memory). The functions of the storage 
unit are as follows:

•	 It stores intermediate results of processing.

•	 It stores all the data and the instructions required for processing.

•	 It stores the final results of processing before these results are released 
to an output device.
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The secondary storage stores processed or unprocessed data or information for 
future use. Hard disks, pen drives, CDs, DVDs, etc. are the examples of storage 
units.

8.4 	 The Memories and Storage Device. Primary and Secondary, 
Cache (L1, L2), Buffer, RAM, ROM, PROM, EPROM, EEPROM 
Storage fundamentals- Primary Vs Secondary data Various 
Storage Devices- Magnetic Tape, Magnetic Disks: Hard Disk 
and Floppy Disks (Winchester Disk), Optical Disks: CD, VCD, 
CD-R, CD-RW, DVD, DVD-RW, Blue Ray Disc. Others: Flash 
drives, SD/MMC Memory cards Physical structure of floppy & 
hard disk, drive naming conventions in PC. 

In a computer system, when you give it data and instructions to work with, it 
needs a place to keep them temporarily while it works on them. This temporary 
storage space is called primary memory and includes things like cache, RAM, 
and registers. Once the computer processes the raw data, it turns it into useful 
information. This useful information needs to be kept for later use, so we use 
storage devices like hard disks, solid-state discs, pen drives, etc., to store it. 
A storage device that stores data, instructions, etc., permanently is known as 
secondary memory. Primary memory is where data and information are stored 
temporarily, while secondary memory is where they are kept for a longer time. 

Memory is made up of many tiny cells, each capable of holding a bit of 
information. These cells are organized into groups called words, which have 
addresses assigned to them. When the computer needs to work with data or 
instructions, it uses these addresses to find them in memory. The speed at which 
the computer can find these addresses affects the cost of the memory i.e., if it is 
faster, it is usually more expensive. 

Memory is the storage location where we can store data and information, either 
temporarily or permanently. The units of measurement of memory in a computer 
are bits, KB, MB, GB, etc. The storage unit of data and information on a computer 
is as:
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Unit Measurement
0,1 Bits
4 bits 1 Nibble
8 bits 1 Byte

1024 Byte 1 KB
1024 KB 1 MB (Mega Byte)
1024 MB 1 GB (Giga Byte)
1024 GB 1 TB (Tera Byte)
1024 TB 1 PB (Peta Byte)

Necessity of Memory in Computer

A computer needs memory for holding data and instructions permanently 
or temporarily. Computer memory is the electronic holding place for the 
instructions and data. It is the place where information or instructions are stored 
for immediate use. Memory is one of the basic functions of a computer because, 
without it, a computer would not be able to function properly. Memory is also 
used by a computer's operating system, hardware, and software.

Type of Memory

Computer memory is used for storing various types of data and information. 
There are different types of memory for storing data and information. Some 
memory stores data temporarily and some stores permanently. Some memories 
communicate directly with the CPU whereas some communicate indirectly with 
a computer system. The overall classification of computers can be done in two 
types:

a.	 Primary Memory 

b.	 Secondary Memory

Primary/main Memory

Primary memory, also known as the main memory or internal memory of a 
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computer system, serves as the core storage component. It can be categorized 
as either temporary or permanent. Compared to secondary memory, primary 
memory has a relatively limited storage capacity. Its primary function is to 
temporarily store data and instructions during processing. Acting as the memory 
directly accessible by the CPU, primary memory facilitates the processor's 
interaction with running applications and services stored temporarily in 
specific memory locations. Upon booting up, primary memory loads all active 
applications, including the operating system, user interface, and background 
programs. Whenever a program or application initiates within the computer 
system, it is loaded into primary memory to interact with the operating system. 
Common types of primary memory include RAM, ROM, cache memory, and 
virtual memory.

Types of Primary/Main Memory 

The basic two types of primary memories are: RAM and ROM.

a.	 Random Access Memory (RAM)

Random Access Memory (RAM) is 
the volatile memory or short-term 
memory of a computer system. It 
executes both reading and writing 
operations. It can read and store data randomly from any physical location 
within it. RAM holds data and instructions during processing. Since it is volatile 
memory, data stored in RAM is erased when the power supply is turned off. 
Hence, to retain files permanently, they must be stored on secondary storage 
devices like a hard disk. RAM is classified as R/W (read-write) memory since it 
allows both reading and writing operations. Upon powering on the CPU, system 
files stored on the hard disk are loaded into primary memory RAM. There are 
two main types of RAM: Static Random Access Memory (SRAM) and Dynamic 
Random Access Memory (DRAM).

i.	 SRAM: Static Random Access Memory, retains data in a static state as long 

Random Access Memory
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as power is supplied to the memory. This semiconductor-based memory 
stores data and instructions without the need for periodic refreshment, 
unlike DRAM. While SRAM is more costly than DRAM, it offers faster 
performance. Typically employed as cache memory, SRAM consumes less 
power compared to DRAM.

ii.	 DRAM: Dynamic Random Access Memory, is constructed using capacitors. 
Data stored in this type of RAM is prone to loss within a few milliseconds, 
even when the computer is powered on, necessitating periodic circuit 
refreshment. DRAM's design involves capacitors, where charge leakage 
occurs. While DRAM is less expensive and slower compared to SRAM, it 
finds common usage in PCs due to these characteristics. 

Difference Between SRAM and DRAM

SRAM DRAM
It is made up of transistors. It is made up of capacitors.
It is more expensive. It is less expensive.
SRAM doesn’t need periodic 
refreshments.

DRAM needs periodic refreshments.

Charges don’t get leaked from 
SRAM.

Data charges get leaked from DRAM.

SRAM is less dense. DRAM is denser.
It is faster than DRAM. It is slower than SRAM.
Data is stored in the form of 
voltage.

Data is stored in the form of a charge.

b.	 Read-Only Memory (ROM)

ROM exclusively retains information that can solely be accessed for reading 
purposes. Altering data stored in ROM presents a challenge. Serving as the non-
volatile memory of a computer system, ROM ensures that data and instructions 
remain intact even when the power supply is disconnected. Unlike volatile 
memory types, ROM doesn't require a constant power supply to preserve stored 
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data. The instructions 
within ROM are embedded 
during manufacturing 
by the respective 
manufacturer. Given its 
read-only nature, users 
cannot modify the contents 
of ROM. This type of 
memory commonly stores 
BIOS (Basic Input Output 
System) information essential for booting up the computer. The programs housed 
in ROM are known as firmware. Variants of ROM include PROM, EPROM, and 
EEPROM.

i.	 PROM: PROM, or Programmable Read-Only Memory, refers to a type of 
ROM with a unique characteristic: it can be programmed just once but read 
multiple times thereafter. Once data and instructions are stored in PROM, 
they become permanent and cannot be erased. Similar to other ROM types, 
PROM maintains its contents even when the power is off. Unlike ROM, 
which comes with pre-installed contents during manufacturing, PROM is 
initially blank upon manufacture. To write data onto PROM, a specialized 
device called a PROM programmer or PROM burner is employed. Once 
programmed, PROM cannot be altered or erased, making it suitable for 
storing permanent data in digital electronic devices.

ii.	 EPROM: Erasable Programmable Read-Only Memory (EPROM) is a 
form of ROM that offers the capability of being reprogrammed multiple 
times. However, reprogramming EPROM requires specialized techniques 
involving UV (ultraviolet) light rays. The contents stored on EPROM 
can be erased and rewritten using these UV rays. It is important to note 
that frequent erasures of EPROM can lead to wear and tear, potentially 
affecting its lifespan.

Read Only Memory
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iii.	 EEPROM: Electrically Erasable Programmable Read-Only Memory 
(EEPROM) is a variation of EPROM that offers the capability to erase 
and write data electronically using electrical signals within a millisecond. 
Unlike traditional EPROM, EEPROM does not require special techniques 
or laboratory conditions to delete or write content onto it. This flexibility 
allows for the efficient modification of data without the need for external 
tools or UV light exposure. Whether it is a single byte of data or the entire 
content of the device, EEPROM provides the convenience of electrically 
erasable and writable memory.

Difference Between RAM and ROM
Random Access Memory Read Only Memory

a.	 It is the volatile memory of a computer 
system.

a.	 It is the non-volatile memory of 
a computer system.

b.	 Currently, data and instructions are 
stored in RAM.

b.	 BIOS data and instructions are 
stored in ROM.

c.	 The content of ROM gets erased 
when the power supply is turned off.

c.	 The content of ROM doesn’t get 
erased when the power supply is 
turned off.

d.	 Programs and files in RAM are loaded 
when the computer starts booting.

d.	 Programs in ROM are stored 
during the time of manufacturing.

e.	 RAM has a high storage capacity. e.	 ROM has less storage capacity.
f.	 RAM is expensive. f.	 ROM is less expensive.

Cache Memory

A computer stores currently opened programs, data, instructions, etc. into 
temporary memory, i.e., RAM. Some data and instructions are frequently needed 
by the CPU. RAM takes more time to provide these data and instructions to the 
CPU, which makes CPU execution slow. To speed up the CPU execution speed, 
cache memory is used. The cache memory holds the frequently needed data and 
instructions by the CPU.
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The high-speed memory between the RAM and the CPU is known as cache 
memory. The cache memory is used to store frequently accessed data and 
instructions during the time of processing by the CPU. It is the high-speed 
volatile memory available to the processor for fast processing. The storage size 
of cache memory is small. If the CPU requires any data, it first searches data in 
the cache memory, if it finds data, it takes and processes it. This process is called 
a cache hit. If data is not found in the cache memory; it is called cache miss. 
So, the CPU looks for data in RAM and loads it into the cache memory. The 
main importance of cache memory is to make CPU execution faster. There are 
different levels of cache memory. L1, L2, L3 (Level 1, Level 2, Level 3). The 
higher the number of levels, the faster the cache.

Buffer Memory

Buffer memory is the temporary storage area for data while transferring to 
another location. The buffer memory improves the overall performance of the 
system. The most common use of a buffer is to act as a holding area, enabling the 
CPU to manipulate data before transferring it to another location.

Secondary Memory 

Primary memory, though essential, is characterized by its high cost, limited 
capacity, and volatile nature. When it comes to store large volumes of data 
permanently at a more economical rate, secondary memory steps to fulfill this 
need. Secondary memory, whether internal or external to the computer, serves 
as the permanent storage medium. It is also referred to as auxiliary or backup 
memory within the computer system. Unlike primary memory, secondary 
memory is non-volatile, meaning data and instructions remain intact even when 
the computer is powered off. With a higher storage capacity compared to primary 
memory, secondary storage devices offer a more cost-effective solution. While 
they may be slower, they are also less expensive than primary memory. Secondary 
storage devices go by various names such as auxiliary storage, backup storage, 
or permanent storage. Examples of secondary storage devices include magnetic 
and optical storage devices.
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Floppy Disk

Types of Secondary Memory

a.	 Magnetic Storage Devices

Magnetic storage devices store data using a magnetic layer on their surface. 
This layer can be magnetized in different directions to represent binary 1s and 
0s. When the disk spins, a reader interprets the stored data. The surfaces of these 
devices are coated with materials like iron oxide, which can be magnetized to 
store data in binary form. Magnetic storage devices offer large data capacities at 
reasonable prices.

i.	 Magnetic Tapes: Magnetic 
tapes were the traditional 
types of storage devices 
where data were accessed 
in sequential order. These 
tapes were normally used 
for analog audio recordings. 
Early computers used these tapes to store digital data.

ii.	 Floppy Disk: A floppy disk consists of a 
flexible disk coated with magnetic material, 
encased in a protective plastic covering. Once 
a prevalent form of portable storage, they 
could hold up to 1.44 MB of data. However, 
they are now obsolete due to their limited 
storage capacity and reduced portability. To 
access data on a floppy disk, a Floppy Disk 
Drive (FDD) is required for reading and writing. IBM pioneered the 
creation of the first floppy disk. Floppy disks come in various sizes, with 
the disk's physical dimensions determined by its inch size.

iii.	 Hard Disk: The hard disk is the primary non-volatile secondary storage in 
personal computers. It surpasses other secondary storage devices in both 
storage capacity and speed. It holds all computer data in a magnetic format 

Magnetic Tape
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and is typically installed internally, 
directly connected to the motherboard's 
disk controller. Comprising one or more 
platters coated with magnetic material, 
data is written onto both sides of these 
spinning platters by a magnetic head 
that moves rapidly over them. The 
hard disk plays a crucial role in storing 
the operating system, as well as the 
installation of essential programs and 
user files. Each platter is mounted on a central spindle, and its surface is 
coated with magnetic material. While both surfaces of the disk can store 
data, only one side of the top and bottom disks is coated. Information is 
stored and retrieved from the rotating disk surfaces using magnetic read/
write heads, each associated with an access arm.

These days, many computers opt for an SSD (Solid State Drive) as their 
main storage instead of an HDD. While HDDs are slower at reading and 
writing data, they provide more storage space for the money.

iv.	 Flash Memory (Pen Drive): Flash 
memory is a form of non-volatile memory 
known for its ability to retain data even 
when power is turned off. This feature 
makes it ideal for storing and transferring 
data between personal computers and 
various digital devices. Its electronic 
reprogramming and erasing capability 
add to its versatility. Flash memory is 
commonly integrated into USB flash drives, MP3 players, digital cameras, 
and Solid-State Drives (SSDs). Data stored in flash memory is erased in 
blocks, necessitating the removal of entire blocks before new data can be 

Inside view of Hard disk

Pen Drive
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written. Despite being more expensive than traditional hard drives and 
RAM, flash memory offers advantages such as durability, portability, and 
faster access times. These qualities have contributed to its widespread 
adoption in modern technology.

SD/MMC Memory Cards

SD (Secure Digital) and MMC (Multi Media Card) memory cards are small, 
portable storage devices used to save data like photos, videos, and files. They 
work like tiny hard drives for gadgets such as cameras, smartphones, and tablets. 
SD cards come in different sizes (like standard, mini, and micro) and capacities, 
while MMC cards are older, similar type of card but less commonly used today. 
Both are inserted into compatible slots on devices, making it easy to transfer 
or store data. They are popular because they are lightweight, reusable, and 
convenient for expanding a device's storage.

b.	 Optical Storage

Optical storage devices utilize laser light beams to both read and write data onto 
their surfaces. However, their storage capacity tends to be lower when compared 
to magnetic devices.

i.	 CD-ROM: Compact Disk Read Only Memory (CD-ROM) is a frequently 
used secondary storage device that operates on laser beam technology for 
data reading and writing. Once data and instructions are stored on a CD-
ROM, they become permanent and cannot be altered or erased. To access 
the data on the disk, a CD or DVD drive is required. Compared to floppy 
disks, CD-ROMS offer a larger storage capacity.

ii.	 VCD (Video Compact Disc): VCD is a digital format used to store and 
play videos, similar to a DVD but with lower quality. It was popular before 
DVDs and streaming services became common. VCDs can hold about 
60–80 minutes of video and are played using VCD players, DVD players, 
or computers. They use the MPEG-1 video format and are often used for 
movies, educational videos, and presentations. While VCDs are now less 
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common, they were they important steps in the development of digital 
video storage and multimedia learning.

iii.	 CD-RW: A Compact Disk Rewritable (CD-
RW) is an optical storage device that allows data 
to be stored by burning a CD using specialized 
software called a CD burner. Unlike a CD-R (CD-
Recordable), a CD-RW can be written multiple 
times. While the data burned on a CD-RW cannot 
be altered, it can be erased. Therefore, to make 
changes or add new data, the entire CD-RW must be completely erased 
each time.

iv.	 DVD ROM: DVD-ROM, short for Digital Versatile Disk Read Only 
Memory, is an optical storage device renowned for its expansive storage 
capacity. Data and information stored on a DVD-ROM cannot be altered 
or erased, hence the term "read-only." It is frequently employed for 
storing large software applications. Similar to a CD-ROM (Compact 
Disk Read Only Memory), but with a greater capacity, a DVD-ROM can 
store approximately 4.38 GB of data, whereas a CD-ROM typically holds 
around 650 MB.

v.	 Blu-ray Disk: Blu-ray Discs, commonly referred 
to as BD discs, are optical storage devices that 
employ a blue laser beam for reading and writing 
data, in contrast to CDs and DVDs, which use a 
red laser beam. This difference allows BD discs 
to store more data in less space, resulting in a 
higher storage capacity compared to CDs. Blu-ray 
discs are typically utilized for storing large software packages, recording, 
rewriting, and playing HD videos. They can hold up to 25 GB of data.

Blu-ray Disk
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Exercise

Choose the correct answer from the given alternatives.
1.	 Which of the following is non-volatile memory?

a. ROM	 b. RAM	 c. Cache	 d. Register

2. 	 Which of the following is the fastest memory of a computer?

a. Hard Disk	 b. RAM	 c. Cache	 d. Register

3. 	 What is the main difference between RAM and ROM?

a. RAM is internal and ROM is external memory

b. RAM is non-volatile and ROM is volatile.

c. RAM is volatile and ROM is non-volatile.

d. RAM is external and ROM is internal.

4.	 Which of the following is another name of secondary memory?

a. Temporary		  b. Internal

c. Auxiliary		  d. All of the above

5. 	 Which of the following is high-speed memory between RAM and CPU?

a. Register		  b. Cache

c. Hard Disk		  d. All of the above

6. 	 Which of the following is Optical Storage Device?

a. CD	 b. DVD	 c. BDI	 d. All of the above.

7. 	 Choose the sequential storage.

a. Magnetic Tape		 b. Hard Disk

c. RAM		  d. ROM

8. 	 Which of the following is required periodic refreshment?

a. SRAM		  b. DRAM	

c. Both i and ii		  d. None of the above.
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9. 	 Which of the following uses electrical charges to erase the content?

a. EPROM		  b. EEPROM 	

c. PROM		  d. None of the above

10. 	 Which of the following is secondary storage device?

a. Hard Disk		  b. Pen drive

c. CD		  d. All of the above

Write short answer to the following questions. 
1.	 Define RAM.

2.	 List different types of ROM.

3.	 What is sequential storage device?

4.	 Define computer memory.

5.	 Give some examples of Primary Memory.

6.	 Define ROM? List its types.

7.	 What is Cache memory?

8.	 Define SRAM and DRAM.

9.	 What is EEPROM?

10.	 What is magnetic storage device?

11.	 What is optical storage?

12.	 Define Blu-ray Disk.

13.	 What is primary memory?

Write long answer to the following questions.
1.	 Define computer memory. Why it is necessary in computer systems?

2.	 What is primary memory? Lists its features.

3.	 Define secondary memory. List its features.

4.	 What is cache memory? Discuss its importance.

5.	 List different types of memory. 
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6.	 Describes the uses of cache memory in the computer. List its labels.

7.	 List the advantages and disadvantages of cache memory.

8.	 Differentiate between SRAM and DRAM.

9.	 What is RAM? List its characteristics.

10.	 What is ROM? Discuss its features.

11.	 Write short notes on: PROM, EPROM, and EEPROM.

12.	 Why is a hard disk called a permanent memory?

13.	 Write short notes on:

a. Hard Disk		  b. SSD

c. Optical Storage	 d. Blu-ray disk

e. Flash Memory

Project Work
1.	 Describe computer memory and its main types by using power point 

presentation and demonstrate. 

2.	 Prepare a presentation about "HDD and SSD" and demonstrate.

3.	 Prepare a presentation about different storage hardware found in computer 
lab and demonstrate. 

4.	 Draw a chart paper about different types of computer memory with your 
name and paste it into your classroom.

5.	 Visit the IT solution office such as the computer maintenance center and 
sales, and collect the latest available memory devices.
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8.5 	 The Input Device - Keyboard, Mouse, Trackball, Joystick, 
Digitizing tablet, Scanners, Digital Camera, MICR, OCR, OMR, 
Bar-code Reader, Voice Recognition, Light Pen, Touch Screen. 

A computer requires data and instructions to produce useful information. To 
enter data or instructions into a computer, input units are used. Input units are 
the components of a computer through which data or instructions are entered 
into the computer. It is the medium through which a user communicates with 
the computer. An input unit is also called an input device. A computer may 
have more than one input unit. Keyboard, mouse, joystick, touch screen, 
touchpad, scanner, digital camera, etc. are input units. When you enter data or 
instructions using input units, they convert the input data or instructions into 
computer-understandable form, i.e., binary form, and pass the binary form data 
or instructions to the computer for further processing. 

Keyboard

A keyboard is the basic input device that helps to input data or instructions 
into a computer. It consists of keys marked with alphabets, numbers, and some 
other characters. A user can input data like letters, text, numbers, and symbols 
through a keyboard. When a key on the keyboard is pressed, it generates the 
corresponding binary code of a character and sends it to the computer.
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A standard keyboard consists of 104 keys. A multimedia keyboard has more than 
104 keys. The keys on a keyboard are grouped into five different groups as:

a.	 Alphabet keys

b.	 Numeric keys

c.	 Cursor-movement keys

d.	 Functional keys

e.	 Special purpose keys	

Mouse

A computer mouse is a basic input 
device that allows a user to input 
data and commands displayed 
on the desktop or in the dialogue 
boxes by selecting them. It is a 
small handheld input device that 
is used, especially in the graphic 
user interface (GUI), to point and 
select icons, data, and commands 
displayed on the screen. Since it points to icons, data, and commands displayed 
on the desktop, menus, or dialogue boxes, it is also called a pointing device. 
A computer mouse can be used to control the position of the cursor and point 
and select items on the screen. Nowadays, an optical mouse is common on a 
computer. It looks like a mechanical mouse, but instead of a ball and wheels, it 
uses a light-emitting diode (LED), optical sensor, and digital signal processor to 
detect the movement of the mouse.

Trackball

A trackball is an input device that functions similarly to a mouse, except instead 
of moving the entire device, the user rolls a ball with their fingers or palm to 
manipulate the pointer on screen. It frequently has mouse-style buttons for 
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clicking and selecting items. Trackballs are commonly employed in specialized 
applications such as graphic design, gaming, and industrial equipment because 
they give fine control and take up less room to operate. A trackball, unlike a 
standard mouse, remains stationary, making it ideal for persons with limited 
work space or mobility issues.

Joystick

A joystick is a pointing device that is used to move the 
cursor on a screen. It has a stick that is attached to a square 
or rectangle plastic base with a flexible rubber case. The 
stick can be moved in all directions. A joystick has one or 
two buttons and a trigger. It is specially used for playing 
computer games.

Digitizing tablet

A digitizing tablet is an input device that lets users draw or write on a flat surface 
with a stylus. The tablet detects the pen's movements and pressure and converts 
them into digital data shown on a computer screen. It is widely used by artists, 
designers, and architects to produce digital drawings, animations, and technical 
sketches. Unlike a mouse, a digitizing tablet offers greater precision and control, 
making it suitable for creative and professional work. Some modern variants 
additionally offer touch input and wireless networking.

Scanner

A scanner is an input device that works more like a photocopy machine. It can 
scan and convert photos, printed text, handwritten documents, and drawings into 
digital images and transfer these digital images to the computer system. The 
digital images stored on a computer can be manipulated.

A scanner consists of two components: the first component generates the optical 
images of photos or other printed documents by illuminating them, and the second 
component converts the optical images into digital format and transfers them to 
a computer. The common optical scanner devices are Optical Mark Recognition 

Joystick
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(OMR), Optical Character Reader (OCR), and Magnetic Ink Character Reader 
(MICR).

Digital Camera

A digital camera is an input device that 
captures pictures or videos and stores 
them in digital format on its memory chip. 
It consists of an electronic photosensitive 
sensor that captures the photographs. 
The photos or videos stored in the 
digital camera can be viewed and erased 
immediately. The photos or videos from 
the camera can be transferred directly to the computer. Using suitable software, 
photos or videos on the computer can be edited according to the requirements.

MICR

A Magnetic Ink Character Reader 
(MICR) is an input device that is 
used in a bank to process a large 
volume of cheques and demand 
drafts. A cheque or demand draft 
is usually pre-printed with the 
bank’s identification number and 
the customer’s account number 
using a special ink containing iron 
oxide (magnetic ink). It reads the data written with magnetic ink on a cheque and 
transfers the information, like the bank's identification number, account number, 
amount, etc., to the computer system for immediate processing.

OCR

An Optical Character Reader (OCR) is a scanner that converts images or printed 
documents into digital images and transfers them to a computer. With the help of 

Digital Camera

Magnetic Ink Character Reader
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suitable OCR software like Fine Reader, the digital image can be converted into 
an editable document.

OCR may be handheld or flatbed. A handheld scanner is a portable scanner that 
can be held in a user's hand and can be moved over the document to be scanned. 
A flatbed scanner has a sheet of glass over which a photo or printed document to 
be scanned is placed.

Handheld Scanner Flatbed Scanner

OMR

Optical Mark Recognition is a special type of scanner that can recognize and 
count a pre-specified type of mark, such as checkmarks, bubbles, or boxes made 
on paper by pencil or ball pen. It reads and counts the marked data on the paper 
quickly and accurately. It is specially used for checking the answer sheets of 
examinations having multiple-choice questions.

Paper Marked with Pencil Optical Mark Recognition
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BCR

A Bar Code Reader (BCR) is an input device that reads data from a barcode, 
converts them into alphanumeric values, and passes them to a computer. A 
barcode is a machine-readable representation of data. A barcode represents data 
in a set of vertical parallel lines of varying thickness with gaps. Books and goods 
in the markets are labelled with barcodes. When you scan a barcode with a bar 
code reader, the information like details of the product, price, etc., is passed to a 
computer system.

Bar code Bar code Reader

Voice Recognition

Voice recognition technology enables a computer or device to understand and 
process spoken speech. It transcribes speech into text or commands, allowing 
users to control gadgets, surf the internet, and dictate messages without typing. 
Virtual assistants such as Siri, Google Assistant, and Alexa use voice recognition, 
as do security systems and hands-free applications. It benefits people with 
disabilities, increases accessibility, and makes tasks faster and easier. Advanced 
voice recognition systems may even learn different dialects and recognize unique 
voices, resulting in greater accuracy.

Light Pen

A light pen is a computer input device that resembles a pen and is used to draw 
or select items directly on the screen. It detects light from the monitor and 
sends signals to the computer when the pen hits the screen. Light pens were 
extensively used with older CRT (Cathode Ray Tube) monitors for graphic 
design, engineering, and computer-aided sketching. However, they are rarely 
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used nowadays because contemporary touchscreens and stylus-based tablets 
offer greater accuracy and simplicity of usage. Despite this, light pens played a 
significant role in the advancement of interactive display technology.

Touch Screen

A touch screen is a special kind of device 
which works as an output device as well as an 
input device. It displays data or information 
on its display screen and enables a user to 
select and input data by touching on the screen 
with a finger. When a user touches the display 
screen of the touch screen of an electronic 
device, it senses the pressure of a finger and 
activates the commands. Nowadays, the 
touch screen is used in laptops, notepads, 
tablets, smart mobile, ATM, kiosks, etc. 

Touchpad

A touchpad is a touch-sensitive pad that 
is used in laptop and notebook computers 
in place of a mouse. It is also known as 
a trackpad. A touchpad works by sensing 
the user's finger movement and downward 
pressure. So, when a user moves his or 
her finger on the pad, the mouse pointer 
moves on the screen accordingly. To select 
the items on the screen, a user has to tap once and to open a file, a user has to 
tap twice quickly, just like a user has to do while 
using a computer mouse.

Microphone

A microphone is an input device used for entering 

Touch Screen - Kiosks

Touch Pad

Microphone



124 Veterinary Extension and computer science

sound or voice into a computer. It is also called Mic, or Mike. It converts sound 
into an electrical signal and can be saved on a computer as a sound file. It is used 
for entering data and commands on a computer.

8.6 	 The Characteristics of Monitor-Digital, Analog, Size, Resolution, 
Refresh Rate, Interlaced/Non-Interlaced, Dot Pitch, Video 
Standard-VGA, SVGA, XGA etc. Printers and types – Impact 
(Dot matrix printer), Non-impact (Laser printer) 

Output Device

The device which displays meaningful information from the computer is called 
an output device. So, an output is the result produced by processing unit. The 
common output devices are monitor and printer. Some other output devices are 
plotter, speaker, headphone, etc.  

Monitor

The monitor is the most common output device. It is also called VDU (Visual 
Display Unit) in computer systems. The output displayed on the monitor's screen 
in the form of text, videos, and graphics is called soft copy output. On the basis 
of colour, two types of monitors are 

i.	 Monochrome monitor

ii.	 Color monitor

Monochrome Monitor

The monitor displays output in one color like green, white, black, blue, etc. 

Color Monitor

The monitor that displays output in different colors more than sixteen is called 
a color monitor. 

The information displayed on the screen is made of a combination of small tiny 
dots. The small tiny dots are called pixels.

The clear screen consists of three terms screen resolution, dot pitch, and refresh 
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rate. 

The characteristics of a monitor are as follows:

a.	 Digital vs. Analog

•	 Digital Monitor: Uses digital signals (0s and 1s) to display images, 
providing clearer and sharper pictures.

•	 Analog Monitor: Uses continuous signals, which may cause slight 
blurring. Older CRT (box-style) monitors are mostly analog.

b.	 Size

•	 Monitor is measured in inches diagonally from one corner to the 
opposite corner (e.g., 24-inch monitor).

•	 Bigger screens are better for watching videos and gaming, but take up 
more space.

c.	 Resolution

•	 The number of pixels (tiny dots) that make up the screen.

•	 Higher resolution = clearer and sharper images.

•	 Example: 1920 × 1080 (Full HD) means 1920 pixels across and 1080 
pixels down.

d.	 Refresh Rate

•	 Measured in Hertz (Hz), it shows how many times per second the 
screen updates.

•	 Higher refresh rate (e.g., 60Hz, 120Hz, 144Hz) = smoother motion, 
useful for gaming.

e.	 Interlaced vs. Non-Interlaced

•	 Interlaced (i): Draws half the image at a time (can cause flickering).

•	 Non-Interlaced (p or progressive scan): Draws the whole image at 
once, providing a clearer picture.
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f.	 Dot Pitch

•	 The distance between tiny dots (pixels) on the screen.

•	 Smaller dot pitch = sharper images.

g.	 Video Standards

Different types of display resolutions and qualities:

•	 VGA (Video Graphics Array) – Low resolution (640 × 480 pixels), 
older standard.

•	 SVGA (Super VGA) – Better resolution than VGA (800 × 600 pixels 
or higher).

•	 XGA (Extended Graphics Array) – Higher quality (1024 × 768 
pixels).

•	 HD (High Definition) – 1280 × 720 pixels or higher.

•	 Full HD, 2K, 4K, and 8K – Even sharper and more detailed images.

Printer

A printer is an output device that displays the data or information on the paper. 
There are mainly two types of printers. They are impact and non-impact printers. 

Impact Printer

An impact printer uses pins like objects or hammers that strike on the inked 
ribbon, and characters are formed on paper. Impact printers physically strike 
the paper. Impact printers are slow and noisy. The printing quality of impact 
printers is low. Based on the printing technology used in impact printers, there 
are mainly three types of impact printers. They are Dot-Matrix, Daisy-Wheel 
and Line printers. 

Dot-Matrix Printers

A dot matrix printer uses pin-like objects called a printer head. When the printer 
head strikes the inked ribbon, the impact of the hit forms dotted characters on the 
paper. Since the characters formed by dot matrix printers are in the patterns of 
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dots, they are not fully formed characters. So, the printing quality of dot-matrix 
printers is not good. The more number of pins in the printer head forms closer 
dots on the paper, making the characters appear more fully formed and easier 
to read. Dot matrix printer heads may contain 9, 18 or 24 pins. While printing, 
dot-matrix printers produce noise. Dot matrix printers can print characters of 
any shape and size. They are durable and relatively economical to operate. The 
carbon copy can be produced by using a dot matrix printer. The speed of dot-
matrix printers normally ranges from 50 to 400 characters per second.

Non-impact Printers

Non-impact printers (laser printers or 
inkjet printers) do not strike on the paper 
with pins like objects to form characters or 
images on the paper. They use laser beam 
technology or bubble jet technology. They 
do not produce noise while printing. The 
printing quality of non-impacts is good, 
but they are a little bit costly to operate. 
These printers can also print high quality 
photos. 

a.	 Laser Printer
A laser printer does not use pins like object to form characters or images on 
paper. A laser printer is an electrophotography printer that uses a laser beam to 
produce an image on a drum. The drum is coated with a photosensitive plastic, 
which is given a negative electrical charge over its surface. The light of the laser 
alters the electrical charge on the drum wherever it hits. That means wherever 
the laser light hits on the drum surface, it gets positively charged. The drum is 
then rolled through a reservoir of toner (i.e., negatively charged ink powder), 
which is picked up by the positively charged portions of the drum. Finally, the 
toner is transferred onto a piece of paper and fused to the paper with heat and 
pressure. After the document is printed, the electrical charge is removed from the 
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drum, and the excess toner is collected.

 Laser Printer Showing formation of image

The resolutions of laser printers range from 300 dpi to 1,200 dpi. Laser printers 
produce very high-quality prints and are capable of printing any shape or size of 
text or graphics. Laser printers are much quieter than dot-matrix or daisy-wheel 
printers. They are also relatively fast. They can print 6 to 200 pages per minute. 
The speed of laser printers ranges from about 4 to 20 pages of text per minute 
(ppm). A typical rate of 6 ppm is equivalent to about 40 characters per second 
(cps). 

3D Printer

A 3D printer is a special type of printer that can create 3D objects based on 
digital models. It uses layering and slicing to produce tangible, solid 3D objects, 
typically of plastic or resin.
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The computer devices used in animal farming are as follows:

a. 	 Drones: Farmers use drones to watch over animals from the sky. They help 
find lost animals, check if they are healthy, and see if they have enough 
food.

b. 	 RFID Tags and Readers: Small electronic tags are attached to animals 
(like cows or pigs), and a special scanner reads the tag to track their 
location, health, and feeding habits.
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c. 	 Automated Feeders: These are machines that give food to animals at the 
right time and in the right amount. Some are controlled by computers to 
make sure animals get the right diet.

d. 	 Milking Machines: In dairy farms, special machines help milk cows 
automatically. Computers help track how much milk each cow produces.
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e. 	 Temperature and Climate Sensors: These sensors help control the 
temperature in barns or animal shelters to keep animals comfortable and 
healthy.

f. 	 Ultrasound Machines: Vets use ultrasound to check if animals are 
pregnant and to monitor their health.
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g. 	 Cameras and Surveillance Systems: Cameras are used on farms to watch 
animals and make sure they are safe, even when farmers are not there.

h. 	 Health Monitoring Systems: These are wearable devices placed on 
animals to check their heart rate, temperature, and movements to detect 
sickness early.
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i. 	 GPS Trackers: Used to track animals in large farms or open fields, so 
farmers know where they are at all times.
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Exercise

Choose the correct answer from the given alternatives.
1.	 Which is not the input device?

a. Keyboard		  b. Joystick

c. Plotter		  d. Digital camera 

2. 	 Which of the following is used for playing games?

a. mouse		  b. touch pad

c. joystick		  d. microphone

3.	 What is equal to 2 millions cycle?

a. 1 GHz 	 b. 2 GHz	 c. 2 MHz	 d. 1MHz

4. 	 Which printer can print a digital model into a tangible and solid object?

a. Graphic Plotter	 b. 3D printer

c. Laser printer		  d. Inkjet printer

5.	 Which is an impact printer?

a. Dot-matrix printer	 b. Laser printer	

c. Inkjet printer		  d. None of the above

Write short answer to the following questions. 
1. 	 Define computer hardware. List any two input and output devices.

2. 	 Write the uses of keyboard and mouse.

3.	 List any four input devices.

4. 	 Write the uses of OMR, Joystick and BCR.

6. 	 What is a printer? List the types of printers.

7.	 What is an impact printer? List its types.

8. 	 What is the non-impact printer? List its types.

9. 	 What is a microprocessor? Write its major parts.
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10. 	 Write the functions of CU and ALU.

11. 	 What is the monitor? Explain its types.

Write long answer to the following questions.
1. 	 What are the computer devices used in animal farming?

2. 	 What is output device? List any two output devices.

Project Work

1. 	 Prepare a chart of input devices and demonstrate.

2.	 Prepare a chart on 'output devices' and demonstrate.

3. 	 Make a presentation on the "Input device" and demonstrate.

4. 	 Make a presentation on the "Output device" and demonstrate.

4.	 Prepare a chart on 'Microprocessor and its parts' and demonstrate.
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8.7	 The Computer Software and its Importance 
A computer is made up of hardware and software. The computer hardware can 
work only when it get data and instructions. A set of instructions given to a 
computer to perform some tasks is known as a program. The computer cannot 
perform any task without programs. The program defines the instructions that 
a computer has to carry out. A program tells a computer what to do and how to 
do. Computer program directs a computer how to process and execute data. A 
collection of programs that operates and controls computer hardware or performs 
specific tasks is known as software. Software is non tangible part of computer 
that you can’t touch or feel. It makes the computer hardware to perform tasks. 
It guides the computer at every step where to start and stop during a particular 
task. It increases the capabilities of the hardware. Software and hardware are 
complementary to each other. Both have to work together to produce meaningful 
output.

Microsoft Windows XP, Microsoft Windows 7, Microsoft Windows 8, Windows 
10/11, Linux, Unix, Novell Netware Server, Microsoft word, Microsoft Power 
point, Microsoft Excel, VLC media player, Microsoft media player, Adobe 
Photoshop, Android, MacOS, etc. are computer software.

8.8	 Types of Software-System Software, Application software

 There are mainly two types of software.



137Animal Science (Grade 9)

a)	 System Software

b)	 Application Software

System software is a set of programs that is designed to control the operations 
of a computer system. The system software helps computer hardware to work 
together. It controls and manages all internal operations like reading data 
from input devices, transferring information to output devices, checking the 
components of a computer, etc. System software is essential for the development 
of applications software. System software provides environment for application 
software in order to run on the computer. So, system software is software that is 
designed to run computer hardware and application software.

Features of System Software

System software is the low level software that has the following features:

a.	 System software provides effective platform for higher-level software to 
operate on the computer system.

b.	 It is developed using the low level languages to control and manage 
computer hardware.

c.	 It links the computer hardware and provides functionality to hardware.

d.	 It provides the user interface to interact with computer hardware and 
application software.

e.	 It runs in the background and manages all functioning of the computer 
itself. 
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f.	 It manages all the essential functions of a computer.

System Software may be: 

a.	 Utility Software

b.	 Device Drivers

c.	 Programming Language and Language Processor 

d.	 Operating System Software

Utility software is helpful software that performs specific tasks related to the 
maintenance of computer hardware and data. It helps to keep a computer in 
a smooth functioning condition. It provides facilities for performing tasks like 
transferring data and files, recovering lost data and files, searching and removing 
computer viruses, disk management, etc. Backup software, Download Accelerator 
(DAP), Split File, Antiviruses, WinZip, WinRAR, Disk Defragmenter, Registry 
Cleaner, History Cleaner, Cleaner, etc. are some examples of utility software.

WinRaR CCleaner Avira Antivirus

A device driver is a set of programs that is designed to control and manage 
the specific device. The device drivers make the devices usable. Every device 
or hardware like a printer, sound card, display card, etc. has its device driver. 
Suppose you have bought a new printer and to use the printer, you have to first 
install the device driver of the printer. 

A programming language is the system software that allows a programmer to 
write software. Low-Level Language and High-Level Language are two types 
of programming languages. 
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A language processor (also called translator) is system software that translates 
programs written in assembly language or high-level language into machine 
language. Assembler, interpreter, and compiler are three types of language 
processors.

An operating system is the basic system software that controls and manages the 
overall operation of a computer.

Application Software 

Application software is the specific software that is designed to fulfill the 
requirements of people. It can perform specified tasks such as handling 
financial accounting, processing words, preparing exam results, producing bills, 
manipulating images and videos, etc. Application software does its tasks with the 
help of an operating system. Packaged Software and customized (or Tailored) 
software are two types of application software. 

Packaged software is readymade software developed for all general users to 
perform their generalized tasks. Software companies like Microsoft, Adobe, 
Dropbox, Corel, Oracle, Google, etc. are used to develop packaged software. 
MS Office, Adobe InDesign, Sybase, SQL Server, Oracle, CorelDraw, Adobe 
PhotoShop, 3DS Max, Maya, VLC Media Player, Google Meet, Zoom, Spotify, 
etc. are packaged software.

Customized (Tailored) software is the application software that is designed 
to fulfill the specific requirements of an organization, office, or individual. It is 
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useful for the organization, office, or person for whom it is developed. SEE Result 
Processing Software, Hospital Management Software, School Management 
Software, Bill Processing Software, Air Ticket Reservation Software, Banking 
Software, etc. are customized software.

Features of Application Software

a.	 Application software is user-friendly software that enables a user to 
perform his/her tasks easily.

b.	 It increases the productivity of a user.

c.	 It provides facilities to customize settings, preferences, and other 
options to meet users' specific needs.

d.	 It enables users to perform their tasks in more organized and efficient 
ways.

Difference between System and Application Software

System Software Application Software
•	 System software manages basic 

system resources and processes.
•	 Application software performs 

specific tasks to fulfill user needs.
•	 System software runs in the 

background and users do not 
usually access it.

•	 Application software runs in the 
foreground and users work directly 
with it to perform specific tasks.

•	 System software is the basic 
need of a computer. Without it, 
a computer cannot run.

•	 An application software is required 
when a specific task has to be 
performed on a computer.

•	 System software provides a 
platform for other software.

•	 Application programs are designed 
to perform tasks and activities for 
the users.

•	 System software helps to run 
application software

•	 Application software cannot run 
independently without system 
software.
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•	 Low-level languages (assembly 
language) and middle-level 
languages (C) are used to create 
system software.

•	 High-level languages like C++, 
Java, .Net, VB, etc., are used to 
create application software.

The use of computer software in animal farming are as follows:

a. 	 Farm Management Software: This software helps farmers keep records 
of their animals, feeding schedules, health reports, and farm activities. 
Example: Agrivi, FarmLogs
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b. 	 Livestock Tracking Software: This software is used to track animals 
using electronic tags (RFID) or GPS. It helps farmers know where animals 
are and monitor their health. Example: CattleMax, Herdwatch

c. 	 Milking System Software: Dairy farms use this software to monitor 
how much milk cows produce and track their health. Example: DeLaval 
DelPro, DairyComp 305
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d. 	 Animal Health Monitoring Software: It helps veterinarians and farmers 
keep track of diseases, vaccinations, and overall animal health. Example: 
SmartBow, CowManager

e. 	 Genetics and Breeding Software: It is used to improve animal breeding 
by selecting the best animals for reproduction. Example: BreedMate, 
AGIS (Animal Genetics Information System)
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f. 	 Climate Control Software: It is used in barns or animal shelters to adjust 
temperature, humidity, and ventilation automatically to keep animals 
comfortable. Example: Argos, Farm2050

g. 	 Feed Management Software: It helps farmers calculate the right amount 
of food for each animal to ensure that they stay healthy and grow properly. 
Example: TMR Tracker, FeedWatch
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h. 	 Veterinary Software – This software helps vets keep records of animal 
checkups, treatments, and medicines. Example: ezyVet, Provet Cloud

These software programs help farmers take better care of animals, increase farm 
production, and improve animal health.
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Exercise

Choose the correct answer from the given alternatives.
1. 	 Which is not the operating system?

a. MS Word	 b. Android	 c. Linux	 d. Unix 

2.	 Which is the operating system?

a. Android	 b. Windows 10	 c. Linux	 d. All of the above

3.	 What is system software?

a. controls the operation of a computer		

b. provides the environment to run other software	

c. links a user, hardware, and application software.		

d. All of the above

4. 	 What is utility software?

a. helps to keep a computer in good working condition.

b. transfers data from a hard disk to RAM.

c. links hardware and software.

d. controls computer hardware.

5. 	 Choose an application software.

a. Microsoft Word	 b. Windows 10

c. Linux		  d. All of the above

6. 	 Which of the following manages RAM?

a. Device driver

b. Utility software	

c. Application software

d. Operating system software



147Animal Science (Grade 9)

Write short answer to the following questions. 
1. 	 What is system software? List its four features.

2.	 List the types of system software.

3.	 What is application software? List its types.

4. 	 Write the differences between packaged software and customized software.

5. 	 Write the differences between system software and application software.

Write long answer to the following questions.
1. 	 What is an operating system? Explain its functions.

2. 	 What is system software? Explain its types.

3. 	 What is application software? Write its uses.

4. 	 What are the computer software used for in animal farming ?

Project Work 

1. 	 Draw “Classification of software” on chart paper and demonstrate.

2. 	 Make a presentation on the "Operating system".

3. 	 Make a presentation on the "Application software"

4. 	 Make a presentation of the system, application, and utility software used in 
your computer lab.

5. 	 Collect names of software used in hospitals, hotels, the educational sector, 
and other different sectors surrounding you and group discussion about the 
main objectives of this software.  

6. 	 Take a short interview with your teachers, friends, parents, and relatives 
and prepare a field report about what types of computers, laptops, or other 
devices they are using, and what types of Operating Systems the device 
installs. Also, make a list of apps that they have used on their smartphones.
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The software which is specially designed for the end users to solve specific 
tasks is called application software. Application package software, or simply an 
application package, is a collection of software programs that are used by the 
end users to solve day-to-day tasks.  Microsoft Office also referred to as Office 
Package is an application package that is designed specifically to be used for 
official and business use. It is a proprietary product of Microsoft Corporation 
and was first released in 1990. Microsoft Office is a collection of office-related 
applications and each application serves a unique purpose and offers a specific 
service to its users. Microsoft Office consists of different programs like MS 
Word, MS Excel, MS PowerPoint, MS Access, MS Outlook,  MS Project, and 
MS Onenote. 

9.1	 Conceptualize Word Processing, types, and uses, Word 
Processor’s Interface Enter and Edit Text Formatting, Text-
Characters, Paragraphs, and Documents, Work with Special 
features of Word Processing – Language tools, Tables, WordArt, 
and Charts Add Graphics 

A word processor is an application software that allows users to create, edit, 
design, and print documents. It enables the user to type text which creates a 
virtual document on the computer screen. The virtual document can be then saved 
electronically or even sent electronically. Word Processor is one of the most 
commonly used application softwares that is available either as a cloud service 
or as software that users install on a personal computer or mobile computing 
device. It has a variety of uses and applications within the business world, home, 

Unit 
9

Application of Software
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education, and many other areas.  In the business world word processor is used 
for legal copies, letters and letterhead, memos, and reference documents. At 
home, word processing is used for writing short stories, letter writing, résumé/
CV creation, and card creation. In education, word processing is used in a variety 
of ways such as in the production of assignments, notes, and exams.  Some of 
the examples of word processing software are MS Word, Libre Office Writer, 
Open Office Writer, Word Perfect, etc.

Features of Word Processing Software

There are various features of word processing software. Some of the features of 
word-processing software are as follows ; 

	Word processing software allows to insert text anywhere in the 
document

	It allows to erase unnecessary characters, words, lines, or pages of the 
document.

	It has cut and paste facility which allows to remove a section of text 
from one place in a document and insert it somewhere in the document.

	It has copy facility which allows to duplicate a section of text and paste 
it anywhere in the document.

	It allows the definition of various page sizes and margins, and the word 
processor will automatically readjust the text so that it fits.

	It allows to send a document to a printer to get a hard copy.

	It provides file management capabilities that allow you to create, delete, 
move, and search for files.

	Character formatting allows to display of the characters and selected 
text in bold, italics, and underlining. 

	It allows you to edit two or more documents at the same time. Each 
document appears in a separate window. This is particularly valuable 
when working on a large project that consists of several different files.
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	Grammar checking identifies sentences, paragraphs, and punctuation 
that don't appear to meet commonly recognized rules of grammar.

	Allows to insert footnotes and cross-references: 

	Automatically creates bulleted or numbered lists, including multi-level 
outlines.

Text editor

A text editor is a program that allows the user to open, view, and edit plain text 
files.  Text editors do not provide the facility of formatting text but focus on 
editing functions for plain text.   Text editors are used by software programmers 
and web developers to write and edit in programming and markup languages. 
This is one of the primary purposes of text editors, and many of the features 
of text editing software are built to help these users read and write code. Text 
editors are also useful for anyone who needs to write quickly and simply, read 
source code, or create text files. Office workers sometimes use text editors to 
create simple documents that don't require a full-featured word processor. Text 
editors are provided along with OS and software development packages. Some 
of the examples of text editor software are Note pad (Windows OS), and Notes 
app (Mac OS).

Desktop Publishing Software

Desktop Publishing (DTP) software is mostly used for designing brochures, 
business cards, greeting cards, web pages, posters, and more for professional or 
personal printing. DTP software is comparatively more advanced and complex 
than word processing software. 

Microsoft Word

Microsoft Word is the most popular word processing software, designed, 
developed, and sold by Microsoft Corporation U.S.A. It allows the user to create 
professional-quality documents, reports, letters, and résumés which can be saved 
and used for future use. It has the features of integrating documents, and pictures 
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with other MS Office components such as MS Excel, MS Powerpoint Point, etc. 
There are many versions of Microsoft Word such as MS Word 95, 97, 98, 2000, 
2003, 2007, 2010, 2013, 2016, and 2019. 

Microsoft Word 2016

Microsoft Word 2016 is the latest and greatest offering from the Microsoft Office 
suite. It provides several new features and improvements to existing features. 
The new feature of MS Word provides an easy and fast way to make quality 
documents. The extension of MS Word is .docx.

Starting  MS Word

	Click on the MS Word icon in the Taskbar, Or

	Click on the Start button and choose Search.

	Type "winword" in the search field.

	MS Word will open, prompting you to select a theme. 

	Click on Blank document. The following MS Word window appears on 
the screen.
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File Menu

The File tab will bring the Backstage View. The Backstage View is used to 
manage the files such as creating, opening, printing, saving, inspecting for hidden 
metadata or personal information, and setting options. The Backstage View also 
provides some information (properties) about the file, including the following.

	file size

	number of pages and words

	creation date

	last modified date

	author

The Arrow is used to close the Backstage view and return to MS Word.

Info: The Info option available in the first column displays various properties of 
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the current document. These properties include the document size, 
the number of pages in the document, the total number of words in 
the document, the name of the author, etc. It also contains options 
like protecting documents and inspecting documents.

New: The new option is used to create a new blank document and the user can 
also choose required templates from the large selection of templates.

Open: The open option is used to open existing documents that are saved on 
the computer or to  OneDrive. It will also display the list of recently opened 
documents.

Save: The save option is used to save documents to the computer or OneDrive.

Save As: Save As option is used to save the previously saved documents with a 
new File name.

Print: The print option is used to change the print settings and print the 
document. Users can also see a preview of the document.

Share: The share option is used to invite people to view and collaborate on the 
document.

Export: The export option is used to export documents in another file format, 
such as PDF/XPS.

Close: The close option is used to close the current document.

Account: The account option is used to access Microsoft account information, 
modify the theme and background, and sign out of the account.

Options: Options are used to change various Word options. For example, you 
can control the spelling and grammar check settings, AutoRecover settings, and 
language preferences.

Ribbon: Ribbon is an area across the top of the screen that makes almost all the 
capabilities of Word available in a single area. File Menu, Quick Access Toolbar, 
ZoomView, Toolbar, Status Bar, Dialog Box LauncherGroups, Title Bar, Tabs, 
Tell Me.
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Title Bar: The title bar is the long horizontal bar that is placed at the top of 
an active document. This bar displays the name of the opened document and 
application. At the right end of the Title Bar are the Minimize, Maximize, and 
Close buttons.

Groups:  A group of buttons on a tab that are exposed and easily accessible. For 
example, the Font group on the Home tab contains commands for formatting text 
in the document.

Dialog Box Launcher:  It is a button in the corner of a group that launches a 
dialog box containing all the options within that group.

Status Bar: It is a horizontal bar at the bottom of an active window that gives 
details about the document.

View Toolbar: The view toolbar is used to enable, adjust, and display different 
views of a document.

Zoom: It is used to magnify or reduce the contents in the document window.

Quick Access Toolbar: It is a customizable toolbar at the top of an active 
document. By default, the Quick Access Toolbar displays the Save, Undo, and 
Repeat buttons and is used for easy access to frequently used commands. To 
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customize this toolbar, click on the dropdown arrow and select the commands 
you want to add.

Tabs: It is an area on the Ribbon contains buttons that are organized in groups. 
The default tabs are Home, Insert, Design, Layout, References, Mailings, 
Review, View, EndNote X5 and Tell Me. Each tab contains several groups of 
related commands. Contextual Tabs are designed to appear on the Ribbon when 
certain objects or commands are selected. These tabs provide easy access to 
options specific to the selected object or command. For example, the commands 
for editing a picture will not be available until the picture is selected, at which 
time the Picture Tools tab will appear.

Home

The home tab is a tab or button in an application or web page that returns you 
to the home section. In Microsoft Office, the Home tab is the default tab in 
Microsoft Word, Microsoft Excel, Microsoft Powerpoint, and other Microsoft 
Office products.

Insert

Insert tab is used for inserting different items into the documents like Cover 
page, Blank page, Page break, table, Pictures, clip art, etc.
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Design

The design tab is mainly used in document formatting which can be used to 
change Themes, Colors, Fonts, Paragraph Spacing, etc.

Layout

This tab is used to make changes to the layout of a page within a Word document 
such as orientation, margins, page breaks, and page borders.

Mailings

The Mailings tab is probably the least often used tab of all the Microsoft Word 
tabs. This can help print envelopes or labels out along with writing and inserting 
different fields. There is a handy option to preview the results and an option to 
convert the file to a PDF format.

Tell me what you want to do.

This is a text field where users can enter words and phrases about what they want 
to do next and quickly get to features they want to use or actions they want to 
perform. Use can also use Tell Me to find help about what they are looking for, 
or use Smart Lookup to research or define the term you entered.



157Animal Science (Grade 9)

Creating Documents and Environment

Document in MS Word can be created from a blank page or by using a template 
that is already formatted. When users start typing text at the insertion point in a 
blank document then, the word document is created. As user types the character, 
MS Word inserts the text to the left of the insertion point and uses the program’s 
defaults margins and line spacing. The margin defaults are set to one-inch top, 
bottom, left, and right margins,  the line spacing is set to 1.08  and the spacing 
after each paragraph is set to 8 points. Word also has a number of tools and 
automatic features to make creating a document easier, including nonprinting 
characters, AutoComplete, and Word Wrap. Perform the following steps to 
create a New Word Document.

	Click on  the File tab

	Click New option.

	Click on Blank Document or choose the required templates from the 
list.
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Formatting Texts and Paragraphs

Formatting Paragraphs

A paragraph in Word is any text that ends with a hard return. User can insert a 
hard return anytime by pressing the Enter key. Paragraph formatting lets the user 
to control the appearance of individual paragraphs. Collectively, the settings that 
users use to vary the look of a paragraph are called paragraph formatting. For 
example, users can change the alignment of text from left to center or the spacing 
between lines form single to double. Users can also indent paragraphs, number 
them, or add borders and shading to them.

Paragraph Alignment

Paragraph alignment determines how the lines in a paragraph appear in relation 
to the left and right margins. It determines the appearance and orientation of the 
edges of the paragraph: The margin is the blank space between the edge of the 
paper and the text. By default, Word aligns paragraphs to the left. User can align 
paragraphs in MS Word so the right sides are symmetrical which is called right 
alignment. User can also align them in the center with even space on both sides 
which is called center alignment. User can also justify the alignment, which 
aligns both the left and right sides.  Perform the following steps to align the 
paragraph.

	Select the paragraph that is to be aligned.

	Click on the Home tab.

	In the paragraph group click left alignment, Center alignment, Right 
alignment or Justified.
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Users can also change the alignment of the paragraph through the following 
steps.

	On the Home tab in the Paragraph group, click the Paragraph dialog 
box launcher.

	On the Indents and Spacing tab, in the General area, click Left, 
Centered, Right, or Justified in the Alignment list.

Line and Paragraph Spacing

Line space is the amount of vertical space between lines of text in a paragraph. 
Line spacing is typically based on the height of the characters, but you can change 
it to a specific value. For example, some paragraphs may be single-spaced and 
some double-spaced. Single-spacing is Word’s default setting. Paragraph space 
is the amount of space above or below a paragraph. Instead of pressing Enter 
multiple times to increase space between paragraphs, you can set a specific 
amount of space before or after paragraphs.
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Perform the following steps to change the spacing between lines and paragraphs.

	Select the line or paragraph that is to be spaced.

	Click on the Home tab.

	In the paragraph group, click the line spacing command button and 
choose the desired option.

Users can change the spacing between the lines of a paragraph through the 
following steps.

	On the Home tab in the Paragraph group, click the Paragraph dialog 
box launcher.

	On the Indents and Spacing tab, in the Space area, click Single, 1.5 
lines, Double, At least, Exactly, or Multiple in the Line spacing list.
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Paragraph Indents

An indent increases 
the distance between 
the side of a paragraph 
and the left or right 
margin. Indented 
paragraphs appear to 
have different margin 
settings. Word provides 
a variety of indents to 
emphasize paragraphs 
in a document.

	 First-line indents are 
sometimes used in 
reports and books to 
help the reader’s eye 
catch the beginning 
of a paragraph. In 
layouts with vertical 
space between 
p a r a g r a p h s , 
however, first-line indents are less useful because it is easy to see where a 
new paragraph begins without that help.

	 Hanging indents are typically used to create listings. In a bulleted or numbered 
list, the bullet or number hangs off the left edge of the paragraph, in a hanging 
indent. However, in Word, when you create bulleted or numbered lists, Word 
adjusts the paragraph’s hanging indent automatically, so you don’t have to 
think about it.
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Perform the following steps for paragraph indents.

	On the Home tab in the Paragraph group, click the Paragraph dialog box 
launcher.

	On the Indents and Spacing tab, in the Indentation area, choose First line or 
Hanging in the Spacing list.

Formatting Texts

The process of changing the appearance of the text is called formatting texts. 
Users can change the appearance of text into bold, italic or underlined and 
can also change the font type, size, and color of the text or even of the entire 
paragraph.

Changing the Text into Bold, Italic, and Underlined

Users can easily change the appearance of text into bold, italic or underlined. 
Perform the following steps to make the bold, italic, or underline.

	Select the text or entire paragraphs.

	Click on the Home tab and locate the Font section.

Click on the B icon to make the text bold.
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Click on the I icon to make the text italic.

Click on the U icon to make the text underlined.

Click on the ABC icon to make the text strikethrough.

User can also change the text into bold, italic, underline, and strike through by 
following steps.

	Select the text and paragraph that you want to format.

	Click on the Home tab.

	Under the Fonts block, click the expand button. It's a small arrow icon 
in the bottom right corner.
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	The Font settings window will be opened.

	Select Bold, Italic, Underline and Strikethrough option.

	Click on OK button to apply the effect.

Changing the Text into Superscript and Subscript Form

Superscripts are numbers, letters, or symbols that appear slightly above the 
surrounding text. Subscripts are letters, numbers, words, or phrases that appear 
slightly below the surrounding text. Perfom the following steps to change the 
text into superscript and subscript form.

	Select the text that is to be changed into superscript and subscript form.

	Click on the Home tab and locate the Font section.

	Click on the Subscript or the Superscript option.
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Users can also change the text into superscript and subscript form by following 
steps.

	Select the text that you want to change into superscript and subscript form

	Click on the Home tab.

	Under the Fonts block, click the expand button. It is a small arrow 
icon in the bottom right corner. 

	The Font settings window will be opened.
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	Select Superscript or Subscript option.

	Click on OK button to apply the effect.

Changing size, color, and font of the text and paragraph

When user creates a new blank document, the default font type of the text is 
Calibri with font size of 11 points, which is a standard size for text in every 
documents.  User can change the font type, size and color of the text and entire 
paragraph according to their needs ad choice. Perform the following steps to 
change the font type, size and color of the text and entire paragraph.
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	Select the text or paragraph that you want to format.

	Click on the Home tab and locate the Font section.

	Click on the Font to change the Font type, Size to change the font size, 
and Color to change the color of the text.  

Users can also change the size, color, and font of the text and paragraphs 
through the following steps.

	Select the text and paragraph that you want to format.

	Click on the Home tab.

	Under the Fonts block, click the expand button. It is a small arrow 
icon in the bottom right corner. 

	The Font settings window will be opened.
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	Select the desired font, font style, size, and effects.

	Click on the OK button to apply the effect.

Managing Lists and Tables

Lists

Lists can be used in documents to format, arrange, and emphasize text in the 
documents. They can be handy for organizing the text. 

The different types of lists that are available in MS Word are:
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	Bullets

	Numbering

	Multilevel lists

Bullets

The lists that are displayed in the form of bullets such as balls or dots are called 
bulleted lists. It is also called an unordered list because the list items are not 
arranged in numerical order.  So bulleted list can be used if the items involved 
in the list do not require any specific order. Perform the following steps to place 
bullets in the list of items.

	Type your list, and then select it. 

	Click on the Home tab.

	Locate the paragraph group and select the Bullets option.

	Click the arrow next to Bullets to find the different bullet styles.
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	Choose the appropriate bullets from the list that will fit in the document.

	The entire list can be aligned to the left, center, or in the right position 
of the Document.

Numbering

The list which is displayed in a sequential order is called the Numbered list. This 
type of listing is appropriate if the order or positioning of items is important in 
the document. The process for adding a numbered list to a document is similar 
to adding a bulleted list. The main advantages of numbered list is MS Word 
automatically renumbers the list so that they retain their sequence if any item is 
inserted in the middle of the list. Perform the following steps to place numbering 
in the list of items.

	Type your list, and then select it. 

	Click on the Home tab.

	Locate the paragraph group and select the Numbering option.
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	Click the arrow next to Number to find the different Number styles.

	Choose the appropriate number from the list that will fit in the document.

	The entire list can be aligned to the left, center, or right position of the 
document.
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Table

A table is a combination of rows and columns. The intersection of a row and 
column forms a small rectangular object called a cell.  Data in a table is inserted 
in a cell. Tables are often used to organize and present information, but they have 
a variety of uses as well. In MS Word users can quickly insert a blank table or 
convert existing text to a table and can also customize the table using different 
styles and layouts. Perform the following steps to create and insert a table in the 
document.

	Place the cursor in the document where the table is to be placed.

	Click on the Insert tab.

	Locate the Tables group and select the Table option.

	A drop-down menu showing different ways to create a table will be 
displayed. The table can be inserted in the document by using different 
ways.

•	 Insert the desired number of columns and rows by selecting the grid.



173Animal Science (Grade 9)

Or                    

•	 Click on the Insert Table option and enter the number of rows and 
columns that you want to create.

                                                                Or

•	 You can also manually create a table by clicking on the Draw Table 
option.

 Add a Drawing to a Document

	Click on the document where the drawing is to be created.

	Click on the Insert tab.
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	Locate the Illustrations group and click Shapes.

	Select the shape that is to be drawn.

	Click and drag the + cursor anywhere on the document to draw the 
selected shape.

	You can do any of the following on the Format tab, which appears after 
you insert a drawing shape:

•	 Insert a shape: On the Format tab, in the Insert Shapes group, click a 
shape, and then click somewhere in the document.

•	 Change a shape: Click the shape you want to change. On the Format 
tab, in the Insert Shapes group, click Edit Shape, point to Change 
Shape, and then, choose a different shape.

•	 Add text to a shape: Click the shape where you want text, and then 
type.

•	 Group-selected shapes: Select several shapes at a time by pressing 
CTRL on your keyboard and clicking each shape you want to include 
in the group. On the Format tab in the Arrange group, click Group so 
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that all of the shapes will be treated like a single object.

•	 Draw in the document: On the Format tab, in the Insert Shapes group, 
expand the shapes options by clicking the arrow. Under Lines, click 
Freeform or Scribble.

•	 Adjust the size of the shapes: Select the shape or shapes you want to 
resize. On the Format tab, in the Size group, click the arrows or type 
new dimensions in the Height and Width boxes.

•	 Apply a style to a shape. In the Shape Styles group, rest your pointer 
over a style to see what your shape will look like when you apply that 
style. Click the style to apply it. Or, click Shape Fill or Shape Outline 
and select the options that you want.

	Add flow charts with connectors. Before you create a flow chart, add 
a drawing canvas by clicking the Insert tab, clicking Shapes in the 
Illustrations group, and then, clicking New Drawing Canvas. On the 
Format tab, in the Insert Shapes group, click a Flow chart shape. Under 
Lines, choose a connector line such as the Curved Arrow Connector.

	Use shadow and three-dimensional (3-D) effects to add interest to the 
shapes in your drawing. On the Format tab, in the Shape Styles group, 
click Shape Effects, and choose an effect.

	Align the objects on the canvas. To align the objects, press and hold 
CTRL while you select the objects that you want to align. On the Format 
tab, in the Arrange group, click Align to choose from an assortment of 
alignment commands.
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Inserting Pictures

	Click on the document where the picture is to be placed.

	Click on the Insert tab.

	Locate the Illustrations group and select the Pictures option.

	Select the necessary pictures from the hard disk and click the Insert 
option.

	Select Online Pictures to select the pictures from the web.

While the image is selected, a new tab Picture Tools Format appears on the 
Ribbon.

	Click on picture style to add a frame, drop shadow, and other predefined 
effects.

	Click on the Corrections option to adjust the brightness and 
contrast of the image. 

	Click on the Color option to adjust the image's saturation (how vibrant 
the colors appear), tone (the color temperature of the image, from cool 
to warm), and coloring.

	Click on Artistic Effects to apply special effects to your image, such as 
pastel, watercolor, or glowing edges.

	Click on Picture Effects to add shadows, soft edges, bevels, or other 
visual effects.

	Click on the Position option to select the position of the image to be 



177Animal Science (Grade 9)

placed in the document.

	Click the Wrap Text option to wrap text around an image.

	Click the Crop button and then choose Crop to Shape to crop the image.

	Click on the Rotate option to flip the image horizontally, and vertically, 
rotate right 900, rotate left 900, and other rotational options.

Resize or Crop a Picture

 The process of removing unwanted areas from an image is called cropping. This 
process is one of the most basic photo manipulation processes. The image should 
not be distorted by sizing it up or adjusting from the edges. 

Perform the following steps to resize the pictures.

	Click the picture or shape you want to resize.

	Drag a sizing handle away from or toward the center.

Perform the following steps to crop the picture.

	Select the picture that you want to crop.

	Click on the Format tab.

	Locate the Size group and clip on the Crop option.

	Drag the cropping handles on that side or corner you want to adjust.

Inserting chart

The chart is a form of representing data which can be in the form of figures and 
values in the form of diagrams. These diagrams can be in the form of a Column, 
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line, pie, bar, area charts, etc. Sometimes, the size of data is so large and complex 
that it cannot be understood easily and will be difficult to present to others. So to 
overcome this problem data can be expressed in the form of a chart. Perform the 
following steps to insert the chart in the document.

	Click on the document where the chart is to be inserted.

	Click the Insert tab.

	Locate the Illustrations group and click the Chart option.

	Click the chart type that you want to insert and click OK.
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	In the spreadsheet that appears, replace the default data with your own 
information.

	When  chart is inserted ,small buttons appear next to its upper-right corner. 

Use the Chart Elements  button to show, hide, or format things like axis 

titles or data labels. Or use the Chart Styles button to quickly 

change the color or style of the chart. The Chart Filters button is a 

more advanced option that shows or hides data in your chart.

	Close the spreadsheet after entering the data. 

	Click on the Design tab of chart Tools to change the chart style.

	Click on the Format tab of Chart Tools for Shape fill, Shape outline and 
shape Effects.

Inserting Smart Art
SmartArt is a graphical tool included in the latest versions of MS Word. 
SmartArt is a way to make organized presentation art. Users can easily create a 
dynamic, appealing diagram by using SmartArt graphics, which visually express 
information in predefined sets of shapes.
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Perform the following steps to insert SmartArt.

	Click on the document where the chart is to be inserted.

	Click on the Insert tab.

	Locate the Illustrations group and click the SmartArt option.

	Choose the category from the left section of the “SmartArt Graphic” 
window and insert SmartArt Graphics from the middle section.

	Now, type the parameters in the given “Text Pane” window.

Inserting  Paragraph Borders and Shading

Borders can be applied to all of the four sides of an entire page, an entire 
document, or just certain sections of the document. A border can also be applied 
to paragraphs.

Shading is the color or artistic design that can be used as a background for 
a paragraph. Borders and shading are formatting tools for enhancing text, 
paragraphs, table cells, or frames. Perform the following steps to add borders 
and shading in the document.
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	Open the document in which borders have to be added. 

	Click on the Design tab.

	Locate the Page Background group and choose the Page Borders 
option.

	Select the Borders tab to add borders in the Borders and Shading dialog 
box. Users can choose the border settings, style, color, and width. Users 
can even select some predefined artwork from the Art dropdown box.

	Click on the Options buttons to choose the margins of the border, and 
whether or not to measure that from the edge of the page or the edge of 
the text. Click that for even more control over your border and shading 
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options.

	 Select the Shading tab in the Borders and Shading dialog box to choose 
the shading settings, style, and color.

	Click the OK button to apply the effect.

Inserting Watermark

A watermark is a message (usually a logo, stamp, or signature) superimposed 
onto an image, with a great deal of transparency. It is displayed as the background 
of the written document. The watermark appears in a light gray, large font, so 
it can be easily seen by readers of the document. Common watermarks include: 
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	Draft 

	Confidential 

	Do not edit 

	Do not copy 

	Sample 

	Urgent 

	A graphic, such as an organization's seal or logo 

Perform the following steps to insert the watermark in the document.

	Click on the Design tab.

	Locate the Page Background group and choose the Watermark option.

	Select any of the built-in watermarks from the drop-down menu to 
insert it into the document.

	MS Word places the watermark behind the text
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              Users can also create custom watermarks from text or images.

	Select the “Custom Watermark” option from the “Watermark” drop-
down menu. 

	Select the “Text Watermark” option in the Printed Watermark window 
that opens, Type the text you want to use into the “Text” box, and then 
configure the options for language, font, size, color, and orientation the 
way you want them. 

	Click on “OK” button.

Word inserts a custom text watermark behind the text. To use a picture as a 
watermark, select the “Picture Watermark” option and then click the “Select 
Picture” button. You can use a picture file on your computer, search for an image 
on Bing, or select an image from your OneDrive storage.

Header and Footer

Header and footer are areas that appear at the top and bottom of the page 
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where user can add additional text or graphics. Header and footer are used to 
add information such as the page number, creation date, document title, or the 
author's name which is required to appear on every page of a document. Perform 
the following steps to insert header and footer in the document.

	Click on the Insert tab.

	Locate the Header & Footer group and choose Header or footer. 

	Choose the predefined header or footer from the gallery.

	Word inserts the header or footer in the document. 

	Type the header or footer that you want to insert in the document.
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Inserting Page Number

Microsoft Word allows the user to add different styles of page numbers in the 
document. Page numbers can be used to automatically number each page in 
the document. Page numbers can be inserted in different formats and can be 
customized according to the needs. Page numbers are usually placed in the 
header, footer, or side margin. Perform the following steps to insert Page 
number in the document.

	Click on the Insert tab.

	Locate the Header & Footer group and choose Page number option. .

	A drop-down menu will appear which shows different options where 
the page numbers will appear such as Top of the page, Bottom of the 
page, and so on. 

	The last couple of options allows the user to format page numbers or 
remove page numbers from the document.
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	Select the desired option where you want to insert page number.

	The page number will appear on the every pages of the document.

9.2 	 Conceptualize Spreadsheet and Use Spreadsheet, Types of Spreadsheet 
Spreadsheet’s Interface Enter Data in a Worksheet – Labels, Values, 
Dates, and Formulas Edit and Format a Worksheet – Relative and 
Absolute Cell References, Formatting Values, Labels and Cells Add 
Charts Data Filter and sort data Work with Special features of 
spreadsheet – General Functions and Formulas

Spreadsheet software is an application software that is capable of displaying, 
storing, and analyzing data in tabular form that is in the form of rows and 
columns. Data in the spreadsheet is stored in cells.  It is a computerized version 
of an accounting worksheet that helps the user perform numerical functions like 
addition, and subtraction and effectively analyze data. The use of calculations 
and functionalities, automated calculations, and the use of conditional 
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expressions makes data handling work effective in spreadsheet software. The 
data can be stored in the form of text, numbers or in graphical form. Because of 
these capabilities, spreadsheet software has replaced many paper-based systems, 
especially in the business world.  Some of the examples of spreadsheet software 
are Microsoft Excel, Lotus 1-2-3, Gnumeric, Visi calc, Google sheets etc.

Features of Spreadsheet Software

There are various features of spreadsheet software. Some of the features of 
spreadsheet software are as follows:

	Spreadsheet software supports various built in functions for complex 
mathematical calculations and logical operations which make calculations 
easier, faster and more accurate.

	It supports a miniature programming language that can be written by using 
various inbuilt functions and syntax.

	Data in spreadsheet can be exported to or imported from other software or 
program.

	Data in spreadsheet software can be sorted and filtered which helps in the 
quick analysis of data. 

	Spreadsheet software automatically edits the result if any changes are made 
in any of the cells.

	The spreadsheet software allows cells, rows and columns to expand and merge, 
inserting cells in any part of the document and deleting unnecessary cells

	Data can be easily represented in pictorial from using different graphs or 
charts.

	Different validation rule can be applied to the cell which prevents the user 
from entering wrong data.

	Spreadsheet software supports the features of character formatting as the text 
entered can be converted into bold, italics as well as edit font size, font color 
and align the text in the cells. 

	Spreadsheet software can store and save large volume of data.
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Microsoft Excel

Microsoft Excel is a popular spreadsheet software which is developed by 
Microsoft Corporation. Microsoft Excel usually comes bundled with Microsoft 
Office and is compatible with other applications offered in the suite of products. 
It allows the user to organize and store data in the form of rows and columns.  
Columns are represented by alphabetical letters and rows are represented by 
numbers.  It contains different inbuilt functions which are used to perform 
mathematical and logical operations on the given data. There are many versions 
of MS-Excel like MS-Excel 98, 2000, 2003, 2007, 2010, 2013,2016, 2019  etc.

Microsoft Excel 2016

Microsoft Excel 2016 is one of the versions of MS Excel which is developed by 
Microsoft Corporation. It is one of the most popular spreadsheet applications 
and has become the default software to handle data, numbers, and graphs. It 
contains many new useful features as compared to its previous versions for 
creating quality documents. The extension of MS Excel is .xlsx.

Starting MS. Excel 2016

	Click on the MS Excel icon in the Taskbar.

                       Or

	Click on Start button and choose Search.

	Type "excel" in the search field.

	MS Excel will open, prompting you to select a theme. 

	Click on Blank workbook. The following  MS Excel window appears 
on the screen.
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The screen elements of MS Excel 2016 are:

The Ribbon

The Ribbon is the name given to the row of tabs and buttons that is seen at the top 
of Excel. The Ribbon is designed to help the user quickly locate the commands 
that is needed to perform the task. There are various commands that are collected 
together under Tabs. Each Tab relates to a type of activity, such as formatting or 
laying out a page, inserting formula etc. There are some tabs in the ribbon which 
are shown only when it is required. 

Quick Access Toolbar

The Quick Access Toolbar, which is located at the top left corner of the screen 
above the Ribbon is used to  provide quick access to commonly used features 
and commands, such as Save and Undo/Redo. Quick Access Toolbar can be 
customized according to the user’s choice. 
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Tell Me what you want to do

It is a new feature added in Office 2016 in which user enter words and phrases 
about what to do next and will quickly get the features which they want to use or 
actions they want to perform. Tell Me can be used to find help about what user 
is looking for and to use Smart Lookup to research or define the term entered. 

Formula Bar

Formula bar is a section in MS Excel which shows the contents of the current 
cell and allows to type and view formulas.

Expand Formula Bar Button

It allows the user to expand the formula bar which is useful when the user have 
to deal with long formula or have to type long text in a cell.

Worksheet Navigation Tabs

Worksheet Navigation Tab shows the number of worksheet in each workbook. In 
MS Excel 2016 by default, every workbook starts with one work sheet but user 
can create many worksheets according to the need.  

Insert Worksheet Button

Insert Worksheet button is used to insert new worksheet in the workbook.

Horizontal/Vertical Scroll bar 

It allows to scroll the worksheet horizontally/ vertically. Scroll bars can be 
hidden or done unhide according to the requirement.

Normal View

This is the “normal view” for working on a spreadsheet in Excel. Page. It is the 
default view of the Excel sheet.

Layout View

In the Layout View document will appear as if on the printed page.
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Page Break Preview

It views a preview of where pages will break when the document is printed.

Zoom Level

It is present at the bottom right corner which allows you to quickly zoom in or 
zoom out of the worksheet.

File menu

File tab displays the backstage view which contains the basic required options 
such as Info, New, Open, Save, Save as, Print, Share, Export, and Close options.

Basic Fundamentals of Spreadsheet

Columns

Columns run vertically downward across the worksheet and ranges from A to 
XFD. A column is identified by a column header that is on the top of the column, 
from where the column originates. There are 16384 columns in a worksheet 
which are named as A, B C ……… 

Rows

Rows run horizontally across the worksheet and range from 1 to 1048576. A 
row is identified by the number that is on the left side of the row, from where 
the row originates. There are 1048576 rows in a worksheet which are named as 
1,2,3………………….

Cell

The cell is the small rectangular box that is present in the worksheet.  A cell is the 
smallest unit used to store data and information. It is formed by the intersection 
of rows and columns. Every cell in the worksheet is identified or named by 
column header followed by row number, for example, A1, B6, F11, etc. Every 
worksheet contains 16,777,216 individual cells. 

Active Cell

The cell that is active in the worksheet is called an active cell.  It is the current 
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position of the cell pointer. An active cell is a selected cell in which data is 
entered when you begin typing. Only one cell is active at a time.

Name Box/Address Bar

The Name box also known as the address bar is located at the left end of the 
formula box. The various uses of the Name box are as follows :

	It displays the address of the active cell such as A1, B1, N5, etc.

	It displays the name of the cell, range, or object selected if this has been 
named.

	It can be used to name a cell, range, or object like a chart.

	It can be used to go to any address you type into it.

	It contains a drop-down list of all named cells and ranges and can be 
used to go to any of them.

Cell Address

Every cell in MS Excel is identified by its unique address known as cell address. 
A cell address is made up of the column letter followed by the row number. For 
example, the cell that is the intersection of column "B" with row "2" has a unique 
cell address of "B2". The Name box in the top left corner always displays the 
address of the active cell.

Fill Handle

The fill handle is located in the bottom right corner of the selected cells. It is used 
as Excel’s Fill Series feature as it takes a starting value, such as 1 or 1/1/2016, 
and fills in a range that the user specifies with the next values that it expects in 
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the series. For example, a linear fill starting with 1 would fill in the next 5 cells 
with 2, 3, 4, 5, and 6.

Cell Range

In MS Excel, a range is a collection of cells. A range can be two or more cells 
and the cells don't need to be adjacent to each other. The different types of ranges 
in MS Excel are

Vertical Range

The following example shows the vertical range from A2:A5. If a user had 
selected the entire column A, the range would be A: A.

Horizontal Range

The following examples show the horizontal range from A2:C2. If a user had 
selected the entire row 2, the range would be 2:2.
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Mixed Range

The following example shows the mixed range from A2:C5. This is a collection 
of cells that can be from multiple rows and columns.

Multiple Selection Range

Following example shows the multiple selection range from A2:A3, B4:B5. This 
is a collection of cells that does not have to be adjacent.

Each range has its own set of coordinates or position in the worksheet such as 
A2:A5, A2:C2, A2:C5, and so on.

Workbook

A workbook is the name given to an Excel file. A workbook can contain one or 
more different worksheets that can be accessed through the tabs at the bottom 
of the worksheet. User can easily add worksheet in the workbook according to 
their requirement. 

Worksheet

A worksheet is a collection of cells user keeps and manipulate the data. Each 
Excel workbook can contain multiple worksheets. The name of the worksheet 
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appears on the worksheet navigation tab at the bottom of the document window 
with name Sheet1, Sheet2 Sheet3 and so on. User can give the desired name 
of the worksheet according to their requirement. Every worksheet has 16,384 
columns (A - XFD) and 1,048,576 rows. This means that every worksheet 
contains 16,777,216 individual cells. This cannot be changed.

Template

A template is a predesigned spreadsheet that can be used to create a new 
workbook quickly. Templates often include custom formatting and predefined 
formulas, so they can save a lot of time and effort when starting a new project.

Creating New Workbook 

	In MS Excel 2016, every workbook contains at least one worksheet by 
default. Perform the following steps to create workbook.

	Click on the File Tab.

	Click on the New option from the Backstage view.

	Click on Blank worksheet or select the required templates.

	A new blank workbook will appear.
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Entering Data, Cell manage, Concept of Cell Reference

Entering Data

Entering data into Excel worksheets is actually fairly simple.  Perform the 
following steps to enter data in the cell.

	Position the cell pointer in the cell where you want the data to be entered.

	Type the text or character.

	As user continue to type, Excel displays the progress on the Formula bar and 
in the active cell in the worksheet. 

	The insertion point (the flashing vertical bar that acts as your cursor) appears 
only at the end of the characters displayed in the cell.

	Press the Right Arrow or Enter key. Pressing Right Arrow key will enter the 
word into cell A1 and activate the next cell to the right whereas Pressing Enter 
key will enter the word into cell A1 and activate the lower cell.

Editing Data

Data that has been entered in a cell can be changed by double-clicking on the cell 
location using the Formula Bar or by pressing the F2 key on keyboard.

a.	 Move the cursor to cell.

b.	 Press F2 key and change the data

                                OR

a)	 Click on cell.
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b)	 Click on formula bar and change it.

                              OR

Double click on the particular cell and change the data.

Cell manage

Changing Row Height and Column Width

The text entered in the cell may appear cutoff  if the size of the text is large. The 
columns and rows on the Excel worksheet can be adjusted to accommodate the 
data that is being entered into the cell. Perform the following steps to adjust the 
column width or row height or automatically resize columns and rows to fit the 
data.

	Place the mouse pointer in between columns or rows that you want to 
adjust the height. The white box plus signs turns into double arrows.

	Click and drag the row or column to the right.

	Release the left button.

	The height of whole row or column will be adjusted.
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The above Click and Drag method is inefficient if user needs to set a specific 
character width for one or more columns.  

Resize Rows

	Select a row or a range of rows.

	Click on the Home tab.

	Locate Cells group and click on Format options. 

	Select Row Height.
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	Type the row height and click OK.

Resize Columns

Select a column or a range of columns.

	Click on the Home tab.

	Click Format in the Cells group and select Column Width.
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	 Type the column width and click OK.

Automatically Resize all Columns and Rows to fit the Data 

	Click the Select All button at the top of the worksheet, to select all 
columns and rows.

	Double-click a boundary. All columns or rows resize to fit the data.

Inserting Cells/Deleting Cells

User can easily insert column, row, and new worksheet on worksheet as well as 
delete row, column, worksheet and format worksheet.

Insert Column

	Place the cursor where you want to insert column.

	Click on Home Tab.

	Locate the Cells group and click on Insert options.

	Click on Insert Sheet column option.
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Insert Row

Place the cursor where you want to insert row.

Click on Home Tab.

	Locate the Cells group and click on Insert options

	Click on Insert Sheet Row option.

Insert New Worksheet

	Click on Home Tab.

	Locate the Cells group and click on Insert options.
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	Click on Insert Sheet option.

Delete Row and Column

	Place the cursor where you want to delete.

	Click on Home Tab.

	Locate the Cells group and click on Delete option.

	Select the appropriate options to delete cells, row, column, and 
worksheet.

Concept of Cell Reference

Every cell in the spreadsheet is identified by the unique name or address known 
as cell address or cell reference. A cell reference refers to the value of a different 
cell or cell range on the current worksheet or a different worksheet within the 
spreadsheet. A cell reference works as a variable in a formula which holds or 
represent the value stored in the cell. An example of single cell reference is A1 
and example of a range of cells reference is A1:A5. The first example refers 
to the content of cell A1 only and the second example refers to the contents of 
cells A1, A2, A3, A4 and A5. There are three types of cell reference.

Relative Cell Reference

Relative cell reference is the default cell reference of MS Excel. The cell reference 
which changes on the relative position of columns and rows when copied across 
multiple cells, is called relative cell references.  For example, if user copy 



204 Veterinary Extension and computer science

the formula =B2*C2 from row 2 to row 5, the formula will become =B3*C3, 
=B4*C4 and =B5*C5.  Relative references are especially convenient whenever 
you need to repeat the same calculation across multiple rows or columns.

Absolute Cell Reference

There may be times when user do not want a cell reference to change when 
filling cells. The cell reference which does not changes on the relative position 
of columns and rows when copied across multiple cells is called absolute cell 
references.  An absolute reference is designated by the addition of a dollar sign 
($) before the column and row. For example, if user copy the formula =D2*$C$6 
from row 2 to row 5, the formula will become =D3*$C$6, =D4*$C$6 and 
=D5*$C$6. The value stored in the cell C6 that is 13% is same in all the 
formula that is used to calculate Net tax.
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Formatting Worksheet

User can help improve the readability of a worksheet by applying different types 
of formatting. User can change the apply borders and shading to help define the 
cells in a worksheet.

Formatting Text

Formatting text or numbers can make them appear more visible especially 
when there are large data in the worksheet. Changing default formats includes 
things like changing the font color, style, size, text alignment in a cell, or apply 
formatting effects. 

Changing Font Color, Size

User can change the font color, type and size of the text. Perform the following 
steps to change the font color, type and size of the text.

	Click on the home tab.
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	Locate the font group  

•	 For a different font style, click the arrow next to the default font Calibri 
and pick the style you want. 

•	 To increase or decrease the font size, click the arrow next to the default 
size 11 and pick another text size.

•	 To make text or numbers in a cell to appear bold, italic, or have a 
single or double underline, select the cell and on the Home tab, pick the 
format you want.
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•	 To change the font color, click Font Color and pick a color.

•	 To apply strikethrough, superscript, or subscript formatting, click the 
Dialog Box Launcher, and select an option under Effects.
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Creating and Working with Charts

It can be difficult to interpret Excel workbooks that contain a lot of data. Charts 
allow the user to illustrate the workbook data graphically, which makes it easy 
to visualize comparisons and trends. A chart should be chosen in such a way 
that it allows the user to grasp the information conveyed via it in a simple and 
easier way than looking at just a table of data. It is often used to represent a large 
amount of data or parts of data. Perform the following steps to create chart.

	Select the cells including the column titles and row labels. These cells 
will be the source data for the chart.

	Click on the Insert tab.
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	Locate the Charts group and select the desired chart category or select 
the desired chart type from the drop-down arrow.

	The chart will appear in the worksheet.

	Click on the Chart Elements icon to add, remove or change chart 
elements such as title, legends, gridlines, and data labels.
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	Click on Chart Styles or Design tab to set style and colour scheme for 
the chart.

	Click on Chart Filters to edit the data points and names that are visible 
on the chart. 

Managing Workbooks

Worksheet is single page spreadsheet or page in Excel, where user can store, 
edit and manipulate data.  The collection of such worksheets is referred as a 
workbook. User can create more than one worksheet in workbook. The default 
name of the worksheet is "Sheet1" and user can rename the name of the worksheet 
according to their needs. 

Creating an Empty Workbook

MS Excel automatically creates a new empty workbook with name Book1 when 
the Excel program is opened. User can create another blank workbook in the 
following ways.

	Press Ctrl+N 

                   Or

	Click on the File tab.

	Choose New option and select Blank Workbook.
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The default name of the worksheet that is created is  "Sheet1".

Insert Additional Worksheets

User can insert worksheets according to their needs. Perform the following steps 
to insert worksheet.

	Click on the Home tab 

	Locate the Cells group and click Insert option.

	Select Insert Sheet option from the drop down menu. Excel automatically 
inserts a new blank worksheet on top of the currently selected sheet. 
Excel automatically assigns the next number such as Sheet2. Or

	Click on the  "+" image next to the sheet1 at the bottom of the worksheet.

	A new sheet is created with the next numerical value in the name. The 
first sheet's default name is "Sheet1." When you create a new sheet, the 
next sheet name is "Sheet2."

Rename Worksheet

By default, Excel names worksheets as Sheet1, Sheet2, Sheet3 and so on, but user 
can easily rename them. Perform the following steps to rename the worksheet.

	Double-click the sheet tab, and type the new name. Or,

	Right-click the sheet tab.
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	Click Rename option, and type the new name.

                          Or

	Use the keyboard shortcut Alt+H + O + R, and type the new name.

Working with Workbook Templates

A template is a predesigned spreadsheet that user can use to create new 
spreadsheets with the same formatting and predefined formulas. With templates, 
user don't need to know how to do the math, or even how to write formulas as 
these are already integrated into the spreadsheet. Use of templates can save a lot 
of time. Templates are especially valuable for frequently used document types 
such as Excel calendars, budget planners, invoices, inventories and dashboards. 
User can also download several more templates from the Internet and can also 
create own templates from scratch or from an existing workbook. MS Excel 
provides a number of templates to make work easier. Perform the following 
steps to use the existing templates.

	Click the File tab 

	Click on New options. You can then see the templates just as you did 
on the start screen.

	Choose the template that you want to use by clicking on it.



213Animal Science (Grade 9)

	Click the Create button to create the template. Excel will load the 
template.

	User can also search for template from the Internet by typing on the 
box displayed at the top of the screen of File->New option.

Save Workbook as a Template

MS Excel also provides the facility of saving the user created workbook as the 
templates so that the same templates can be used to create more workbooks 
instead of starting from scratch. Perform the following steps to save the workbook 
as a template.

	Click on the File tab.

	 Click on Save option.

	Enter the name for the template in the File name box and select Excel 
Template in the Save as type drop-down list.

	Click on Save button.

	Excel saves templates with an .xltx file extension.
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General Functions and Formulas

Function

A function is a predefined formula that performs calculations using specific 
values in a particular order. All spreadsheet programs include common functions 
that can be used for quickly finding the sum, average, count, maximum value, 
and minimum value for a range of cells. The main advantages of using functions 
are it saves time because user do not have to write the formula theMSelves and 
the long formulas can easily be replaced by using functions. User can find all 
available Excel functions in the Function Library on the Formulas tab.

Formula

A formula is an expression which calculates the value of a cell. Formulas are 
written to perform mathematical calculations and logical operations on the given 
data. 

Arguments

Arguments in formula refers to both individual cells and cell ranges and must 
be enclosed within parenthesis. User can include one argument or multiple 
arguments, depending on the syntax required for the function. For example, the 
function =SUM(A1:A10) will return the sum of all the values in the cell range 
from a1:A10. This function contains only one argument.

Functions in MS Excel

The basic functions used in MS Excel are

SUM

This function is used to  add all of the values of the cells in the argument.
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Syntax: SUM(number 1,[number 2]……..)

AVERAGE

This function is used to determine the average of the values included in the 
argument. It calculates the sum of the cells and then divides that value by the 
number of cells in the argument.

Syntax: AVERAGE(number 1,[number 2]……..))

COUNT

This function counts the number of cells with numerical data in the argument. 
This function is useful for quickly counting items in a cell range.

Syntax: =COUNT(number 1,[number 2]…..))

MAX

This function determines the highest cell value included in the argument.

Syntax: =MAX(number 1,[number 2]…..) 

MIN

This function determines the lowest cell value included in the argument.

Syntax: =MIN((number 1,[number 2]…..)

IF

This function returns one value if the condition is TRUE, or another value if the 
condition is FALSE.

Syntax: =IF(Logical test,[Value if true],[Value if false])

SUMIF

This function adds all the values in a range of cells that meet a specified criteria.

Syntax: =SUMIF(range,criteria,[average_range])

LEN

This function returns the number of characters in a string text.

Syntax: =LEN(Text)
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AVERAGEIF

This function calculates the average value in a range of cells that meet the 
specified criteria.

Syntax: =AVERAGEIF(range,criteria,[average_range])

CONCAT

This function joins together two or more text strings.

Syntax: CONCAT ( input_string1, input_string2 [, input_stringN ] )

LEFT

This function returns a specified number of characters from the start of a supplied 
text string.

Syntax: =LEFT(input string)

RIGHT

This function  returns a specified number of characters from the end of a supplied 
text string.

Syntax: =RIGHT(input string)

MID

This function  returns a specified number of characters from the middle of a 
supplied text string.

Syntax: =MID(input string)

Example :

Extra Charge IF(C6<=100,0,(C6-100)*2)

Total D6+E6

VAT 13%*F6

Tax 11%*F6

Net Amount F6+G6+H6
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ABC	 Telecom

Kathmandu, Nepal

SN
Customer 

Name

Total 

Call

Rental 

Charge

Extra 

Charge
Total VAT Tax

Net 

Amount

1 Sarita 167 200 134 334 43.42 36.74 414.16

2 Babita 88 200 0 200 26 22 248

3 Ramita 269 200 338 538 69.94 59.18 667.12

4 Kanaya 89 200 0 200 26 22 248

5 Nrinju 234 200 268 468 60.84 51.48 580.32

6 prakrity 512 200 824 1024 133.12 112.64 1269.76

7 Heena 345 200 490 690 89.7 75.9 855.6

8 Daisy 100 200 0 200 26 22 248

9 Nanu 172 200 144 344 44.72 37.84 426.56

10 Jinny 299 200 398 598 77.74 65.78 741.52

TOTAL MARKS =SUM(C8:G8)

RESULT

IF(MIN(C8:G8)>=40,"PASS","FAIL") 

                  OR

=IF(AND(C8>=40,D8>=40,E8>=0,F8>=40
,G8>=40), “PASS”, “FAIL”)

PERCENTAGE IF(I8="PASS",H8/5, “  ” )

DIVISION
=IF(J8>=75,"dis t inc t ion" , IF(J8>=60,"1s t 
division",IF(J8>=40,"2nd division",IF (J8>=35, “3 
rd division”,"fail"))))

RANK =IF(I8="pass",RANK(J8,J$8:J$17,0),"")

Average Marks =AVERAGE(C8:C17)

Highest Marks =MAX(C8:C17)

Lowest Marks =MIN(C8:C17)
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Data filter and sorting

Sorting

Sorting is the process of arranging the records either in ascending or descending 
order. The main advantages of sorting data is it helps to search the record fast. 
Sorting data in MS Excel rearranges the rows based on the contents of a particular 
column. Perform the following steps to sort the record.

	Select the cells that is to be sorted.

	Click on Home tab.
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	Locate the Editing group and select Sort & Filter option.

	Click the Sort A to Z option to sort the record in ascending order and 
the Sort Z to A option to sort the record in descending order.

Sorting Multiple Levels

	Select the cells that is to be sorted.

	Click on Home tab.

	 Locate the Editing group and  select Sort & Filter option.

	Click on Custom Sort option.

	Click on Add level button to add category to sort by.

	Click on Order button and select either A to Z or Z to A option.

	Click on OK button.
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Filtering

Filtering is the process of extracting only the necessary records according to the 
criteria given by the user. Filtering is the quick way to display only the information 
relevant at a given time and remove all other data from view. Microsoft Excel 
makes it easy for the user to narrow down the search with a simple yet powerful 
Filter tool. User can filter rows in Excel worksheets by value, by format and by 
criteria. After applying a filter, user can copy, edit, chart or print only visible 
rows without rearranging the entire list.

 Perform the following steps to filter the record.

	Select the cells that is to be filtered.

	Click on Home tab.

	Locate the Editing group and select Sort & Filter option.

	Click on Filter option.

	Column headings now have an arrow next to the heading name. Click 
on the arrow next to the heading with which you want to filter, and you 
will see a list of all the unique values in that column. 

	Check the box next to the criteria you wish to match and click OK. 

	Click on the arrow next to another heading to further filter the data.
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Printing Worksheets

When user have finished creating the worksheets in the workbook, it may be 
necessary to print them out.  Printing in MS Excel is very easy. Perform the 
following steps to print the worksheets.

	Click on the File tab.

	Click on Print option.

 	Specify the desired option under Setting.

	Click on Print option to print the worksheet.
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9.3 	 Present Program Basics, Present Program’s Interface, Create a 
Presentation Format Slides, Special Features of Presentation Programs 
– Transition, Animation and Custom Animation Work with Tables, 
Graphics, Word ART, Graphs, Organization Charts and Multimedia 
Integrate Multiple Data Sources in a Presentation Present Slide Shows 

A presentation is a systematic way of displaying information. Presentation 
software is defined as the software programs that is designed to allow the user 
to present information in an effective way by integrating different components 
such as text, pictures, sound, animation and video. It is very useful for business, 
education and training center to present the information in more interesting and 
attractive way. Some of the examples of presentation software are Microsoft 
Power point, OpenOffice.org impress, powerdot, magic point, keynote etc.

Features of Presentation Software

The different features of presentation software are

	Colors and fonts of the text, appearance and format of the slides can be 
changed which make presentation snazzy and will catch the eye of audience.

	Text, images, video, animations, links and sound can be combined on each 
slide to create a sophisticated final product.

	Transition animations that can be added between slides, which engage the 
audience and allow them to feel more involved with the presentation.

	It allows to create, edit and import charts and graphs. 

	Slides can be printed according to the requirement.

	It provides screen recording facility through which user can record the 
computer screen and related audio before inserting them in the slide.

Microsoft Power Point

Microsoft Power point is a powerful presentation software which was developed 
by Microsoft. MS Power point is the component of Microsoft Office suite 
software, and comes together with MS Word, MS Excel and other Office 
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productivity tools in the single package. It uses slides to deliver information 
by combining multimedia components and is effective to create business 
presentations, educational outlines and much more. There are many versions of MS 
Power point such as MS-Power point 2000, 2003, 2007, 2010,, 2016, 2019  etc. 

MS Power Point 2016

MS Power point 2016 is one of the versions of Microsoft which allows users to 
create media-rich presentations constituted by a series of slides. Since it is fully 
integrated with the other tools of the Microsoft Office suite, the user can import 
content created with Excel or Word into Power Point, as well as other media 
such as pictures, audio, and video clips. It contains many new useful features as 
compared to its previous versions for creating quality documents. The extension 
of MS –Power point is .pptx.

Starting MS Power Point

	Click on the Power point icon in the Taskbar.

                       Or

	Click on Start button and choose Search.

	Type "powerpnt" in the search field.

	Power point will open, prompting you to select a theme. 

	Click on Blank Presentation. The following Power point window 
appears on the screen.
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Components of a Power Point Window

Title Bar

It is used to display the name of the presentation and the name of the program. 
Minimize, maximize, restore down and close window control buttons are 
grouped on the right side of the title bar.

Quick Access Toolbar

The quick access toolbar at the left end of the title bar can be customized to 
include any commands that you want to have easily available. It is used to display 
buttons to perform frequently used commands such as Save ,undo , repeat with a 
single click  . User can add additional buttons to the quick access toolbar .



225Animal Science (Grade 9)

Ribbon

The ribbon is located below the title bar .Ribbon is used to organize commands 
on tabs and group them by topics for performing related presentation tasks.

File Tab

It is used to display the lists of commands that user can perform with a presentation 
such as opening , saving , printing , or sharing .
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Slide Tab/Outline Pane

It is used to display the presentation text in the form of an outline. Outline tab is 
used to organize and develop the content of your presentation. This tab enables 
you to move slides and text by dragging selected material. Slide tab displays the 
slides of your presentation as small miniature images called thumbnails.This 
view allows easy navigation through slides.
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Slide Pane

Slide pane contains the current slide in your presentation. You can use the 
vertical scroll bar to view other slides in the presentation.

Notes pane

Note pane is located below the slide pane and is used to type reference notes. 
The notes can be printed, then referenced when making the presentation.

Status Bar

It is a horizontal bar that is located at the bottom of the presentation windows 
which displays the current slide number, number of slides in a presentation, 
theme name ,view buttons , and zoom slider.

View Area

View area is located at the right hand bottom of the screen. It contains buttons 
that allow the ability to switch between Power point views. The first view button 
allows you to view slides in normal view, the second is called the slide sorter 
view, the third is called the reader view and the fourth is called the slide show 
view. This area also contains the zoom feature.

Slide

A slide is a single screen of a presentation, and every presentation is composed 
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of several slides. A slide is like a bank page on which the information is stored 
in the form of text, picture, sound, video etc. There are different types of slide 
available in the program, and user can select and design document or presentations 
according to their needs.

Slide Title

It is the title given to the slide which contains the information stored on it.

Slide Text

It is subtitle given to the slide which contains the information stored on it.

Create Presentation Slides

	Select the File tab.

	Click on New option from Backstage view.

	Click Blank Presentation or select suitable templates or use the search 
bar to find something more specific.
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Create a Presentation Format Slides 

A theme is a predefined combination of colors, fonts, and effects. Each theme 
uses its own set of slide layouts. In Power point, themes give you a quick and 
easy way to change the design of your presentation. They control your primary 
colour palette, basic fonts, slide layout, and other important elements. All of the 
elements of a theme will work well together, which means you won't have to 
spend as much time formatting your presentation. Perform the following steps to 
change the theme of the presentation.

	Clicking on the Design tab 

	Locate the Themes group and move the mouse over the different images 
which will show what design would look like on the slides.

	Click on the design image to apply it.

	Click the More drop-down arrow to see all available themes.
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	Click on Format Background to change the background color of the 
design.

	Click on the  More button in the  Variant group to change 
Colors, Fonts, Effects, and Background Styles in the slide.
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Formatting and Styles to Text

The appearance of text makes a huge difference to any presentation. The font 
typeface used within the slides is activated by the active Theme or Theme Fonts 
set of the presentation. User can change the default font type face and font size 
of the text. User can also change the font styling attributes such as bold, italics, 
underline, etc. add shadows, and even strike through any selected text. User 
can also change the text direction, and set how the text aligns relative to the 
placeholder, top, middle or bottom and can even convert text to SmartArt. User 
can also apply bullets and numbering to the text. 

Changing Font Style Attributes

Perform the following steps to change the font style attributes.

	Select the text that is to be formatted.

	Click on the Home tab.

	Locate the Font group and click B, I, U button to make the text bold, 
italic and underline.

Changing Font Type Face and Font SIze

Perform the following steps to change the font type face and font size. 

	Select the text that is to be formatted.

	Click on the Home tab.

	Locate the Font group select a font in the Font list and size from the 
font size.
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Changing alignment of text

Perform the following steps to change the alignment of the text.

	Select the text that is to be formatted.

	Click on the Home tab.

	Locate the Paragraph group select Align Left or Center or Align Right 
or Justify according to the requirement. 

Inserting bullets and numbering

Perform the following steps to insert bullets and numbering in the text.

	Select the text that is to be formatted.

	Click on the Home tab.

	Locate the Paragraph group select appropriate bullets and numbering 
in the list.
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Animation and Custom Animation

Animation is simply the process of making an object move. Slide objects can 
be anything on a slide which include text, pictures, charts, SmartArt graphics, 
shapes, even movie clips. Animation effects in Power point provide smooth 
visual transitions between different states of the presentation by moving objects 
in place or around the slide canvas. Animation makes the viewing experience 
engaging and dynamic. Animation is also used to draw viewers’ attention to 
the key points and therefore express ideas in a more memorable way. There 
are plenty of animations in Microsoft Power point that can be applied to text, 
shapes or pictures. Some of the most commonly used effects are: Appear, Fade 
in, Fly in, etc. Sometimes our imagination goes beyond standard Power point 
animations, so we need to create a more complex, unique animation that no other 
presentation contains. Power point provides four types of animations such as 
Entrance, Emphasis, Exit, and Motion Paths. An Entrance animation determines 
the manner in which an object appears on a slide, for example, an object can 
move onto a slide. An Emphasis animation does something to draw attention 
to an object, for example, the object can become larger. An Exit animation 
determines the manner in which an object leaves a slide, for example, an object 
can move off a slide. A Motion Paths animation determines how an object moves 
around a slide, for example, an object can move from left to right.

Perform the following steps to add animation in the slides.

	Select the text or object you need to animate

	Click on the Animations tab.

	Locate the Advanced Animation group and click Add Animation.

	Select an animation effect from the list.
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	 Click on Slide Show tab to view the animation.

Custom Animation

After adding animation, user can use Custom Animation pane to modify it 
by choosing an effect. A single object on a Power point slide may have many 
animation effects applied at the same time. Adjusting the settings for each effect 
will create a combination that most likely will be a unique one. Power point 
has a toolbar called Animation Pane that gives user the total control over the 
animations on a slide. This makes creating sophisticated animations very easy 
with only a few clicks. Perform the following steps to choose an effect.

	Select the object that is to be animated.

	Click on Animation tab.
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	Locate the Advanced Animation group and click the Animation Pane 
button. The Animation Pane opens on the right side of the window.

	Select the down arrow next to the effect you want to modify. From here, 
change when the animation starts, the effect options, and the timing.

	To change when the animation will start, select one of the following.

o	 Start On click: Starts the animation on the mouse click.

•	 Start With Previous: Start the animation at the same time as the 
previous animation (could be another animation on this slide or the 
slide transition of this slide).

•	  Start After Previous: Starts the animation when the previous animation 
or transition has finished.

	Select Effect Options to choose custom options, such as sounds and 
directions.

	Select Timing to choose custom timing settings, such as delay, duration, 
or repeat.

	Modify the options for each effect that you have applied to the object.

Special Features of Presentation Programs 

Transition of Presentation

A slide transition is how one slide is removed from the screen and the next 
slide is displayed during a presentation. A slide transition is the visual effect that 
occurs when the user moves from one slide to the next during a presentation. 
Users can control the speed, add sound, and customize the look of transition 
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effects. The Transitions tab consists of three groups of controls, as described in 
the following list:

Preview: This group includes a single control Preview that displays a preview of 
the transition effect the user selected for the current slide.

Transition to This Slide: This group lets the user select the transition effect that 
will be used when the presentation moves to this slide.

Timing: This group lets users select options that affect how the transition effect 
is applied to the slide, such as how quickly the transition occurs and whether 
it’s triggered by a mouse click or automatically after a time delay. Perform the 
following steps to add transition.

	Select the slide you want to add a transition to.

	Select the Transitions tab.

	Locate the Transition to This Slide group and select the type of transition 
such as Cut, Fade, Push, etc.

	Click on the More button to view other transition options.
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	Select Effect Options to choose the direction and nature of the transition.

	Select Preview to see what the transition looks like.

Working with Tables, Graphics, and Word Art

Tables

A table is a combination of rows and columns. Tables are useful to display the 
data and information in a tabular form. Users can even customize tables to fit in 
the presentation. Perform the following steps to insert a table in the slide.

	Click the Insert tab.

	Locate the Tables group and click the Table option.

	The table can be inserted in either of the three ways.

•	 Hover the mouse over the grid of squares to select the desired number 
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of columns and rows in the table. 

Or

•	 Click on Insert Table and choose the number of rows and columns.

•	 Click on Draw Table and draw the required table.

	Click on the Design tab and choose Table Styles to make a variety of 
changes to a table.
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.	Click on the Layout tab to change the layout of the table.

Graphics

Graphics generally refer to pictures and images. A picture speaks more than 
thousands of words. So adding pictures to the slides makes the presentations 
more interesting, eye-catching, and engaging. A picture can be inserted from 
the computer’s hard disk file onto any slide. Powerpoint even includes tools for 
finding online pictures and adding screenshots to the presentation. Perform the 
following steps to insert Graphics in the slides.

	Click on the Insert tab.

	Locate the Images group and click the Pictures option.

	 Select the image file from the hard disk and then click the Insert 
button.
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	Click the Online Pictures command to insert online pictures.

	Click on the Screenshot command to insert a screenshot of the active 
window.

Word Art

Microsoft has integrated WordArt into PowerPoint so users can apply this text 
format to the presentation text blocks. It helps in providing special effects like 
outlines, gradient glow, shadow, bevel, textures, and 3-D effects to the text, 
effects which are unavailable in the standard font formatting tools. Perform the 
following steps to insert word art in the slides.

	Click on the slide where you want to insert wordart.

	 Click on the Format tab.

	Locate the WordArt Styles group.

	Click the More drop-down arrow in the WordArt Styles group.

	Select the style to use.

	The text will appear in the selected style. If desired, you can change the 
font or font color from the Home tab.
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	To add or modify text effects click On the Format tab and choose the 
Text Effects command in the WordArt Styles group.

	Click the Text Fill and Text Outline drop-down boxes to modify the 
fill and outline color.

Working with Graphs and Organization Chart

Inserting Graph

The graph makes perfect sense and it makes easier to draw conclusions and 
perform comparison and analysis on the given data. Users can also insert graphs 
in the presentation. Perform the following steps to insert the graph in the slide. 

	Click on the Insert tab. 

	Locate the Illustrations group and select the Chart option.
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	Click the chart type and then double-click the chart you want.

	In the worksheet that appears, replace the placeholder data with your 
information.

SmartArt

SmartArt is one of the features in PowerPoint used to build interactive 
charts. SmartArt window consists of a variety of chart types that work well 
as organizational charts. An organizational chart is a graphic that shows the 
reporting structure of a company. Perform the following steps to insert SmartArt 
in the slide.

	Click on the Insert tab.
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	 Locate the Illustrations group and select the SmartArt option.

	Select the Hierarchy category to browse the choices that work best as 
organizational charts.

	Select the desired chart and click on the Ok button.

	Type in the text box on the left side in outline form boxes to fill out the 
PowerPoint organizational chart template.
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Exercise

Write short answer to the following questions.
1.	 What is word processing software? Write the features of word processing 

software.

2.	 What is spreadsheet software? Write the features of spreadsheet software.

3.	 What is cell reference? Explain the different types of cell reference.

4.	 What is presentation software? Write the features of presentation software.

5.	 What is DBMS? Write the features of DBMS software.

6.	 What are specific tools? Explain any two domain-specific tools.

7.	 Differentiate between word processing, spreadsheet, and presentation 
software.

8.	 Write short notes on:

a.	 Desktop publishing software 

b.	 Text editor

c.	 Mail merge

d.	 Animation 

Practical on MS Word

Type the following paragraph and do the activities that follow.

Application Software

Software that is specially designed for the end users to solve specific tasks is called 
application software. Application package software, or simply an application 
package, is a collection of software programs that are used by the end users to 
solve day-to-day tasks.  Microsoft Office also referred to as Office Package is 
an application package that is designed specifically to be used for official and 
business use. It is a proprietary product of Microsoft Corporation and was first 
released in 1990. Microsoft Office is a collection of office-related applications 
and each application serves a unique purpose and offers a specific service to its 



245Animal Science (Grade 9)

users. Microsoft Office consists of different programs like MS Word, MS Excel, 
MS PowerPoint, MS Access, MS Outlook,  MS Project, and MS Onenote. 

a.	 Paragraph font size and font type must be 12 Times New Roman.

b.	 Paragraph alignment must be justified and double line spacing.

c.	 Drop Cap the first letter of “S”.

d.	 Highlight the word “Office Package” with green color.

e.	 Make the heading “Application Software” bold and italic.

f.	 Insert any text using “WordArt” in the document. 

g.	 Insert any image related to software in the document.

h.	 Add the following lines to your document

	 MS Word

	 MS Excel

	MS Powerpoint

	MS Access

1.	 Design a visiting card for your college principal mentioning the Name of 
your college, address, his/her name, email ID, contact number, etc.

2.	 Design the format of your class routine specifying days, periods, times, 
names of different subjects, and names of subject teachers inserting a table.

3.	 Design the attractive vacancy announcement advertisement asking for the 
post of teachers to teach different subjects for your college.

4.	 Design a sample of the newspaper by writing the news in three columns.

5.	 Design an invitation card for the annual day program of your college. Fill 
in the data in the invitation card by using mail merge. The data to be filled 
is the Name and Address of 25 parents.

Lab assignment on MS Excel
1. 	 Create a workbook that stores all the information of the terminal 

examinations of your class and prepare a result sheet by applying different 
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formulas. The result sheet should contain:

a.	 Total marks of each student.

b.	 Percentage secured of only passed students.

c.	 Result of each student i.e. pass or fail.

d.	 Division of passed students.

e.	 Rank of passed students.

2.	 a.Create a salary sheet of an organization with field names such as S.no, 
Name, Basic salary, Service year, Monthly allowance, Daily allowance, 
Provident fund,  Monthly salary, Yearly Salary, Monthly tax, Yearly tax, 
and Net yearly income.

b. 	 Insert 10 data under the fields S.no, Name, Basic Salary, and Service Year.

c. 	 Calculate Monthly allowance according to the following condition.

	 If the service year is greater than 10 years, 10% of the Basic Salary, 
if the service year is greater than 5 years, 5% of the Basic Salary, 
otherwise 0.

d. 	 Calculate Daily allowance according to the following condition.

	 If the service year is greater than 8 years, 10% of the Basic Salary, if the 
service year is greater than 3 years,5 %of the Basic Salary, otherwise 
1% of the Basic Salary.

e. 	 Calculate Provident fund according to the following condition.

	 If the Basic Salary is greater than 50,000, 10,000,  if the Basic Salary 
is greater than 30,000,5000, otherwise 2000.

f. 	 Calculate Monthly salary by adding Basic salary, Monthly allowance, 
Daily allowance, and Provident fund.

g. 	 Calculate yearly salary.

h. 	 Calculate monthly tax. (tax=13%of  Monthly salary)

i. 	 Calculate yearly tax.

j. 	 Calculate Net yearly income.( yearly salary- yearly tax.)
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k. 	 Display the record of the Name of staff and their yearly income in the 
form of a Bar graph, and Pie chart.

Lab assignment on MS PowerPoint
a.	 Create an attractive presentation on the topic “Computer Memory” with at 

least 5 slides. Insert animation and transition effects in the slides.

b.	 Create an attractive presentation on the topic “Computer Generation” with 
at least 5 slides.
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